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Documentation Notice
The information and software described in this document are furnished only under a separate agreement and
may only be used or copied according to the terms of such agreement. It is against the law to copy the
software except as specifically allowed in such agreement. Complying with all applicable copyright laws is
the responsibility of the user. Without limiting the rights under copyright law, no part of this document may be
reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means
(electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express
written permission of Hyland Software, Inc. and/or one of its affiliates.

Hyland, OnBase, Alfresco, Nuxeo, Content Innovation Cloud, and other product or brand names are
registered and/or unregistered trademarks of Hyland Software, Inc. and its affiliates in the United States and
other countries. All other trademarks, servicemarks, trade names and products of other companies are the
property of their respective owners.

© 2026 Hyland.

The information in this document may contain technology as defined by the Export Administration
Regulations (EAR) and could be subject to the Export Control Laws of the U.S. Government including for the
EAR and trade and economic sanctions maintained by the Office of Foreign Assets Control as well as the
export controls laws of your entity’s local jurisdiction. Transfer of such technology by any means to a foreign
person, whether in the United States or abroad, could require export licensing or other approval from the U.S.
Government and the export authority of your entity’s jurisdiction. You are responsible for ensuring that you
have any required approvals prior to export.

DISCLAIMER: This documentation contains available instructions for a specific Hyland product or module.
This documentation is not specific to a particular customer or industry. All data, names, and formats used in
this document’s examples are fictitious unless noted otherwise. This document may reference websites
operated by third parties. In such a case, Hyland has no control or liability for the content of such third-party
websites. The inclusion of such a link shall not constitute an endorsement or affiliation with such a third-party
website; the reference is provided for information purposes only. If you have questions about discrepancies in
this document, please contact Hyland. Hyland customers are responsible for making their own independent
assessment of the information in this documentation. This documentation: (a) is for informational purposes
only, (b) is subject to change without notice, (c) is confidential information of Hyland Software, Inc. and its
affiliates, and (d) does not create any commitments or assurances by Hyland. This documentation is provided
“as is” without representation or warranty of any kind. Hyland expressly disclaims all implied, express, or
statutory warranties. Hyland’s responsibilities and liabilities to its customers are controlled by the applicable
Hyland agreement. This documentation does not modify any agreement between Hyland and its customers.
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Manage documents
Document types
What are document types?
Document types are document properties that uniquely categorizes a document so that it is similar to the
document's drawer or folder, regardless of the document's folder or drawer location.

You assign the document type when capturing the document or when you define its properties, and you can
alsomodify the document type after it has been initially assigned. However, you can assign only one
document type to a document.

Document types can include custom properties, which are additional properties to which you can assign
values.

Add amaster form to a document type
To add one or more forms to a document type, complete the following steps.

Prerequisite The automatic form identification featuremust be installed, licensed, and enabled and, for
scannedmaster forms, youmust have a scanning profile defined for the scanner.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, select a document type and click Modify.
4. In theDocument Type dialog box, on the Forms tab, click New.
5. In theNew Form dialog box, in theName andDescription boxes, enter a name and optional

description for the form you are adding to this document type.
6. Do one of the following actions.

l To import a master form from your file system, in theSource list, select File > Browse, locate and
select the file, and then click OK.

l To scan a paper master form, make sure your scanner is turned on and connected, and then insert
the form to be scanned. In theSource list, select Scanning Profiles, in theProfiles list, select
the scanning profile, click Scan, and when the scan is complete, click OK.

Add a document type
To create a new document type for document categorization in Perceptive Content, complete the following
steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
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3. In the right pane, on theDocument Types tab, click New.
4. In the selected row underDocument Type, type a name for the document type and then press ENTER.
5. Select the new document type and then click Modify.
6. In theDocument Type dialog box, on theGeneral tab, type an optional description for the document

type and select the Is Active check box.
7. Optional. On theCustom Properties tab, assign custom properties to the document type.
8. Optional. If you want Perceptive Content to verify signatures for this document type, do the following

substeps.
1. On theDigital Signatures tab, select theAutomatically verify signatures for this document

type check box.
2. To specify how often the signatures are verified, in theVerification interval boxes, select the

number and time unit and then click OK.
9. Click OK.

Create a document type for unmatched images
When automatic form identification cannot match a captured image to one of your master forms, it assigns the
proposed default document type to the document. To create a document type for unmatched images,
complete the following steps.

This assignment allows you to easily find any documents in a batch that require additional processing after
the automatic form identification stage is complete. Although you can use a previously defined document
type, by creating a unique document type, you canmore easily detect and handle documents that were not
matched tomaster forms.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. On theDocument Types tab, click New.
3. Name the document type using a name such as NoMatchFound, which clearly marks the document

type as having no formmatch, and press ENTER.
Next Select this document type as the default when you create the capture profile for automatic form
identification.

Modify a document type
Tomodify a document type, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theDocument Types tab, select the document type and click Modify.
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4. Modify any of the following document type components:

Situation Steps

Enable or disable the document type l On theGeneral tab, select the Is Active
check box to make the document type active
or clear the check box to make the document
type inactive.

Select a form for the document type l On theGeneral tab, select the Is a form
check box and in the Form list, select a
form.

Modify the document type description l On theGeneral tab, in theDescription
box, change the description as needed.

Modify the custom properties 1. Click theCustom Properties tab.
2. To add a custom property, in theAvailable

list, select a custom property and clickAdd.
In the confirmation box, clickYes.

3. To make the custom property required, in
theAdded list, click the first column of a
custom property to add the icon. Or, click the
icon to remove the requirement.

4. To change the order of a custom property, in
Added, clickMove Up orMove Down.

5. To remove a custom property from the list,
inAdded, select a custom property and
then clickRemove. In the confirmation box,
clickYes.

Automatically verify signatures for the document
type

On theDigital Signatures tab, select the
Automatically verify signatures for this
document type check box, and designate an
interval.

5. Click OK.

Display a document as a form
This procedure changes all documents in the document type you select. To display a form instead of a
document in ImageNowViewer, complete the following steps.

1. InManagement Console, in the left pane, click Document Types.
2. Select the document type that contains the document you want and then click Modify.
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3. In theDocument Type dialog box, on theGeneral tab, select the Is a form check box and then, in the
Form list, select the form you want.

4. If you want the document type to be displayed to users, select the Is active check box.
5. Click OK.
Result Displaying a document as a form replaces any forms previously attached to any workflow queue with
the form you select in this procedure.

Delete a document type
If there is at least one document that uses the document type, you cannot remove it. Instead, you canmake
the document type inactive so that it can no longer be assigned to documents. To delete a document type,
complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theDocument Types tab, select the document type and click Delete.
4. In the confirmation box, click Yes.

Rename a document type
To rename a document type, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theDocument Types tab, select the document type, and then click Rename.
4. In the selected row underDocument Type, type a new name for the document type, and then press

ENTER.
ResultWhen you rename a document, the new document type name is automatically updated for all existing
documents of that type.

Assign a document type to a folder type
To associate an existing document type with a folder type, complete the following steps.

Prerequisite Before you begin this procedure, ensure that your folder type and document types exist.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. In the right pane, on the Folder Types tab, select the folder type to which you want to add a document

type and click Modify.
4. In the Folder Type dialog box, on theDocument Types tab, perform the following substeps.

1. Optional. To prevent users from adding types of documents to a folder that you do not specify,
select theAllow only allows selected document types check box.
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2. Optional. To filter the available document types according to the list in which they were assigned,
inBy List, select a document type list.

3. In theAvailable list, select a document type and click Add.
4. Optional. Tomake a document type required, in theSelected list, click in the document type.

Required document type icon.

Note:When you define required document types for a folder type, you can configure Perceptive
Content workflow to consider a folder complete only when all required document types are
added to the folder.

5. Optional. To change the order in which the document types appear in a folder, in theSelected list,
select a document type and click Move Up orMove Down.

Note: You can also order the document types in theView Previewwindow on theAppearance
tab.

6. Optional. To remove a document type from the folder type, select the document type and click
Remove.

7. Click OK.

Require document types for a folder type
You can associate specific document types with folder types. To specify required document types, complete
the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. In the right pane, on the Folder Types tab, select the folder type and click Modify.
4. In the Folder Type dialog box, on theDocument Types tab, in theSelected list, click in the column in

front of the document type.
TheRequired icon appears.

5. Click OK.

Definable document properties
Perceptive Content uses document properties to store, secure, and retrieve a document. Many document
properties exist and you can define a set of these properties to customize your Perceptive Content system for
your organization's business needs. The following information focuses on the set of document properties you
can define.

Tomake a document distinguishable from other documents, youmust define the Type property. In addition,
youmust define a unique name and location (a name along with a folder) or a unique set of document keys
(Drawer along with Field1, Field2, Field3, Field4, or Field5). You define how properties are assigned to a
document, as well as the type of information that can be assigned, in an application plan or a capture profile.
The following tables further explain the definable document properties and provide an example value for each
property.



Manage Documents User Guide

24

Properties for a document not stored in a folder
For a document that is not stored in a folder, the Drawer and Type properties are required. Youmust also
define one of the following properties: Field1, Field2, Field3, Field4, or Field5. Additional definable properties
include custom properties and notes. The following table shows how youmight define document properties for
documents owned by the HumanResources Department that are not stored in folders.

Document
Property

Description Example
Configuration

Example Value Required

Drawer Drawer provides
the highest level
within the
document key
structure and is
often defined as a
department or
function, such as
Accounts Payable,
Human
Resources,
Registrar, or
Financial Aid. You
can restrict access
to documents
based on their
assigned Drawer
values.

Human Resources Human Resources Yes

Field1 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

Employee ID 12345 Yes - You must
define at least one
field value.
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Document
Property

Description Example
Configuration

Example Value Required

Field2 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

Last Name Jones Yes - You must
define at least one
field value.

Field3 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

First Name John Yes - You must
define at least one
field value.

Field4 You can use
Field1 through
Field5 to define
values through a

Job Code 32156 Yes - You must
define at least one
field value.
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Document
Property

Description Example
Configuration

Example Value Required

selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

Field5 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

Employment
Status

Full Time Yes - You must
define at least one
field value.

Type Type categorizes a
document so that
your users can
easily identify its
purpose. A user
selects a value for
the Type field
using a list of
document type

Employment
Application

Employment
Application

Yes



Manage Documents User Guide

27

Document
Property

Description Example
Configuration

Example Value Required

values that you
predefine. You can
restrict access to
documents based
on the Type values
assigned to them.

Custom Properties You can define
custom property
values for a
document type.
Custom properties
let you define and
store unlimited
data beyond the
standard
document
properties.

Job Title Marketing Director No

Notes The Notes field
enables a user to
type and view
additional text
about a document.

Notes Samantha Smith
at Acme
Corporation called
September 9 to
verify employment
dates.

No

Properties for a document stored in a content model

When a document is stored in a content model, Perceptive Content stores the document in a folder that
resides in a drawer. Many folder levels can exist within a folder. For a document that is stored in a content
model, Perceptive Content uses the Type property as well as the document path to store, secure, and retrieve
the document. The properties that make up the path, as well as Type, are required. You can store additional
information about a document in the following definable properties: Field1, Field2, Field3, Field4, Field5,
notes, and custom properties.The folders in which a user attempts to store a document, as well as the Type a
user assigns to a document, must work with the folder type hierarchy that you define for a drawer. The
following table shows how youmight define document properties for documents owned by the Human
Resources Department that are stored in a content model.
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Document
Property

Description Example
Configuration

Example Value Required

Path A document path
indicates where a
document is stored
in your Perceptive
Content system.
The path contains
the values
assigned to the
Drawer and Name
property fields.
The path also
contains any folder
or folders in which
the document is
stored. Each
document path is
unique.

The following
structure applies
to the document
path: <Drawer> \
<folder> \
<subfolder> \
<Name>

Human Resources
\ John Jones \
Onboarding \
Application

Yes

Name Name provides a
unique identifier
for the document
within the folder it
is stored. A name
cannot exceed 128
characters.

Application Application Yes

Drawer Drawer provides
the highest level
within the folder
structure and is
often defined as a
department or
function, such as
Accounts Payable,
Human
Resources,
Registrar, or
Financial Aid. You
can restrict access
to documents
based on their
assigned Drawer
values.

Human Resources Human Resources Yes
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Document
Property

Description Example
Configuration

Example Value Required

Type Type categorizes a
document so that
your users can
easily identify its
purpose. A user
selects a value for
the Type field
using a list of
document type
values that you
predefine. You can
restrict access to
documents based
on the Type values
assigned to them.

Employment
Application

Employment
Application

Yes

Field1 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

Employe ID 12345 No

Field2 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal

Last Name Jones No
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Document
Property

Description Example
Configuration

Example Value Required

value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

Field3 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

First Name John No

Field4 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a

Employment
Status

Full Time No
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Document
Property

Description Example
Configuration

Example Value Required

sequence, or a
unique ID
assigned by
Perceptive
Content.

Field5 You can use
Field1 through
Field5 to define
values through a
selected data
element in your
application plan
dictionary, a literal
value that you
enter, the name of
the current user,
the date and time,
a number in a
sequence, or a
unique ID
assigned by
Perceptive
Content.

Job Code 32156 No

Custom Properties You can define
custom property
values for a
specific document
type. Custom
properties let you
define and store
unlimited data
beyond the
standard definable
document
properties.

Job Title Marketing Director No

Notes The Notes field
enables a user to
type and view
additional text
about a document.

Notes Samantha Smith
at Acme
Corporation called
September 9 to
verify employment
dates.

No
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Document Type Lists
What are document type lists?
Document type lists group sets of document types together in order to build groups of document types that are
specific to one department, process, or set of business rules.

Document type lists let you provide users with a filtered view or subset of the entire list of defined document
types. For example, you canmap a document type list to a LearnMode application plan to filter the available
document types to assist the user in determining the correct document types to assign to documents. You
can set the order of the documents in the list, and a document type can be included inmultiple document type
lists.

You can assign users or groups with Document, Explorer/Folder Viewer, Viewer, and Document Management
privileges by each document type but not document type list. These action privileges apply at the same level
as Drawer privileges, so you can assign privileges by drawer or document type.

Create a document type list
To create a document type list, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document types.
3. In the right pane, on theDocument Types Lists tab, click New.
4. In the selected row underDocument Type List, type a name for the list.
5. Select the new document type list and click Modify.
6. On theGeneral tab, type a name and optional description.
7. To add document types to the list, on the List Members tab, perform the following substeps:

1. In the Types list, select a document type and click Add.
2. Optional. To reorder the document types in the list, in theMembers List box, select a document

type and click Move Up orMove Down.

Example You canmove themost commonly used document types to the top of the list.

8. Click OK and, in the confirmation box, click Yes.

Modify or rename a document type list
Tomodify the components of a document type list, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theDocument Type Lists tab, select the list you want, and then click Modify.
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4. Modify any of the following document type list components:

Situation Steps

Rename the list 1. On theGeneral tab, in theName box,
modify the name as needed.

2. In theDescription box, describe the
document type list.

Add, reorder, or remove document types 1. Click the List Members tab.
2. In the Types list, select a document type

and clickAdd.
3. In the confirmation box, clickYes.
4. ClickMove Up orMove Down to change

the order.

5. Click OK. In the confirmation box, click Yes.

Delete a document type list
To delete a document type list, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theDocument Type Lists tab, select the document type list you want, and then

click Delete.
4. In the confirmation box, click Yes.

Categories
What are categories?
Categories enable you to logically organize document types in Perceptive Content and Interact Desktop.

The Navigation pane displays categories under the list of available folders. Documents not assigned to a
folder or a category are grouped together.

In Interact Desktop, you can create a category of document types in Management Console. When you create
a category, you can assign a specific color to that category. In addition to defining a color, you can organize
the document types within a category so that they appear in the order that your users want to see them. In the
Navigation pane, Interact Desktop displays the name and color of each category, as well as a number that
indicates the number of documents assigned to a category based on the current context. The Navigation pane
only displays categories with documents assigned to them. When you create a category to display in Interact
Desktop, Perceptive Content displays the category as a document type list in ImageNow Client.
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Create a category for document types
To create a category for document types, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, click New.
4. In theModify Category dialog box, on theGeneral tab, perform the following substeps.

1. In theName box, type a category name.
2. Optional. In theDescription box, describe the category.

5. On theMembers tab, to add the document types that appear in this category, perform the following
substeps.
1. To assign only document types that appear in a specific document list, in theBy document type

list, select a list. If you select All document types, all of the document types in the system
appear.

2. In the Types list, select a document type and click Add.
3. Optional. To change the order of the document types, inMembers, click Move Up orMove

Down.
6. Click OK.
7. Optional. To assign a color to the category, inManagement Console, on theCategories tab, select

the category and select a color.

Assign a category color
To assign a color to a category, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, select a category and select a color.

Assign a document type to a category
To assign a document type to a category, complete the following steps. You can assign a document type to
multiple categories.

Prerequisite Before you begin this procedure, ensure that your document types and document type lists are
created.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, select the category to which you want to add a document type

and click Modify.
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4. In theCategory dialog box, on theMembers tab, perform the following substeps.
1. Optional. To filter the available document types according to the list in which they were assigned,

inBy document type list, select a document type list.
2. In the Types list, select a document type and click Add.
3. Optional. To change the order in which the document types appear in a category, in the document

type List , select a document type and click Move Up orMove Down.
4. Optional. To remove a document type from the category, select the document type and click

Remove.
5. Click OK.

Modify a category
Tomodify an existing category, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, in the category list, select the category you want to update and

click Modify.
4. In theCategory dialog box, on theGeneral tab, perform one or more of the following actions.

l In theName box, modify the name as needed.
l In theDescription box, modify the category description.

5. On theMembers tab, perform one or more of the following actions.
l To add an additional document type to the category, in theBy document type list, select a list and
in the Types list, select a document type, and then click Add.

l To remove a document type from the category, in theMembers list, select the document type and
select Remove.

l To change the order in which the document types appear in the category, inMembers, select a
document type and click Move Up orMove Down.

6. Click OK and in the confirmation box, click Yes.

Delete a category
To remove a category from the Perceptive Content system, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, select the category you want to remove from Perceptive

Content and click Delete.
4. In the confirmation dialog box, click Yes.
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Rename a category
To rename an existing category, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, select the category you want to rename and click Modify.
4. In theCategory dialog box, on theGeneral tab, in theName box, enter a new name.
5. In the confirmation box, click Yes.

Reorder a category
To rearrange the order in which categories appear within a parent category, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, select the category you want to move and click Move Up or

Move Down.
4. Click OK.

Reorder category document types
To rearrange the order in which document types appear in a category, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Document Types.
3. In the right pane, on theCategories tab, select the category you want and click Modify.
4. In theCategory dialog box, on theMembers tab, select the document type you want to move and click

Move Up orMove Down.
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Organize your content structure
What are folder types?
What are folder types?
A folder type provides a template from which your users create and tailor individual folders.

In a folder type, you can assign one or more document types, custom properties, or capture profiles, as well
as define how Perceptive Content displays the contents. You can specify that a folder type can only contain
the document types you assign to it, and Perceptive Content prevents the user from adding documents to a
folder that are not assigned to that folder. You can specify that the folder type contains some or all document
types, and define your Perceptive Content workflow process to identify when a new folder type contains all of
the required document types.

Perceptive Content provides the ability to specify that some or all document types assigned to a folder type
are required. When you define required document types for a folder type, your users can view a list of the
required document types in the Folder Viewer. You can also configure your Perceptive Content workflow
process to identify when a folder contains all of the required document types.

You can also assign an unlimited number of "custom properties" to document types and folder types, enabling
you to store additional metadata about a type. Additionally, you can organize folder types in your Perceptive
Content system using "folder type lists" and the "folder hierarchy."

For example, youmight create a folder type namedHR that users in your human resources department
use each time they need to create a folder for a new employee. Youmight specify that the HR folder
must contain "Resume," "Application" and "Tax form" document types, but not a "Medical" document
type. Then you define workflow to route the documents in a new employee's folder only after the
resume, application and tax form arrive in the specified queue. In the event that a user tries moving and
insurance form into this folder, Perceptive Content prevents it.

Create a folder type
To create a folder type, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. On the Folder Types tab, click New and type a name for your folder type.
4. Select the folder type and click Modify.
5. On theGeneral tab, in theDescription box, type a description explaining briefly how this folder type is

used.
6. Click OK.
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Modify a folder type
Tomodify a folder type, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. Select a folder name and click Modify.
4. In the Folder Type dialog box, make themodifications you want to the options available, such as, to

change or remove the folder's name, description, or assigned document typemembers, custom
properties, and forms.

5. Click OK.

Rename a folder type
To rename a folder type, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. Select the folder type you want to rename and click Rename.
4. Type the new name for the folder type.
5. Click OK.

Delete a folder type
To delete a folder type, complete the following steps.

You cannot remove a folder type if folders based on the folder type exist in your Perceptive Content system.
Set a folder type to inactive when you want to retain the existing folders, but you no longer want users to
create folders based on the folder type. If you want to prevent users from using the folder type temporarily,
revoke the user privileges for that period of time.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. Select the folder you want to delete and click Remove.
4. Click OK.

Display a folder as a form
To display a form in Folder Viewer instead of the folder contents, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. Select the folder type that contains the folder you want to change and then click Modify.
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Note: This procedure changes all folders with the folder type you select.

4. In the Folder Type dialog box, on theGeneral tab, select the Is a form check box and, in the Form
list, select the form you want.

5. To display the folder type to users, select the Is active check box.

Note: Displaying a folder as a form replaces any forms previously attached to any workflow queue
with the form you select in this procedure.

6. Click OK.

Assign a capture profile to a folder type
You assign a capture profile to a folder type when your users add files to Perceptive Content using Interact for
Outlook. When a user adds a file to a folder in Outlook, the associated capture profile defines how the file is
indexed. To assign a capture profile to a folder, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. In the right pane, on the Folder Types tab, select the folder type to which you want to assign a capture

profile and click Modify.
4. In the Folder Type dialog box, on theCapture Profiles tab, perform the following substeps.

1. In theAvailable list, select a capture profile and click Add.
2. Optional. To remove a capture profile from the folder type, select the profile and click Remove.
3. Click OK.

Create a folder hierarchy for output files
To create a nested folder structure where each folder represents an item s keys or properties, complete the
following steps.

If you are exporting items to a file, you can only perform this procedure if you are not outputting files as a
single PDF.

1. Perform one of the following options, depending on the situation.

Situation Steps

Define folder structure inManagement
Console

1. InManagement Console, in the left pane,
clickOutput Profiles.

2. In the right pane, click the File tab, select
the output profile, and clickModify.
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Situation Steps

Define folder structure in the viewer 1. Open the item.
2. Click File > Export.
3. In the Export dialog box, clickOptions.

2. On the Folder Hierarchy tab, perform one of the following options.

Situation Steps

To create a copy of the existing folder structure l Select theUse the existing hierarchy for
this item check box.

To create a new folder structure 1. To select the item properties to create
folders for the output files, clickAdd.

2. To change the order of the properties you
added, click a property and clickMove Up or
Move Down.

3. To remove a property from the list, click
Remove.

3. Click OK.

What is content modeling?

What is content modeling?

Content modeling is the process by which you structure, manage, and preserve content in Perceptive Content
to best fit your business needs. A content model includes securemethods for capturing, processing, and
searching for content.

Because different business processes use different content, each content model structures, manages, and
preserves the content according to each business process.

Modeling your content in Perceptive Content involves creating drawers, items, and container types; building a
container type hierarchy within drawers; using the defined container and item types; and assigning uniquely
identifiable properties to content, including custom properties.

Perceptive Content enables you to define specific item types as required for a container. When you define
required item types for a container, your users can view a list of the required item types in a container viewer.
You can also configure your Perceptive Content workflow process to identify when a container contains all of
the required item types.

Perceptive Content enables you to create a container type hierarchy to restrict the types of containers allowed
in a drawer. You can also restrict drawers and container types to allow only specified item types.
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For example, when you restrict a drawer to allow only specified item types, a user can add an item to
the drawer only if the item is assigned one of the item types that you specify.

Define a content model overview

Many components perform roles in a content model. Before you define a content model for a drawer, youmust
create the necessary document types, folder types, and drawer. Youmust also define content model-specific
privileges. The additional components that you create to complete a content model depend on your business
processes. We recommend that you create the components in the listed order by completing the following
sequence of procedures.

1. Add the custom properties needed to store additional data about a document or folder based on its
assigned Type value.
l Create a custom property overview

2. Adda document type to provide a template to define which users can access the document based on its
Type value and which custom property values a user can assign to the document.

3. Create a document type list to provide a filtered set of document types.
4. Createa drawer in which to store content.

l Manage drawer restrictions overview
5. Create a folder type list to provide a filtered set of folder types.
6. Define a folder type hierarchy for a drawer to specify which folders a user can store in a drawer.
7. Set folder privileges to specify which drawers, folders, and document types a user or group of users can

access, as well as which actions the user or group can perform.
8. Create an application plan to contain mapped information used to assign a location and property values

to documents, folders, and shortcuts.
l Create an application plan

9. Create a client-based capture profile to contains the settings used to capture documents, including how
to assign the location and property values to a new document.

What are folder type lists?
A folder type list enables you to group sets of folder types based on a relationship.

Folder type lists also let you provide users with a filtered view, or subset, of the entire list of defined folder
types. You can set the order of the folders in the list so that the commonly used folder types appear near the
top of the list.

For example, you can build groups of folder types specific to one department, process, or set of
business rules.

Create a folder type list

To group existing folder types into a folder type list, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
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list.
2. In the left pane, click Folder Types.
3. In the right pane, on the Folder Types Lists tab, click New.
4. UnderSelect a folder type list, in the selected row, type a name for the list.
5. Select the new folder type list and click Modify.
6. Optional. In the Folder Type List dialog box, on theGeneral tab, modify the name or optional

description.
7. In the Folder Type List dialog box, on the List Members tab, perform the following substeps:

1. To add a folder type, in the Types list, select a folder type and click Add. Repeat this step for
each folder type that you want to add to the list.

2. Optional. To change the position of a folder type in the list, in theMembers list, select a folder
type and click Move Up orMove Down.

3. Click OK.
8. In the confirmation box, click Yes.

Modify or rename a folder type list

Tomodify a folder type list by changing its name, description, or folder type list members, complete the
following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. In the right pane, on the Folder Type Lists tab, select the list you want to modify and click Modify.
4. In the Folder Type List dialog box, modify any of the following components:

Situation Steps

Rename the list or modify its description 1. Click theGeneral tab.
2. In theName box, modify the name.
3. In theDescription box, modify the

description.

Add, reorder, or remove folder types in the list 1. Click the List Members tab.
2. To add a folder type to the list, in the Types

list, select a folder type and clickAdd.
3. To change the position of a folder type in the

list, in theMembers list, select a folder type
and clickMove Up orMove Down.

4. To remove a folder type from the list, in the
Members list, select the folder type list and
clickRemove.
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5. Click OK.
6. In the confirmation box, click Yes.

Delete a folder type list

To delete a folder type list, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types.
3. In the right pane, on the Folder Type Lists tab, select the folder type list and click Delete.
4. In the confirmation box, click Yes.

What is the folder type hierarchy?
The folder type hierarchy allows you to structure your container types in drawers.

You use the hierarchy to define a template for the container structures that your users create to perform their
tasks. The folder type hierarchy is a component of a content model.

Perceptive Content does not require that you specify a container type hierarchy for your users to create
containers in a drawer; however, we recommend that you establish a hierarchy so that the containers your
users create in your system follow a defined structure. A well designed structure enhances the storage and
retrieval of items.

Define a folder type hierarchy for a drawer

When you define a hierarchy for a drawer, the drawer becomes restricted so that a user can only add a folder
to the drawer that is assigned one of the folder types specified in the drawer's folder type hierarchy. To define
a folder type hierarchy for a drawer, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types and, in the right pane, click theHierarchy tab.
3. In the right pane, underStructure, in theDisplay list, select the name of the drawer you want to

restrict.
4. In the left pane, under Folder Types, perform the following substeps.

1. Optional. ForBy list, select a folder type list to filter the list of folder types.
2. From the list of folder types, select the folder type you want to define in the hierarchy and drag it

to the right, dropping it under the drawer where you want it to appear.
3. Continue to add folder types under the drawer's name and use theMove Up orMove Down

buttons to arrange the folder types to fit your business needs.

Note: You can use theMove Up orMove Down buttons tomove a folder type to a different
location under a drawer, but you cannot use them tomove a folder type from one drawer's
hierarchy to another drawer's hierarchy.
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4. If you definemore than one level of folder types in the hierarchy, and you want to restrict the last
folder type level so that a user cannot create a folder below this level, in the right pane, right-click
the last folder type level and click Restrict.

5. To apply your changes to the hierarchy, click Save.

Modify a folder type hierarchy for a drawer

Tomodify a folder type hierarchy that was defined for a drawer, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types and, in the right pane, click theHierarchy tab.
3. In the right pane, underStructure, in theDisplay list, select the name of the drawer you want to modify.
4. Perform any of the following actions tomodify the drawer's hierarchy:

l To add a folder type, from the list of folder types in the left pane, select the folder type you want to
define in the hierarchy and drag it to the right, dropping it under the drawer where you want it to
appear.

l To relocate a folder type, select the folder type and click theMove Up orMove Down button.
l To remove a folder type, select the folder type and click Remove.
l To reset all changes youmade to the hierarchy since the last save, click Undo All.

5. To apply your changes to the hierarchy, click Save.

Manage folder type restrictions overview

To restrict a folder type to allow only the specified document and subfolder types complete any of the
following procedures.

1. Restrict document types in a folder.
2. Restrict subfolder types in a folder.
3. Remove folder contents restrictions.

Remove a folder type from the folder type hierarchy

To remove a folder type from the folder type hierarchy, but not remove the folder type from your system,
complete the following procedure.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Folder Types, and in the right pane, click theHierarchy tab.
3. To remove a subfolder type from theCommon Hierarchy, in theStructure pane, underCommon

Hierarchy, select the subfolder type you want to remove, and then click Remove.
4. To remove a folder type from the hierarchy defined for a drawer, In theStructure pane, in theDisplay

list, select the name of the drawer from which you want to remove a folder type, select the folder type
you want to remove, and then click Remove.

5. To apply your changes to the hierarchy, click Save.
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What are drawers?
Drawers provide the first hierarchical level of organization for Perceptive Content documents, and they are
used to separate documents and folders into logical categories.

Youmight think of drawers as individual departments. For example, the accounting department data can be
stored separately from the sales department data by having separate "Accounting" and "Sales" drawers.

In addition to providing a distinct level of organization, you can use drawers to assign or deny access to
particular documents and folders. For example, only users in the accounting department may need to see
certain folder contents. These particular folders can be stored in a drawer named "Accounting." Access to that
drawer can be restricted at the user or group level by assigning the appropriate privileges.

Create a drawer
To create a new drawer, complete the following steps.

You can restrict a drawer to only allow users to store specified document types at the drawer level. This
restriction does not prevent a user from storing a document type in a folder within the drawer.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Drawers.
3. In the right pane, click New.
4. In theNew Drawer dialog box, on theGeneral tab, type the drawer name and an optional description.
5. To restrict the drawer to allow only specified document types, on theDocument Types tab, perform the

following substeps.
1. Select theAllow only selected document types check box.
2. Optional. To filter the document types according to the list in which they were assigned, in theBy

list, select a document type list.
3. UnderAvailable, select a document type and click Add. Continue to add document types that

you want to allow at the drawer level.
4. To change the order in which the document types display in the drawer, in theSelected list, click

Move Up orMove Down. For example, you canmove themost commonly used document types
to the top of the list.

5. To delete a document type from the list, in theSelected list, select the document type you want
to remove and click Remove.

6. Click OK.
6. Optional. To havePerceptive Content verify digital signatures for this drawer, on theDigital

Signatures tab, perform the following substeps.
1. Automatically verify signatures for this drawer check box.
2. ForVerification interval, specify the number and time unit for how often you want Perceptive

Content to verify the signatures.
7. Click OK.
8. Optional. To create a new drawer with the same privilege assignments as another drawer, use the
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above steps but instead select the drawer you want to copy in step 2, then click Copy instead of New.

Note: This does NOT copy the documents in the existing drawer to the new drawer.

Manage drawer restrictions overview
To restrict a drawer to allow only specified folder types and document types, as well as steps to remove
restrictions, complete any of the following procedures.

l Restrict document types for a drawer.
l Restrict folder types for a drawer.
l Remove drawer document type restrictions.
l Remove drawer folder restrictions.

Rename a drawer
To rename a drawer, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Drawers.
3. In the right pane, select the drawer you want to rename, and then click Rename.
4. Type the new drawer name and then press ENTER.

View details about a drawer
To view details about the document and folder types configured for a drawer, complete the following steps.

l Do one of the following actions, depending on the situation.

Situation Steps

View the
document types
assigned to a
drawer

1. In Management Console, in the left pane, click Drawers.
2. In the right pane, on the Drawers tab, select the drawer for which you want

to view assigned document types and clickmodify.
3. In the Drawer dialogue box, on the Document Types tab, under Selected,

Perceptive Contentdisplays a list of all document types assigned to the
drawer.

4. Click OK.

View the folder
types defined for
a drawer

1. In Management Console, in the left pane, click Folder Types and, in the
right pane, click the Hierarchy tab.

2. In the right pane, under Structure, in the Display list, select the name of the
drawer for which you want to view its defined folder types.
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Delete a drawer
To delete the drawer, complete the following steps.

Prerequisite To delete a drawer, youmust first remove all documents, shortcuts, and folders from the
drawer. When you remove a drawer, you do not delete the users and groups assigned to it.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Drawers.
3. In the right pane, select the drawer you want to delete, and then click Remove.
4. In the confirmation dialog box, clickYes.

Manage Capture
What is CaptureNow?

The CaptureNow product suite drives the desktop, ImageNow Client-based collection and processing of
documents frommultiple sources with a rich collection of scanning and importing functionality.

Your users can collect files manually or automatically from a centralized location or distribute the capture of
documents to different locations. Using CaptureNow, your users can capture all types of documents,
individually or in batches, into a secure, organized, and accessible repository.

Capture and source profiles enable you to define hardware and software settings such as resolution, page
size, orientation, brightness, threshold detection, and duplex scanning to optimize your unique capture
environment. Your users can deliver captured documents directly into workflow processes where documents
are automatically assigned document properties with features such as barcode recognition. Also, when
CaptureNow is used with Recognition Agent, documents can be submitted for OCR processing. Quality
Assurance features ensure images appear clean and readable before they are indexed and placed into the
repository or a specified workflow queue.

Document property types in CaptureNow
Youmust define the type of information to store in a document property value that is assigned to a captured
document. For Single or Batchmode, you set a document property type in a capture profile. For Package
mode, you set a document property type in the Basket Definition dialog box while creating or editing a basket.
The following list describes each type you can choose to define a document property.

Application

Assign a value captured from an application plan.
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Barcode

Assign a value captured from one of the recognized barcodes. Youmust supply the number of the
barcode in the Value field. You can parse a single barcode into separate values with the standard
barcode parsing syntax <barcode position number> | <starting character> -
<ending character>.

Batch Sequence

Assign the unique Batch Sequence number assigned to a batch of captured documents. The Batch
Sequence number helps group pages of a captured batch of documents together.

COM Value

Assign a value gathered from your business application through a COM interface specified in the Value
field. For Single and Batchmodes, to allow a user to change the property value, select the Allow user
updates to this value check box.

Date/Time

Assign the date and time that Perceptive Content captures the document.

Document Type

Assign a pre-defined document type selected from the Value list.

Document Type List

Select a pre-defined document type list from the Value list for a user to choose from when capturing the
document.

Empty

Do not assign a value.

Imprinter Value

Assign a data string captured from imprinter hardware. Imprinter hardware connects to a scanner and
prints a data string on the original scanned document.

Literal

Assign the static value entered in the Value field.

Notes

Assign a static value entered in the Value box. This text appears in the Notes field in the Properties pane
when users view a document in Viewer.

OCR Zone

Assign a value gathered throughOCR when the document is submitted to the server for Recognition
Agent processing. Click the Settings button to configure the OCR zone on the document.
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Predefined List Local

Create a list of values in the Value field for a user to choose from when Perceptive Content captures the
document. Perceptive Content stores the list of values locally.

Predefined List Server

Create a list of values in the Value field for a user to choose from when Perceptive Content captures the
document. Perceptive Content stores the list of values on the server.

Sequence Number

Assign a sequence number for Perceptive Content to retrieve a serial number from a sequence table or
define your own sequence number. You can create a new group of numbers with varying widths and
increments. For example, you can create a sequence called Sequence_indexkey1, where the width is 5
and the increment is 1. Perceptive Content would assign 00001 to the first document, 00002 to the
second document, and so on.

System Drawer

Assign the name of a drawer.

Unique ID

Assign the Unique ID that Perceptive Content generates. Choose this type if you want to treat each
page of a batch separately.

User Entry

Prompt the user who captures the document to enter a value.

User Name

Assign the name of the user who captured the document.

VB Script

Assign a value gathered from your business application through a VB Script entered in the Value field.
After you enter a script, click Test to review the output.

Application Plans
About selecting an application plan type
Perceptive Content has different types andmethods available to capture data from a business application and
to create an application plan.

The first step to working with application plans is selecting the type andmethod that works best with your
business environment. The application plan types are Agent, External, External User, Interact, LearnMode,
Manual, andMobile. The Agent type has twomethods: Fax Agent and Import Agent. The Interact type has
twomethods: Connector for SAP ArchiveLink and Interact for Outlook. The LearnMode type has six methods:
DOS command prompt, HyperLearn, Internet Explorer, Terminal Capture, Viewpoint, andWindow Walker.
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Finding the right type andmethod is sometimes a case of trial and error and involves finding the right method
that fits the specific needs of your business. When using a business application, you need to understand how
Perceptive Content captures data from the application, its design, and the property values you need to
capture to link your images. It is extremely helpful to understand what type of business application you use,
the type of interface it uses, and how it is accessed by your users.

Activate an application plan
An application plan assigns metadata to a captured item, which can be a document or a record, and allows
users to easily filter and retrieve that item. The following steps describe how to activate an application plan.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. ExpandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select the application you want to activate and click

Settings.
4. In thePlan Settings dialog box, selectIs active.
5. To close thePlan Settings dialog box, click OK.

Add a user or group to an application plan
Adding a user or group to an application plan allows those users to access and utilize it. To add a user or group
to an application plan, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. ExpandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select the application to which you want to add a user or

group and click Settings.
4. In thePlan Settings dialog box, on theSecurity tab, click Add.
5. UnderPrivileges, grant or deny the specific privilege actions.

l To grant specific application plan privileges for the selected user or group, click the column in front

of each privilege until appears.
l To deny specific application plan privileges for the selected user or group, click the column in front

of each privilege until appears.

Note: You can grant or deny privileges to create or link documents, automatically create folders when
the document is linked, run the active screen's view action andmanage the application plan.
Alternatively, you can click Allow All, Deny All, or Deselect All to allow, deny or deselect all privileges
for the selected user or group.

6. Click OK to close thePlan Settings dialog box.
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Copy an application plan
To copy an application plan, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. ExpandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select the application plan you want to copy.
4. Click Copy.
5. In theCopy dialog, enter a name and click OK.
6. Tomodify the copied version of the application plan, complete any of the following actions.

l To assign a name to the copied application plan, click Rename, type the new name, and press
ENTER.

l Tomake changes to the application plan, such as modifying context maps or adding new screens
or dictionary data elements, select the copied version and click Modify.

l Tomake changes to the general settings of the application plan, such as changing the application
plan name or description, or to make changes to the security settings, select the copied version
and click Settings.

Create an application plan
To create an application plan, complete the following steps.

TheMobile application plan type does not support Records Manager functionality. To view records
functionality, youmust install a Records Manager license.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, expandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select New.
4. In thePlan Settings dialog box, select theGeneral tab.
5. Under Information, complete the following substeps.

1. ForContent Type, select theDocument orRecord option. You cannot change the content type
once the application plan is created.

2. In theName box, type a unique name for your application plan.
3. Optional. In theDescription box, type a description for your application plan.
4. Optional. Clear the Is active check box if you do not want this application plan to be active.

6. Click OK.

Delete an application plan
To delete an application plan, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.
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2. ExpandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select the application plan you want to delete.
4. Click Delete.
5. In the confirmation dialog box, click Yes.

Modify an application plan
Tomodify an application plan, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, expandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select the application plan you want to modify.
4. Tomodify an application plan, perform any of the following actions.

Situation Steps

Modify an application plan 1. ClickModify.
2. InApplication Plan Designer, make the

necessary changes to the application plan,
such asmodifying maps, or adding new
screens or dictionary data elements. If your
application plan hasmore than one screen,
you must modify each screen separately.

3. ClickSavewhen you are finished modifying
the application plan and closeApplication
Plan Designer.

Modify application plan settings 1. ClickSettings.
2. In the Plan Settings dialog box, make the

necessary changes to the application plan's
general settings, such as changing the
application plan name and description, or
updating security preferences.

3. ClickOK.

Remove a user or group from an application plan
To remove a user or group from an application plan, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. ExpandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select the application from which you want to remove a user

or group and click Settings.
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4. In thePlan Settings dialog box, on theSecurity tab, select the appropriate user or group, and click
Remove.

5. To close thePlan Settings dialog box, click OK.

Rename an application plan
To rename an application plan complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. ExpandApplication Plans and select an application plan type.
3. In the right pane, on theApplications tab, select the application plan you want to rename.
4. Click Rename.
5. Type the new application plan name and press ENTER.

What is an application plan?
An application plan assigns metadata to a captured item, which can be a document or a record, and allows
users to easily filter and retrieve that item.

Perceptive Content uses an application plan to assign drawer, folder, and document property values to a
captured document. Perceptive Content also uses an application plan to assign file plan, category, folder, and
record property values to a captured record.

These values store additional information about your items and allow users to easily filter and retrieve items
stored in Perceptive Content.

What is a screen?
A screen represents a screen in your business application that is learned by applying one of the LearnMode
methods, such as HyperLearn or ViewPoint.

When you create a screen, you capture data from the business application screen to create document keys.
You can also add screens to an existing application plan, make changes to the way an existing screen links to
the business application, delete a screen, and rename a screen.

In Perceptive Content, you can useMicrosoft Visual Basic Scripting to identify specific screens of your
business application whenmultiple screens are open. You can create, modify, and apply these scripts when
adding or editing a screen.
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Agent Type

About using the Agent type methods

You use the Agent type application plan with Import Agent and Fax Agent to capture data directly into
Perceptive Content.

l Fax Agent. The Fax Agent enables you to capture incoming faxes directly into Perceptive Content by
converting them into documents. This method uses data available from the Fax Agent to identify possible
document property values. Fax-specific data includes the fax sender number, fax sender DID, and
incoming fax channel.

l Import Agent. The Import Agent, installed with the ImageNow Server, handles all automated import
routines on the server. This method uses data available from the Import Agent to identify possible item
property values. Import specific data includes Import mode, Import file name, Import file location, Import
index file line, and Import associated text file.

Create a Fax Agent application plan

To create a Fax Agent application plan, complete the following sequence of procedures.

1. Create an application plan.
2. Define Fax Agent dictionary values.
3. Optional. Add amacro.
4. Create an application planmap.
5. Add a user or group to an application plan.

Create an Import Agent application plan

To create an Import Agent application plan, complete the following steps.

1. Create an application plan.
2. Define Import Agent dictionary values.
3. Optional. Add amacro.
4. Create an application plan document map.
5. Add a user or group to an application plan.

External Type

About using the External type

You use the External type application plan with external Perceptive Content interfaces, such as iScript and
Integration Server.

This type uses data available from the external interface to identify possible property values for items and
containers. It also limits the property values you can use for input in the external interface.
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Configure an External application plan

You use the External application plan tomap data to items using iScript or another external Perceptive
Content interface. To create an external type application plan, complete the following steps.

1. Create an application plan.
2. Add a data element to the dictionary.
3. Add amacro.
4. Create an application planmap.
5. Add a user or group an application plan.

External User Type

About using the External User type

You use the External User application plan when capturing files or scanning images from an application that is
utilizing Integration Server to connect with Perceptive Content, such as Perceptive Experience Content
Capture.

When using an External User type plan, the user can enter some of the properties, and you can configure
which fields the user is able tomodify. You can also create dictionary data elements when using this type of
application plan.

Configure an External User application plan

You use the External User application plan when capturing files or scanning images from an application that is
utilizing Integration Server to connect with Perceptive Content. To configure an External User application
plan, complete the following steps.

1. Create an application plan.
2. Add a data element to the dictionary.
3. Add amacro.
4. Create an application plan document map.
5. Add a user or group to an application plan.

Interact Type

About using the Interact type methods

You use the Interact type to integrate themanagement features of Perceptive Content with your existing SAP
andOutlook applications.

The Interact type contains twomethods, the Connector for SAP ArchiveLinkand Interact for Outlook. Linking
items according to content guarantees long-term easy access to the items.

The following bullets describe each type.
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l Connector for SAP ArchiveLink. This integration allows you to deliver secure, digital versions of paper
and other electronic documents associated with SAP transactions. SAP ArchiveLink is a service
integrated in the SAPWeb Application Server for linking archived documents and the application
documents entered in the SAP system.

l Interact for Outlook. This integration uses a capture profile to determine how to link single or multiple
captured emails and add them to Interact for Outlook.

Create an Interact application plan

You use the Interact application plan tomap data to items captured by an Interact client, such as Interact for
Lexmark. To create an Interact application plan, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, expandApplication Plans and select Interact.
3. On theApplications tab, select New.
4. In thePlan Settings dialog box, select theGeneral tab.
5. Under Information, complete the following steps.

1. ForContent Type, select theDocument orRecord option.

Note: You cannot change the content type once the application plan is created.

LearnMode Type

Create a Learn Mode application plan

You use the LearnMode application plan tomap data, gathered from one or more screens, to documents or
records where each screen represents a learned screen or window in your business application. To create a
LearnMode application plan, complete the following steps.

Prerequisite Start your business application, then open the window and active business object that you
want Perceptive Content to learn.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, expandApplication Plans, and select LearnMode.
3. In the right pane, on theApplications tab, select New.
4. In thePlan Settings dialog box, select theGeneral tab.
5. Under Information, complete the following substeps.

1. Next toContent Type, select eitherDocument orRecord.

Note: You cannot change the content type once the application plan is created.

2. In theName box, type a unique name for your application plan.
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3. Optional. In theDescription box, type a description for your application plan.
4. Clear the Is active check box if you do not want this application plan to be active.
6. UnderApplication, select themethod you want to use to identify the business application.

Note:

l Themethods used to identify your business application allow you to use wildcard symbols.
l The window title in LearnMode is limited to 128 characters.

7. Click OK.
Perceptive Content captures a screen shot of the business application window and displays it in
LearnModeApplication Plan Designer.

Set HyperLearn settings

You use this LearnModemethod for GUI applications that do not make themselves as accessible to
Perceptive Content as others. To set HyperLearn settings, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click LearnMode, and then perform any of the

following optional actions:

Situation Step

To set the delay time for screen captures l In theDelay list, select the time.

To display an alert when Perceptive Content
encounters an unknown character when reading
a business application screen

l Select theDisplay message when
unknown characters are found check
box.

To restrict font templates to the local computer l Select theUse font templates from local
machine only check box.

To convert an unwanted color appearing in the
document key or screen ID clip region

1. Select the Enable color conversion check
box.

2. In the Search for box, specify the unwanted
color.

3. In theReplace box, specify the color to
convert to.

To allow dynamic relocation of the target area 1. Select the Enable position offset for
dynamic fields check box.

2. Set pixel movement to shift the search area
when a business application's fields shift.
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Situation Step

3. In the Shift Region up/down box, specify
the pixel movement up or down.

4. In the Shift Region left/right box, specify
the pixel movement left or right.

To troubleshoot issues with application plans by
providing screen capture output

1. Select the Enable debug check box.
2. To view the output on the screen, select

Screen.
3. To produce an output file, select File

(hyperlearn.log).

Note: Enabling position offset for dynamic fields shifts the coordinates for all HyperLearn application
plans and templates on the client computer. It is possible this setting can disable other templates.
However, because the screen shifts the same direction on the same business application every time,
this is normally not an issue.

3. Click OK.

What is the Internet Explorer method?

The Internet Explorer method is the LearnMode typemethod you use with web-based applications.

Business applications that are rendered through HTML, ActiveX, Java, Macromedia Flash, or some
combination of these are easily integrated with Perceptive Content.

LearnMode using the Internet Explorer method utilizes an HTML parser that conducts browser interrogation to
identify property values. Data is obtained automatically and dynamically from the web application running on
your desktop. When capturing data from your business application, LearnMode delivers the unique controls to
the application plan. These controls are used in the captured window to define document property values and
the screen label.

What is the HyperLearn method?

The HyperLearnmethod is the LearnMode typemethod used with GUI applications that are not as accessible
to Perceptive Content as others.

Some custom-built applications, for example, may not adhere to all current Windows interface standards, and
can only deliver bitmapped data about aWindows screen. In this case, LearnMode using the HyperLearn
method utilizes an on-screen character recognition process to gather data from the business application.
Basically, the HyperLearnmethod takes a screen shot of the business application window, analyzes its
content, and converts the screen characters into text.



Manage Documents User Guide

59

In other methods, field data is gained from controls. HyperLearn instead intelligently interprets the characters
presented within a defined region on the window, including the title bar. Properties are defined by drawing
boxes around the content you want in the captured window.

Using this method requires that you know the specific window font information, type face, point size and
formatting style, used by the business application. Youmay need to contact the original manufacturer or
designer of the business application to obtain font information.

What is LearnMode?

LearnMode is a client-side, non-programmatic method of integrating your business application with Perceptive
Content and learning screens or windows within that application.

The LearnMode type application plan offers six different methods to learn your business application, and the
best method to use depends on the type of application you are using. Knowing whether your application is
GUI-based, web-based, DOS-based, a terminal emulator, or other type of application will assist in
determining the LearnModemethod to use. Sometimes, it takes tryingmore than one LearnModemethod to
determine which one works best for your particular application.

Each application plan you create can use a different LearnModemethod. A LearnMode application plan
contains screens. Creating a screen involves capturing the data from your business application screen so that
you can create properties to link the image to a business object in your application. There should be one
screen in the application plan for each screen or window in your business application. For example, a General
Banking System business applicationmay have aMain screen, a Summary screen, and a Loan screen.

What is the Terminal Capture method?

The Terminal Capturemethod is the LearnMode typemethod you use with terminal emulator programs and
mainframe programs.

This method uses a straightforward technique of copying the business application screen contents to the
system clipboard. This method is most commonly used with Terminal Emulation programs. The terminal
emulator displays data screens from amainframe or online business application.

Depending on the terminal emulator that you use, the way it copies screen data to the clipboard varies. A
connect string is needed for each screen that is created. The connect string provides LearnMode with a set of
system level program calls that relate specifically to the terminal emulation program being used. Determining
the connect string is one of themost difficult tasks in this method. The clipboard contents are then copied into
the captured window in the screen. Document property values are defined by highlighting the text in the
captured window. The screen label is defined the sameway.

We recommend checking with Perceptive Software Product Support to ask if the connect strings have
already been determined for the terminal emulator for another customer using the same program.



Manage Documents User Guide

60

What is the Viewpoint method?

The Viewpoint method is the LearnMode typemethod that is a hybrid between theWindow Walker and
HyperLearnmethods and is used with someGUI applications on theWindows platform.

It is similar toWindow Walker in that it is control-based. However, instead of using address of node in the
control tree to identify and locate data, Viewpoint (formerly known as Window Text) uses x,y coordinates
(similar to HyperLearn) to locate a control. The controls can be in a disabled state and the window can be
dragged off the screen. Property values are defined by clicking the pointer in each text box in the captured
window. This method also usually defines the screen label for you by collecting the text in the title bar of the
captured window.

Perceptive Content includes an enhancement to LearnMode using the Viewpoint method to expand options
for learning web-based applications that were built with tools such as Macromedia Flash and for use by
Mozilla Firefox users.

What is the Window Walker method?

TheWindow Walker method is the LearnMode typemethod you use with someGUI applications that conform
toMicrosoft Windows interface design guidelines.

Many applications in use today have a graphical user interface that operates entirely within a single window
on the desktop. Examples of applications that run inside a single window areMicrosoft Word andMicrosoft
Excel. Custom-built applications alsomay fall into this category. Additionally, Window Walker can learn
some Java applets and applications that run in browsers.

These application windows are published to the operating system in such a way that LearnMode can easily
communicate with them using theWindow Walker method. Different information is contained within easily
distinguishable controls, such as fields, images, and objects. Data is obtained automatically and dynamically
from theWindows application running on your desktop. When capturing data from your business application,
Window Walker method it delivers the unique control IDs to the application plan for defining property values
and the screen label.

Manual Type

About using the Manual type

You use theManual type application plan as a stand-alone system, or when a business application is not
available.

When using aManual type application plan, some of the properties can bemanually entered. This is different
from the LearnMode application plan type where the properties are defined dynamically using values from a
captured screen in the business application. There are features available during property definition that can
makemanual entry less manual.

For example, predefined lists applied to properties present the user with a list of choices when linking
an image, and scripts can process entered data.
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Create a manual application plan

You use theManual application plan tomap data to documents or records without using an agent, Interact
client, or business application. To create amanual application plan, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, expandApplication Plans and selectManual.
3. In the right pane, on theApplications tab, select New.
4. In the Plan Settings dialog box, select theGeneral tab.
5. Under Information, complete the following substeps.

1. Next toContent Type, select eitherDocument orRecord.

Note: You cannot change the content type once the application plan is created.

2. In theName box, type a unique name for your application plan.
3. Optional. In theDescription box, type a description for your application plan.
4. Clear the Is active check box if you do not want this application plan to be active.

6. Click OK.

Visual Basic

About using Visual Basic scripts

In Perceptive Content, you can useMicrosoft Visual Basic scripting as a tool to extend functionality.

When creating an application plan, you can create, modify, and apply Visual Basic scripts to a property,
custom property, or dictionary data element.

For example, if you have a dictionary element called Full Namewith the value "Bruce Jones", you can
create a script that reverses the first name and the last name to read "Jones, Bruce".

You can also create and apply a script to the Field1 property to remove all punctuation (that is, dashes) from a
social security number. As a result, the Visual Basic script updates the social security number "123-45-6789"
to the number "123456789."

When you add a script to an item or container property, the script runs prior to the context mapping. If you
select the User Entry source option, however, Perceptive Content clears the script data from the property to
allow for user entry of data.
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Apply a Visual Basic script

A Visual Basic script defines how Perceptive Content formats and processes screen data elements before
the elements are added to the dictionary, or when applied to amap value. To apply a Visual Basic script,
complete the following steps.

l In the Screens pane, select the screen you want, and then do one of the following actions.
l Apply a Visual Basic script to a dictionary dataelement
l Apply a Visual Basic script to amap value

Suppose you want to remove the dashes from the social security numbers youmap using an
application plan in your HumanResources department. To remove the dashes, you apply the following
script:
workingvalue = DeleteChars(workingvalue, "-")

To test this script, in the Input box, type 123-45-6789 and click Test. If the script works properly,
"123456789" appears in the Test box. When you apply a Visual Basic script, Perceptive Content runs
that script each time a user invokes the application plan.

Create a Visual Basic script

In Perceptive Content, you can useMicrosoft Visual Basic Scripting as a tool to extend functionality. To
create a Visual Basic script, complete the following steps.

1. InApplication Plan Designer, in theScreens pane, select the appropriate screen, and then do one of
the following actions:

Situation Steps

Create a Visual Basic script for a dictionary data
element

1. In theDictionary pane, double-click the
dictionary data element for which you want
to create a Visual Basic script.

2. In theDictionary Field dialog box, under
Processing, clickAdd > Script.

3. In the Script dialog box, clickCreate, and
then type a new name for your script.

4. Select the script you just created and click
Modify.

Create a Visual Basic script for a map value 1. In the right pane, click theMap tab and then
double-click the value for which you want to
create a Visual Basic script.

2. In theAttributes dialog box, under
Advanced, from the Scripts list, select
Manage Scripts.
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Situation Steps

3. In the Script dialog box, clickCreate, and
then type a new name for your script.

4. Select the script you just created and click
Modify.

2. In theScript New Script dialog box, create your Visual Basic script by typing the information in the text
box underScript.

3. UnderSample, in the Input box, enter a value that allows you to test the script you just created.
4. Click Test, and verify Perceptive Content returns the appropriate value.
5. To close theScript New Script dialog box, click OK.
6. To close theScripts dialog box, click OK.
7. To close theDictionary Field dialog box orAttributes dialog box, click OK.

Modify a Visual Basic script

In Perceptive Content, you can useMicrosoft Visual Basic Scripting as a tool to extend functionality. To
modify a Visual Basic script, complete the following steps.

1. InApplication Plan Designer, in theScreens pane, select the appropriate screen, and then do one of
the following actions.

Action Steps

Modify a Visual Basic script for a dictionary data
element

1. In theDictionary pane, double-click the
dictionary data element for which you want
to create a Visual Basic script.

2. In theDictionary Field dialog box, under
Processing, select the script you want to
modify and then clickModify.

3. In the Script dialog box, select the script
you want to modify and then clickModify.

4. Select the script you just created and click
Modify.

Modify a Visual Basic script for a map value 1. In the right pane, click theMap tab, and
then double-click the value you want to
modify in a Visual Basic script.

2. In theAttributes dialog box, under
Advanced, from the Scripts list, select
Manage Scripts.
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Action Steps

3. In the Script dialog box, select the script
you want to modify, and then clickModify.

2. In theScript - New Script dialog box, modify your Visual Basic script by typing the information in the
text box underScript.

3. UnderSample, in the Input box, enter a value that allows you to test the script you just created.
4. Click Test, and verify that the script returns the appropriate value.
5. To close theScript - New Script dialog box, click OK.
6. To close theScripts dialog box, click OK.
7. To close theDictionary Field dialog box orAttributes dialog box, click OK.
8. CloseApplication Plan Designer.

Remove a Visual Basic script

This procedure removes a visual basic script from a defined data element. To remove a Visual Basic script,
complete the following steps.

1. InApplication Plan Designer, in theScreens pane, select the appropriate screen, and then do one of
the following actions:

Situation Steps

Remove a Visual Basic script applied to a
dictionary data element

1. In theDictionary pane, double-click the
dictionary data element where you want to
remove a Visual Basic script.

2. In theDictionary Field dialog box, under
Processing, select the script you want to
delete and then clickModify.

3. In the Scripts dialog box, select the script
you want to delete and then clickDelete.

4. In the confirmation dialog box, clickYes.
5. To close the Scripts dialog box, clickOK.
6. To close theDictionary Field dialog box,

clickOK.

Remove a Visual Basic script applied to a map
value

1. In the right pane, click theMap tab, and
then double-click the value for which you
want to remove a Visual Basic script.

2. In theAttributes dialog box, in the Script
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Situation Steps

list, select None.
3. To close theAttributes dialog box, click

OK.

2. CloseApplication Plan Designer.

Rename a Visual Basic script

In Perceptive Content, you can useMicrosoft Visual Basic Scripting as a tool to extend functionality. To
rename a Visual Basic script, complete the following steps.

1. InApplication Plan Designer, in theScreens pane, select the appropriate screen, and then do one of
the following actions:

Situation Steps

Rename a Visual Basic script in applied to a
dictionary data element

1. In theDictionary pane, double-click the
dictionary data element where you want to
rename a Visual Basic script.

2. In theDictionary Field dialog box, under
Processing, select the script you want to
rename and then clickModify.

3. In the Scripts dialog box, select the script
you want to rename, and then click
Rename.

4. Type the new name of the script.
5. To close the Scripts dialog box, clickOK.
6. To close theDictionary Field dialog box,

clickOK.

Rename a Visual Basic script applied to a map
value

1. In the right pane, click theMap tab, and
then double-click the value where you want
to rename a Visual Basic script.

2. In theAttributes dialog box, under
Advanced, select Script > Manage
Scripts.

3. In the Scripts dialog box, select the script
you want to rename, and then click
Rename.

4. Type the new name of the script.
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Situation Steps

5. To close the Scripts dialog box, clickOK.
6. To close theAttributes dialog box, click

OK.

2. CloseApplication Plan Designer.

Visual Basic script functions

The following list describes key functions you can use in your scripts. Each list item contains information
about a function, its syntax, any arguments you need to supply, an example of the function, and the results of
the example.

AppGetData

This function returns a screen element.

Syntax

String appGetData(int hwnd, String Path, String Type)

Arguments

Use FindWindow to get the identifier of the window (hwnd). The type can be any of the following
quoted strings. Value is the default.

l Name
l Description
l Window
l Value

String Path can be a point, the path, or a path/name. When it is a point, it is relative to the top left corner
of the host application. The path is designated by children (1|4 would be the first child of the window,
and then its fourth child).

A name can be specified using the format n^String. It looks for theNth instance of that name, where
N is the number specified. If the number is not specified it uses the first instance of the name found.

Example

Point = appGetData(hwnd, "POINT(150,200)", "Value")

Path = appGetData(hwnd, "4|4|4|3|4|1|1|1|1|1|1|1|4|1|5|1", "Value")

Name = appGetData(hwnd, "1|2^Test|4|1|1|3", "Value")
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Result

Result is Smith, John F .

AppGetDataVisible

This function returns a screen element from a visible window.

Syntax

String appGetDataVisible(int hwnd, String Path, String Type)

Arguments

Use FindWindow to get the identifier of the window (hwnd). The type can be any of the following
quoted strings. Value is the default.

l Name
l Description
l Window
l Value

String Path can be a point, the path, or a path/name. When it is a point, it is relative to the top left corner
of the host application. The path is designated by children (1|4 would be the first child of the window,
and then its fourth child).

A name can be specified using the format n^String. It looks for theNth instance of that name, where
N is the number specified. If the number is not specified it will use the first instance of the name found.

Example

Point = appGetDataVisible(hwnd, "POINT(150,200)", "Value")

Path = appGetDataVisible(hwnd, "4|4|4|3|4|1|1|1|1|1|1|1|4|1|5|1",
"Value")

Name = appGetDataVisible(hwnd, "1|2^Test|4|1|1|3", "Value")

Result

The result is Smith, John F .

ClipboardGetData

This function returns data from aDOS or terminal application using the clipboard.

Syntax

string ClipboardGetData(int hwndSelectedWind, int Position, int Length,
int ConnectionDelay, int ConnectionRetries, string ConnectionString)
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Arguments

Int hwndSelectWind is the window handle of the application plan.

Int Position is the starting position. This argument assumes a starting position at 80 columns. For
example, 0-80 is line one, 81-161 is line two, 162-242 is line three, and so on.

Int Length is the number of characters to capture.

Terminal Capture Arguments

Int ConnectionDelay sets the delay in the seconds between connection attempts.

Int ConnectionRetries is the number of times to retry.

String ConnectionString determines how to capture the data.

Example

window = FindWindow("Test App")

results = ClipboardGetData(window, 0, 20, 5, 5, "57634;")

Result

The result is Smith, Jones .

DeleteChars

This function deletes all specified characters.

Syntax

STR DeleteChars(STR SourceStr, STR CharsStr)

Arguments

String rawValue is the string from which you want to remove characters.

String charsToDelete are the characters to delete from the rawValue string.

Example

WorkingValue = DeleteChars(folder, "()- ")

Result

The string "(913) 111-1111" becomes "9131111111".

DeleteCharsOfType

This function deletes the specified characters of a certain type.

Syntax

STR DeleteCharsOfType(STR SourceStr, STR TypeStr)
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Arguments

p specifies punctuation.

a specifies alphabetical characters.

d specifies numeric characters.

Example

WorkingValue = DeleteCharsOfType(folder, "pa")

Result

The string abc9999.. becomes 9999 .

DeleteRangeOfChars

This function parses a string and deletes the specified amount of characters from that string.

Syntax

STR DeleteRangeOfChars(STR SourceStr, int StartPos, int Len)

Arguments

String rawValue is the string from which to remove characters.

Integer startChar is the starting position in the rawValue string.

Integer length is the number of characters after startChar to delete.

Example

WorkingValue = DeleteRangeOfChars(folder, 0, 3)

Result

The string abcdefgh becomes defgh .

DoMacroAlpha

This function removes all non-alphabetic characters.

Syntax

STR DoMacroAlpha(STR rawValue)

Arguments

String rawValue is the string of non-alphabetic characters you want to remove.

Example

msgbox "Alpha: " + DoMacroAlpha("a1@b2#c3$")
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Result

The string a1@b2#c3$ becomes abc .

DoMacroAlphaNumeric

This function removes all non-alphanumeric characters.

Syntax

STR(STR rawValue)

Arguments

String rawValue is the string from which to remove non-alphanumeric characters.

Example

msgbox "AlphaNumeric: " + DoMacroAlphaNumeric("a1@b2#c3$")

Result

The string "a1@b2#c3$" becomes a1b2c3 .

DoMacroDateConversion

This function converts a string variable to a variable of date type.

Syntax

STR(STR rawValue, string dateFormat)

Arguments

String rawValue is the string to convert to a date.

String dateFormat is the format in which the date string was passed. You can include the following
format variables:

l m represents amonth number
l M represents amonth letter
l d represents day
l y represents year

Example

msgbox "Date: " + DoMacroDateConversion("OCT 16th, 1978", "MMM dd, yyyy")

Result

The string OCT 16th, 1978 becomes 10/16/1978 .
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DoMacroDeleteCharacters

This function removes specific characters from a string.

Syntax

STR(STR rawValue", STR charsToDelete)

Arguments

String rawValue is the value from which to remove the characters.

String charsToDelete is the list of characters to remove from rawValue.

Example

msgbox "Delete Characters: " + DoMacroDeleteCharacters("INV-778989",
"INV-")

Result

The string INV-778989 becomes 778989 .

DoMacroLeadingZeros

This function removes leading zeros from a string.

Syntax

STR(STR or int rawValue)

Arguments

String rawValue is the value from which the leading zeros are removed.

Example

msgbox "Remove Zeros: " + DoMacroLeadingZeroes("000012345")

Result

The string 000012345 becomes 12345 .

DoMacroFixedLength

This function returns the designated amount of characters from a string.

Syntax

STR DoMacroFixedLength(STR rawValue, int length, bool fromLeft)
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Arguments

String rawValue is the value to convert.

Integer length is the number of characters to return from the string value.

If the boolean fromLeft is set to true, the substring returned is the number of characters starting from
the left, plus the value length. If fromLeft is set to false, the substring returned is the number of
characters starting from the right, plus the value length.

Example

msgbox "Fixed Length (left): " + DoMacroFixedLength("abcdefg", 4, true)

Result

The string abcdefg returns abcd .

DoMacroNumberConversion

This function returns a value of type number.

Syntax

STR(STR or int rawNum, int numOfDecimals, char separator)

Arguments

String or integer rawNum is the value to format as a number.

Integer numOfDecimals is the total decimal numbers.

Character separator is the decimal separator to use.

Example

msgbox "Number: " + DoMacroNumberConversion("1234.12", 0, ".")

Result

The string 1234.12 becomes 1234 .

DoMacroNumeric

This function converts a string variable to a numeric variable.

Syntax

STR(STR rawValue)

Arguments

String rawValue is the string from which to remove non-numeric characters.



Manage Documents User Guide

73

Example

msgbox "Number: " + DoMacroNumber("INV-8899878")

Result

The string INV-8899878 returns 8899878 .

DoMacroLineSearch

This function searches multiple lines based on the input string and extracts data from the specified line.

Syntax

STR DoMacroLineSearch(STR Input, int LineNum, STR Direction, int
StartPos, STR StopType, STR StopValue)

Arguments

String Input is the string to search.

Integer LineNum is the line of text from input to process (1 is the first line).

String Direction is either "Forward" or "Backward" and is the direction to search.

Integer StartPos is where in the line of text the data starts. When direction is backward, the first
character position is the end of the line.

String StopType indicates how many characters from the StartPos to return. Valid quoted string values
include:

l EndOf Line
l Character Length
l Stopping Characters

Example

input = "this is a test" & vbNewLine & "This is only a test" &
vbNewLine & "Testing 1, 2, 3"

text1 = DoMacroLineSearch(input, 2, "Forward", "9", "Character
Length", "6")

Result

The result string is only a .

Additional information

If StopType is "Character Length", StopValue is a number of characters to return. If StopType is
"Stopping Characters", the StopValue is a character pattern that indicates where to stop the string
returned.
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DoMacroStaticSearch

This function searches for text based on the input string and returns text from the results.

Syntax

STR DoMacroStaticSearch(STR Input, STR AnchorText, int LineOffset, STR
Direction, STR StopType, STR StopValue)

Arguments

String Input is the string to search.

String AnchorText is the text to search for.

Integer LineOffset is the number of lines above or below the anchor text to select. Zero(0) selects the
line that contains the AnchorText, a negative number s a line above and a positive number selects a
line below.

String Direction is either "Forward" or "Backward" and is the direction to search.

String StopType indicates how many characters from the StartPos to return. Valid quoted string values
include:

l EndOf Line
l Character Length
l Stopping Characters

Example

Input = "this is a test" & vbNewLine & "This is only a test" &
vbNewLine & "Testing 1, 2, 3"

"Forward", "End Of Line",)

Result

The result string is Testing 1, 2, 3 .

Additional information

If StopType is "Character Length", StopValue is a number of characters to return. If StopType is
"Stopping Characters", the StopValue is a character pattern that indicates where to stop the string
returned.

DoMacroUser

This function returns a value of type Perceptive Content username.

Syntax

DoMacroUser(String userName)
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Arguments

String userName is the user name to pass into Perceptive Content.

Example

msgbox "User: " + DoMacroUser("jsmith")

Result

The result is User:jsmith .

DocProperty

This function can set a property for a document or return the desired value.

Syntax

string DocProperty(string customPropName)

Arguments

String customProperty is the name of the custom property that needs to be set.

Example

DocProperty("Name") = " Jane Doe"

Result

The result string is Name: Jane Doe .

Field

This function can set or return the current value from an element in the dictionary.

Syntax

string Field(string dictionaryElement)

Arguments

String dictionaryElement is the dictionary element name.

Example

msgbox Field("Last Name")

Result

Returns the current value from the dictionary element called Last Name.

FolderProperty

This function can set a property for a folder or return a specific value.
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Syntax

string FolderProperty(string customPropName)

Arguments

String customPropName is the name of the custom property that needs to be set.

Example

FolderProperty("Patient ID") = "9910552"

Result

The result string is Patient ID: 9910552 .

FindWindow

This function searches the desktop for a window title that matches the argument.

Syntax

int FindWindow(STR WindowTitle)

Arguments

String WindowTitle is the title to search for and can include wildcards (* or ?)

Example

hwnd = FindWindow("Internet Explorer")

Result

The result is an integer that identifies the window in the system.

Additional information

The returned value is most useful when used as the first parameter to AppGetData.

GetActiveScreenName

This function returns the user defined screen name that Perceptive Content is currently using.

Syntax

GetActiveScreenName()

Example

msgbox GetActiveScreenName()
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Result

Returns the current user defined screen name.

GetINowINIString

This function reads a string from the ImageNow.ini file.

Syntax

string GetINowINIString(string SectionName, string KeyName)

Arguments

String SectionName is the name of the section in the INI file to search for the key.

Example

Result = GetINowINIString("Logon Settings", "Default")

Result

Result contains the name of the default Perceptive Content connection profile.

GetScreenText

This function gets the text on the screen at the supplied x and y coordinates, to the specified length.

Syntax

String GetScreenText(int Xpos, int Ypos, int Len)

Arguments

Integer Xpos is the horizontal position of the first character retrieved with a value of 1 indicating the
leftmost character.

Integer Ypos is the vertical position of the first character retrieved with a value of 0 being the topmost
line.

Integer Length is the number of characters to return.

Example

WorkingValue = GetScreenText(0, 8, 15)

Result

The result string is City: Crestview .

HyperlearnCreateFont

This function creates the font string necessary for HyperlearnGetData.
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Syntax

string HyperlearnCreateFont(string fontName, int fontSize, int Weight,
int Italic)

Arguments

String fontName is the name of the font.

Integer fontSize is the size of the font.

Integer Weight is 400 for normal weight fonts, 700 for bold.

Integer Italic is 0 for normal, 1 for italic.

Example

font = HyperlearnCreateFont("Courier", 12, 400, 0)

Result

The result string is -11,0,0,0,400,0,0,0,0,0,0,0,0,Courier .

HyperlearnGetData

This function extracts the text from an area of a window using Hyperlearn technology.

Syntax

string HyperlearnGetData(int selectedWindow, int left, int top, int width, int height, string font)

Arguments

Integer hwndSelectWind is the window handle from which to get data. Use the FindWindow()
method to get the window handle.

Integer left is the left side of the rectangle that specifies where HyperLearn should look for text.

Integer top is the top of the rectangle that specifies where HyperLearn should look for text.

Integer height is the height of the rectangle that specifies where HyperLearn should look for text.

String font specifies the font HyperLearn should use when looking for text in the specified rectangle.

Example

hwnd = FindWindow("PSI higher Ed Demo")

font = HyperlearnCreateFont(Courier, 12, 400, 0)

result = HyperlearnGetData(hwnd, 100, 200, 50 16 font)

Result

The text extracted from the area at pixel coordinates 100, 200 with a width of 50 pixels and a height of 16
pixels from the window titled "PSI Higher Ed Demo."
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Additional information

HyperlearnCreateFont creates the font string. Youmust first add fonts to the application plan to receive
results.

IntToStr

This function converts an integer to a string.

Syntax

String IntToString(int Num)

Arguments

Integer Num is the integer value to convert to a string format.

Example

s=IntToString(99)

Result

The result string is 99 .

Additional information

This method was deprecated in version 6.7. Replace it with the Visual Basic Scriptingmethod, CStr.

LogError

This function writes amessage to the client log file.

Syntax

void LogError(String message)

Arguments

Message to be written to the log

Example

LogError( an error occurred in the LearnMode script )

Result

The result string is added to the client log file.

LogWarning

This function writes amessage to the client log file.

Syntax
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void LogWarning(String message)

Argument

Message to be written to the log

Example

LogWarning( something happened in the LearnMode script )

Result

If the client log level is 1 or greater, the string is added to the client log file. If the client log level is 0, then
no action is taken.

NameReorder

This function converts a string that contains a first name, a space, and a last name to a last name, comma,
first name format.

Syntax

STR NameReorder(STR SourceStr)

Arguments

String SourceStr is the string that is reordered.

Example

WorkingValue = NameReorder(folder)

Result

The string John Doe becomes Doe, John .

PostDocProperty

This function can set a property for a folder or return the desired value.

Syntax

string PostDocProperty(string customPropName)

Arguments

String customPropName is the name of the custom property that needs to be set.

Example

PostDocProperty("Patient ID") = "9910552"
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Result

The string result is 9910552 .

PostField

This function can set the current value or return from an element in the dictionary.

Syntax

string PostField(string dictionaryElement)

Arguments

String dictionaryElement is the dictionary element name.

Example

msgbox PostField("Last Name")

Result

Returns the current value from the dictionary element called Last Name.

PostFolderProperty

This function can set a property for a folder or return a specific value.

Syntax

string PostFolderProperty(string customPropName)

Arguments

String customPropName is the name of the custom property that needs to be set.

Example

PostFolderProperty("Name") = " Joe Smith"

Result

The result string is Name: Joe Smith .

SetFocus

Searches for a namedwindow and gives it input focus.

Syntax

int SetFocus(string windowTitle)
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Arguments

String windowTitle is the title of the window for which to search.

Example

success = SetFocus("PSI Higher Ed Demo")

Result

The window titled "PSI Higher Ed Demo" moves to the foreground and has input focus. Success equals
1 if the window is found.

SetForeground

This function finds the window with a given handle and gives it input focus.

Syntax

int SetForeground(Int64 hWnd)

Arguments

Integer hWnd is the window handle that receives focus.

Example

hwnd = FindWindow("PSI Higher Ed Demo")

result = SetForeground(hwnd)

Result

The window titled "PSI Higher Ed Demo"moves to the foreground and has input focus. Success equals
1 if the window is found.

ShellOpen

This function launches a program or a file.

Syntax

ShellOpen(String Command)

Arguments

Command is a program or a file to open.

Example

ShellOpen("c:\Somefile.txt")

ShellOpen("calc.exe")
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Result

NotePad opens with c:\Somefile.txt loaded. The calculator application also is opened.

Sleep

This function establishes the amount of time to pause without doing anything.

Syntax

void Sleep(int msec)

Arguments

Supply the time for msec in milliseconds.

Example

Sleep(100) ' 1/10th of a second

Result

The script is paused for 1/10th of a second.

SwipSwapFromBegin

This function takes a specified number of characters from the beginning of a string andmoves them to the end
of the string.

Syntax

STR SwipSwapFromBegin(STR SourceStr, int Len)

Argument

Supply the string in SourceStr. Integer Len is the number of characters to take, starting at the
beginning of the string.

Example

WorkingValue = SwipSwapFromBegin(folder, 3)

Result

The string result is abcdefgh becomes defghabc .

SwipSwapFromEnd

This function takes a specified number of characters from the end of a string andmoves them to the beginning
of the string.

Syntax

STR SwipSwapFromEnd(STR SourceStr, int Len)



Manage Documents User Guide

84

Arguments

Supply the string in SourceStr. Integer Len is the number of characters to take, starting at the end of
the string.

Example

WorkingValue = SwipSwapFromEnd(folder, 3)

Result

The result string abcdefgh becomes fghabcde .

SwipSwapFromPos

This functionmoves a specified number of characters from one position to another in a string.

Syntax

STR SwipSwapFromPos(STR SourceStr, int StartPos, int Len, int EndPos)

Arguments

Supply the string in SourceStr. Integer

StartPos is the starting character position beginning at 0.

Integer Len is the number of characters to take.

Integer Endpos is the character position where the string is moved, where the first character is 0.

Example

WorkingValue = SwipSwapFromPos(folder, 4, 2, 1)

Result

The string abcdefgh becomes aefbcdgh .

Term

This function searches for windows to close based on "CLASS" or "TITLE."

Syntax

int Term String Mode, String Name, String Command
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Arguments

String Mode specifies how to search for windows to close based on "CLASS", or "TITLE." "CLASS"
searches for windows with a class that exactly matches the Name parameter. "TITLE" searches for
windows whose title text contains the Name parameter.

String Name is the string tomatch in the window title or class. This parameter is case sensitive.

String Command specifies how to closematched windows and can be "QUIT," or "CLOSE." In general,
windows that receive the "CLOSE" message prompt the user to save changes before closing. The
"QUIT" message closes the application immediately.

Example

Term = "TITLE," "NotePad," "QUIT."

Result

All open NotePad windows are closed.

TopMsg

This function displays a window with the specified text.

Syntax

TopMsg(string message)

Arguments

String message is themessage to display.

Example

TopMsg = "Hello World"

Result

A dialog box displays the text "HelloWorld" inside.

WindowTitle

This function returns a specified number of characters in the window title of the current window.

Example

myWindowTitle = WindowTitle

Result

The string result is PSI Banking Demo .
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WinGetData

This function returns text from awindow usingWindowWalker.

Syntax

string WinGetData(int windowHandle, string directions)

Arguments

Integer selectedWindow is the handle to the window from which to get data. Use the FindWindow
() function to get the window handle.

String directions is the information passed to theWindowWalker extractor to access the control.

Example

hwnd = FindWindow("PSI Higher Ed Demo")

result = WinGetData(hwnd, "D3;L7")

Result

The result string is 206528888 .

Testing VB script functions

The Test button in the script editor does not always produce valid results when using these functions. To test
your code, save the template, close the application plan, and then click on the icon in the Perceptive
Content toolbar to view the results.

Visual Basic script variables

Below is a list of variables you can use in your Visual Basic scripts.

The Test button in the script editor does not always produce valid results when using these functions. To test
your code, try saving the template, closing the application plan, and then clicking on the icon in the ImageNow
Client toolbar to view the results.

Note: In previous versions of Perceptive Content, you used Folder and Tab. In Perceptive Content 6.7,
these supported document key variables changed to Field1 and Field2. While Folder and Tab are currently
supported, they may be deprecated in future versions.

Document key variables

Drawer

DocName

Field1

Field2
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Field3

Field4

Field5

DocType

Post-macro document key variables

PostDrawer

PostDocName

PostField1

PostField2

PostField3

PostField4

PostField5

PostDocType

Other variables

User - Logged in user name

Group - Logged in user group name

AppPlan - Name of the current application

Reserved variables

WorkingValue - Sets the current dictionary element to the desired value. This can also be used to get the
current dictionary element.

ScreenFound - The default for this value is FALSE. The script sets the value to TRUE if the screen is
found. If FALSE, the next available screen is used.

Visual Basic scripts for DDE

You can use the following functions in any script in application plan types. These functions are useful with the
DDE LearnMode type.

The Test button in the script editor does not always produce valid results when using these functions. To test
your code, try saving the template, closing the application plan, and then clicking on the icon in the ImageNow
Client toolbar to view the results.
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Note: These Dynamic Data Exchangemethods are deprecated in Perceptive Content 6.7. In previous
versions of Perceptive Content, you used Folder and Tab. In Perceptive Content 6.7, these supported
document key variables changed to Field1 and Field2. While Folder and Tab are currently supported, they
may be deprecated in future versions.

Script Name Syntax

DDEExecute int DDEExecute(int Channel, STRCommandStr)

DDEInitiate int Channel = DDEInitiate(STR AppStr, STR
TopicStr)

DDEPoke int DDEPoke(int Channel, STR ItemStr, STR
DataStr)

DDERequest STRDDERequest(int Channel, STR ItemStr)

DDETerminate int DDETerminate(int Channel)

DDE Script Example

The following example script reads keys fromMicrosoft Excel.

nChannel = DDEInitiate("excel", "test.xls")

if nChannel <> -1 then

s = DDERequest(nChannel, "R1C1")

field1 = left(s, len(s)-2)

s = DDERequest(nChannel, "R1C2")

field2 = left(s, len(s)-2)

s = DDERequest(nChannel, "R1C3")

field3 = left(s, len(s)-2)

s = DDERequest(nChannel, "R1C4")

field4 = left(s, len(s)-2)

s = DDERequest(nChannel, "R1C5")

field5 = left(s, len(s)-2)

DDETerminate(nChannel)

end if
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Visual Basic scripts for Internet Explorer

You can use the functions described in this section in any script in application plan types. These functions are
only effective in capturing values fromMicrosoft Internet Explorer pages. They are useful with the Internet
Explorer LearnMode type.

IECapture

This function captures the data from Internet Explorer in the form of name/value pairs and stores them for
subsequent searches. It returns the number of pairs found.

Syntax

IECapture (bool useTDtags, HWND hwndSelectedWind)

Arguments

useTDTags: use this boolean if LTD tags need to be captured.

hwndSelectedWind: specifies the handle for the window to capture the data from, 0 to use the top-
most Internet Explorer window.

Example

size = IECapture(false, 0)

Results

0: <PEB#1>,"Student Name:"

1: <PEB#2>,"Smith, James"

2: <PEB#3>, "Student ID:",

3: <PEB#4>,"1234567"

4: <PEB#5>,"Date of Birth:"

5: <PEB#6>, "6/14/1987"

size = 6

Example

size = IECapture(true, 0)
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Results

0: <LTD#1>, Student Name:

1: <LTD#2>, Smith, James

2: <LTD#3>, Student ID:

3: <LTD#4>, 1234567

4: <LTD#5>, Date Of Birth:

5: <LTD#6>, 6/14/1987

6: <LTD#7>, First Term:

7: <LTD#8>, Fall 2008

8: <PEB#1>, Student Name:

9: <PEB#2>, Smith, James

10: <PEB#3>, Student ID:

11: <PEB#4>, 1234567

12: <PEB#5>, Date of Birth:

13: <PEB#6>, 6/14/1987

size = 14

Note: Youmust use the IECapture or the IECaptureEx function first to store data for subsequent searches.
All the following function examples use IECapture(true, 0) or IECaptureEx(true, 0, myArray).

IECaptureEx

This function captures a specified set of named fields from Internet Explorer and stores them for subsequent
searches.

Syntax

IECaptureEx (bool useTDtags, HWND hwndSelectedWind, VARIANT* pVarIDs)

Arguments

useTDTags: use this boolean if LTD tags need to be captured.

hwndSelectedWind: specifies the handle for the window to capture the data from, 0 to use the top-
most Internet Explorer window.

pVarIDs: a list of IDs to capture from Internet Explorer.



Manage Documents User Guide

91

Example

myArray = Array( CSID , CSID2

size = IECaptureEx(false, 0, myArray)

Results

0: CSID, 12n53n43

1: CSID2, 25n232

2: <PEB#1>, Student Name:

3: <PEB#2>, Smith, James

4: <PEB#3>, Student ID:

5: < PEB#4>, 1234567

6: <PEB#5>, Date of Birth:

7: <PEB#6>, 6/14/1987

size = 8

Example

myArray = Array( )

size = IECaptureEx(true, 0, myArray)
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Results

0: <LTD#1>, Student Name:

1: <LTD#2>, Smith, James

2: <LTD#3>, Student ID:

3: <LTD#4>, 1234567

4: <LTD#5>, Date of Birth

5: <LTD#6>, 6/14/1987

6: <LTD#7>, First Term:

7: <LTD#8>, Fall 2008

8: <PEB#1>, Student Name:

9: <PEB#2>, Smith, James

10: <PEB#3>, Student ID:

11: <PEB#4>, 1234567

12: < PEB#5>, Date of Birth

13: <PEB#6>, 6/14/1987

size = 14

IEGetNameByIndex

This function returns the name at the specified index.

Syntax

IEGetNameByIndex (int nIndex)

Arguments

nIndex: specifies the location of the tag. Zero returns the first tag.

Example

name = IEGetNameByIndex(1)

Results

name = <LTD#2>

Note: Youmust use the IECapture function first to store data for subsequent searches. This example uses
IECapture(true, 0).
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IEGetValueByIndex

This function returns the value at the specified index.

Syntax

IEGetValueByIndex (int nIndex)

Arguments

nIndex: specifies the location of the value. Zero returns the first value.

Example

value = IEGetValueByIndex(1)

Results

value = Smith, James

Note: Youmust use the IECapture function first to store data for subsequent searches. This example uses
IECapture(true,0).

IEFindName

This function allows you to search for a name and it returns the location where it was found. It returns -1 if not
found.

Syntax

IEFindName (LPCTSTR name, int nStart, bool bCaseSensitive)

Arguments

Name: specifies the name to search for.

nStart: specifies the location to start at. Use 0 to start the search from the beginning

bCaseSensitive: use this boolean if the search is case sensitive.

Example

nameLocation = IEFindName ( <PEB#1> , 0, false)

Results

nameLocation = 8

Note: This function supports wild card characters such as * and ?. Youmust use the IECapture function first
to store data for subsequent searches. This example uses IECapture(true,0).
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IEFindNameReverse

This function allows you to search for a name in reverse and it returns the location where it was found. It
returns -1 if not found.

Syntax

IEFindNameReverse (LPCTSTR name, int nStart, bool bCaseSensitive)

Arguments

Name: specifies the name to search for.

nStart: specifies the location to start at. Use -1 to start at the end.

bCaseSensitive: use this boolean if the search is case sensitive.

Example

nameLocation = IEFindNameReverse ( <PEB#1> , 6, true)

Results

nameLocation = -1

Note: This function supports wild card characters such as * and ?. Youmust use the IECapture function first
to store data for subsequent searches. This examples uses IECapture(true,0).

IEFindValue

This function allows you to search for a value and it returns the location where it was found. It returns -1 if not
found.

Syntax

IEFindValue (LPCTSTR value, int nStart, bool bCaseSensitive)

Arguments

Value: specifies the value to search for.

nStart: specifies the location to start at. Use 0 to search from the beginning.

bCaseSensitive: use this boolean if the search is case sensitive.

Example

valuelocation = IEFindValue( Student Name: , 0, true)

Results

valueLocation = 0
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Note: This function supports wild card characters such as * and ?. Youmust use the IECapture function first
to store data for subsequent searches. This example uses IECapture(true,0).

IEFindValueReverse

This function allows you to search for a value in reverse and it returns the location where it was found. It
returns -1 if not found.

Syntax

IEFindValueReverse (LPCTSTR value, int nStart, bool bCaseSensitive)

Arguments

Name: specifies the value to search for.

nStart: specifies the location to start at. Use -1 to start at the end.

bCaseSensitive: use this boolean if the search is case sensitive.

Example

valueLocation = IEFindValueReverse( Student Name: , -1, true)

Results

valueLocation = 8

Note: This function supports wild card characters such as * and ?. Youmust use the IECapture function first
to store data for subsequent searches. This example uses IECapture(true,0).

IEGetValue

This function returns the value when passed the name of the name/value pair.

Syntax

IEGetValue (LPCTSTR value, bool bCaseSensitive)

Arguments

Name: specifies the name to search for.

bCaseSensitive: use this boolean if the search is case sensitive.

Example

WorkingValue = IEGetValue ( <LTD#12> )

Results

The value, which corresponds to the name <LTD#12>, is placed into folder.
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Note: This function supports wild card characters such as * and ?. You can use the IEGetValue function as
a shortcut to calling IECapture and then IEGetValueByName. However, a single IECapture andmultiple
IEGetValueByName calls is a faster option if you needmultiple values.

IEGetValueByName

This function allows you to search for a name and it returns the corresponding value. It returns an empty string
if not found.

Syntax

IEGetValueByName (LPCTSTR name, bool bCaseSensitive)

Arguments

Name: specifies the name to search for.

bCaseSensitive: use this boolean if the search is case sensitive.

Example

value = IEGetValueByName( <PEB#1> , false)

Results

value = Student Name:

Note: This function supports wild card characters such as * and ?. Youmust use the IECapture function first
to store data for subsequent searches. This example uses IECapture(true,0).

The Test button in the script editor does not always return valid results when you use these functions. To test
your code, save the template, close the application plan, and then click the icon in the ImageNow
Client toolbar to view the results.

Add a user-defined script to a button

To add Visual Basic scripts to buttons in the User toolbar, complete the following steps.

1. In ImageNowViewer, display any document.
2. Click View > Toolbars > User.

Note: TheUser toolbar contains five user-defined function buttons.

3. Right-click one of the function buttons and then click Edit Script.

Note: If a script has already been added to this button and you don't want to replace it, click Cancel
and then right-click other function buttons until you find one that is unused.
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4. In theScript Edit Dialog dialog box, from theScript Type list, select Pre and type the first script you
want to run when a user clicks the button.

5. Optional. To run a second script after the first script, using the same button, from theScript Type list,
select Post and then type the second script.

6. Click OK.

Run a script upon opening a workflow item

You can create a VBScript that executes each time a workflow item is open. This is a global script that
executes for all workflow queues in all workflow processes that exist on the ImageNow Server you are
running. To run a script upon opening a workflow item, complete the following steps.

1. Open a workflow item.
2. In ImageNowViewer, clickWorkflow > Page Load Script.
3. In theWorkflow Page Load Script dialog box, type in your VBScript, and then click OK.
4. Close the item, and then in the confirmation box, click Yes.

Configure print and scan
ImageNowPrinter properties
ImageNow Printer prints an electronic file from an application, such as Microsoft Excel, into a document. You
can configure property options such as color, orientation, and watermark type. The following tables describe
each ImageNow Printer property.

Advanced features

The following table lists the options available on the Advanced Features tab.

Units

Determines whether the units of measure for the hardwaremargins and custom paper options are in one-
hundredths (0.01) of an inch or in tenths (0.1) of amillimeter.

Hardware Margins

Allows you to customize the size of the printer-supplied edge of your outputted image. Enter Left/Right
and Top/Bottom hardwaremargin settings into the appropriate field, using themeasurement option you
selected for Units.

Enable Custom Paper

Allows you to set a custom paper size for the generated image file. This selection overrides any other
paper size selections you set.
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Paper Size

Allows you to enter the desiredWidth and Height for the custom paper size, using themeasurement
option you selected for Units.

Printer Area Margins

Allows you to enter Left, Right, Top, and Bottom printer areamargin settings for the custom paper size,
using themeasurement option you selected for Units.

License

Allows you to view license information.

Restore defaults

Restores advanced features defaults.

Compression

The following lists the options available on the Compression tab.

Color Images

Allows you to select the compressionmethod to use for color images. Available options are
Uncompressed RGB, Uncompressed CMYK, Low Quality JPG, Medium Quality JPG, High Quality
JPG, Packbit RGB, Packbits CMYK, LZW RGB, and LZW CMYK.

Indexed Images

Allows you to select the compressionmethod to use for indexed images. Available options are Low
Quality JPG, Medium Quality JPG, High Quality JPG, Packbits, LZW, and None.

Greyscale Images

Allows you to select the compressionmethod to use for greyscale images. Available options are Low
Quality JPG, Medium Quality JPG, High Quality JPG, Packbits, LZW, and None.

Monochrome Images

Allows you to select the compressionmethod to use for monochrome images. Available options are
CCITT Group 4 Fax, CCITT Group 3 2D Fax, CCITT Group 3 1D Fax, CCITT Modified Huffman, LZW,
Packbits, and None.

License

Allows you to view license information.

Restore defaults

Restores compression defaults.
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FAX and TIFF

The following lists the features available on the Fax/TIFF Options tab.

Enable fax mode

Creates faxable images when selected.

Fax Profile

Allows you to select either Profile F (standard) or Profile S (simplified) as your fax format profile. A fax
profile is required if you want to select Enable fax mode.

Fax Resolution

Allows you to select an output resolution. A resolution is required when you select Enable fax mode.
Note that this selection overrides any other resolution selection that you set.

EOLs byte aligned

Instructs ImageNow Printer to align rows of CCITT Group 3 1D and 2D image data on word boundaries.

Reverse Bit Order

Specifies whether image data in a CCITT compressed TIFF file is stored in LSB toMSB orMSB to LSB
order. Enable this check box to select MSB to LSB order. This option does not apply if you select Enable
fax mode and select Profile S as your fax profile.

Invert Photometric

Determines the order of the black and white palette entries for amonochrome TIFF file (MINISWHITE or
MINISBLACK). Select this check box to chooseMINISBLACK order.

Include creation date and time

Adds the creation time and date to the generated TIFF file.

Use Motorola format

Creates TIFF images usingMotorola (big-endian) byte order. The default format is Intel (little-endian)
byte order. This option does not apply if you enable fax mode and select Profile S as your fax profile.

Layout

The following lists the options available on the Layout tab.

Orientation

Specifies how the document is positioned on the page. Portrait orients the paper vertically. Landscape
rotates the paper 90 degrees clockwise.
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Print on Both Sides

Specifies how the document is printed on the page. Choose None, Flip on Long Edge, or Flip on Short
Edge.

Advanced

Displays the AdvancedOptions dialog box.

Paper and quality

The following table lists the options available on the Paper/Quality tab.

Color

Converts documents to color.

Black & White

Converts documents to black and white.

Advanced

Displays the AdvancedOptions dialog box.

Watermark

The following table lists the options available on theWatermark tab.

Enabled

Allows you to use the watermark feature.

Watermark the first page only

Allows you to apply the watermark to the first page only.

Portrait Pages Image File

Allows you to enter the full path to the image file to use as the watermark.

Portrait Pages Position

Determines how the watermark image is placed on the page in portrait orientation. Available options are
Stretch to fit, Tile, and Center.

Portrait Page Brightness

Allows you to adjust the brightness level of the watermark image.

Landscape Pages Image File

Allows you to enter the full path to the image file to use as the watermark.
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Landscape Pages Position

Determines how the watermark image is placed on the page in landscape orientation. Available options
are Stretch to fit, Tile, and Center.

Landscape Pages Brightness

Allows you to adjust the brightness level of the watermark image.

What is ImageNowPrinter?
ImageNow Printer allows you to import an electronic file, such as aMicrosoft Office document or an email,
convert it to TIFF format, and store it.

You can use ImageNow Printer from any software program that has a print option. The options you set in a
capture profile determine how to process documents. Because ImageNow Printer documents are stored as
TIFF files, you can annotate them, set the page orientation, color, and watermark options. You can also use
ImageNow Printer to highlight aWord document or add a sticky note to an email.

ImageNow Printer is included with ImageNow Client and does not require a separate license.

Scanner

About configuring a scanner

You can configure a scanner for any ImageNow Client computer in your enterprise.

Scanning profiles and capture profiles define the behavior of the scanner in connection with ImageNow Client.
You can create up to ten capture profiles and distribute them according to user names, groups, or computer
names. The installation procedure depends on the type of scanner and drivers you install.

Assign master configuration files to all Windows user accounts

Themaster configuration files contain logon profiles, capture profiles, scanning profiles, and custom settings
from the originating computer. To copy these files to all Windows users on the same server, complete the
following steps.

Prerequisite Youmust have a scanner installed on the target ImageNow Client computer and upload
enough CaptureNow licenses on the ImageNow Server for your scanners. If you use Kofax software, create
the correct source in the Scanning Configuration Utility for VRS 4.1.

1. Back up the inscan.xml, indevice.xml, and ImageNow.ini files and, if needed, the other scanning
configuration files.

2. Copy the XML and INI files to the [drive:]\Program Files\ImageNow directory on the target computer
and overwrite any existing files with the same names.
The files you have copied are now themaster configuration files.

3. In each [drive]:\Documents and Settings\<username>\Application Data directory, delete the
Perceptive Content folder.
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Example The <user name> folder is the name for eachWindows user account that logged in to
Perceptive Content on the target computer.

Change the scanner driver type

To select a different scanner driver for a scanning device, complete the following steps.

Prerequisite This procedure requires CaptureNow licenses available for use to change between Pixel and
Kofax drivers.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underScanning Profiles, click Manage Device List.
4. In theDevice Manager dialog box, click Create.
5. In theDriver Type dialog box, in theDriver list, select the new driver type.
6. Click Next.
7. Complete the steps in the wizard, which include adding the second scanner license toPerceptive

Content.
8. Click Finish.
9. In thePerceptive Content Options dialog box, underScanning Profiles, click Manage Profile List.

10. For each scanning profile, perform the following substeps.
1. Select the profile and click Modify.
2. On theGeneral tab, in theDevice list, select the new device.
3. On theProperties tab, select any needed options
4. Click OK.

11. Test all of your capture profiles.
12. On thePerceptive Content toolbar, click Settings > Options.
13. In thePerceptive Content Options dialog box, perform the following substeps.

1. In the left pane, click Capture.
2. On theGeneral tab, underScanning Profiles, click Manage Device List.
3. In the Device Manager dialog box, select the scanner that you no longer need.

14. Click Delete.

Connect a scanning workstation to multiple servers

To enable a scanning workstation to connect to different ImageNow Servers, complete the following steps.

Prerequisite This procedure requires that a scanning license is available on the server.

1. Start Perceptive Content, connect to the first ImageNow Server, and create scanning and capture
profiles.
This captures a token from the first server.

2. Exit Perceptive Content.
3. On theWindows user profile folder, in a text editor, open the ImageNow.inifile.
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4. In the ImageNow.ini file, under [User Preferences], add the following line:
AcquireTokenDuringScan=1

5. Save and close the file.
6. Start Perceptive Content and connect to the second ImageNow Server.
7. Scan a sample document.
8. When prompted to acquire a license, click Yes. This captures a token from the second server.

You can now use the scanning computer with both ImageNow Servers.

Install a scanner overview

To install a scanner on an ImageNow Client computer, complete the following sequence of procedures.

Prerequisite Youmust log on toWindows using an account in theWindows Administrator Group to
successfully install a scanner on your system.

1. Install scanner drivers.
2. Install Kofax VRS.

If your Perceptive Content solution includes Kofax VRS, youmust install Kofax VRS before you
connect the scanner.

3. Test a scanner to verify that the drivers function correctly.
4. Configure a scanning device to connect the scanner toPerceptive Content.
5. Create a scanning profile.

In a scanning profile, define scanner-specific features such as paper size, color mode, and image
processing filters. You can also copy or move an existing scanning profile.

6. Create a scanner source capture profile:
1. Create a Single mode capture profile from Scanner source overview.
2. Create a Batchmode capture profilefrom Scanner source overview.
3. Create a PackageMode capture profile from Scanner source overview.

Example In a capture profile, define processing tasks such as a workflow queue to route the scanned
pages and how to assign property values. You can also copy or move an existing capture profile, or you
can create a new capture profile.

Remove a scanner from ImageNow

This procedure includes steps to release the scanner license token for the removed scanner. On the computer
from which you want to remove a scanner, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In thePerceptive Content Options dialog box, in the left pane, click Capture.
3. On theGeneral tab, underScanning Profiles, click Manage Device List.
4. In theDevice Manager dialog box, select the scanner and click Delete.
5. Confirm the deletion and click OK until you return to thePerceptive Content toolbar.
6. Exit Perceptive Content.
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7. Open theWindows user profile folder and copy the inscan.xml file to the [drive:]\Program
Files\ImageNow directory.

8. For each additional user account on the computer, open the appropriateWindows user profile folder and
delete the inscan.xml file.

Replace a scanner

To replace a scanner, complete one of the following procedures.

l Complete one of the following procedures.
l When the scanner make andmodel are the same, perform a routine installation of the scanner. No
additional steps are necessary in Perceptive Content.

l When the scanner make andmodel are different, copy the scanning settings to another
workstation.

Scanner configuration files

This topic describes the configuration files used for scanning in Perceptive Content.

File directories

By default, ImageNow Client files reside in the [drive:]\Program Files\ImageNow directory. When you start
Perceptive Content for the first time, it creates copies of its configuration files and several folders in the
Windows user profile folder found at theC:\Documents and Settings\<username>\Application
Data\Perceptive Content directories, where <user name> is a placeholder for an individual Windows user
account. The ImageNow Client computer may contain a number of these folders. For eachWindows user
account that logs in to a computer, Perceptive Content downloads its files from the[drive:]\Program
Files\ImageNow directory to the appropriateWindows user profile folder, described above, on the same
computer.

To access a profile folder that is different from the folder for the currently logged-in user, replace <user
name> with the actual user name. If you replace <user name> in this path with %userprofile% and copy
the path to the Address box of Windows Explorer, Windows automatically opens the user profile folder of the
current Windows user account.

When youmake changes to capture profiles, scanning profiles, or configuration settings, Perceptive Content
only saves the changes for the logged-inWindows user account. These changes are not copied to other
Windows user accounts. You can select andmaintain different settings for eachWindows user on the same
computer.

The CaptureNow license for the scanner is stored in the intkinfo.dat file located in theC:\Documents and
Settings\All Users\Application Data\Perceptive Content\etc directory. This file is called the token for that
scanner. For a CaptureNow license, the token is the seat that allows all the users of that computer to use a
scanner. CaptureNow licenses are hardware specific. When the intkinfo.dat file is created, you can only use it
on the specified computer.
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File creation

Perceptive Content creates the indevice.xml and inscan.xml configuration files when you set up capture or
scanning profiles. These files reside in theWindows users profile folder. After you create your scanning and
capture profiles, you can use the same profiles on another computer or allow other users on the same
computer to use the profiles with their ownWindows user accounts.

indevice.xml

Contains all scanner settings, including the scanner name and basic configuration settings. The
indevice.xml file only exists if a scanner is configured for the workstation.

inscan.xml

Contains all capture profile and scanning profile settings.

Scanning terminology

The following terms are commonly used when configuring and installing scanners for Perceptive Content.

AIPE

Adrenaline Image Processing Engine uses image processing filters to clean the images in a predefined
way before the pages are processed by the scanner and allows you to read barcodes and patchcodes.

Master configuration files

The configuration files located in [drive:]\Program Files\ImageNow on the originating computer that
include logon profiles, capture profiles, scanning profiles, and custom settings.

Originating computer

The computer on whichmaster configuration files were created and from which you aremoving or
copying files.

Scanner token

The part of the CaptureNow hardware license for the scanner stored in the intkinfo.dat file and
Perceptive Content database tables.

Target computer

The computer to which you aremoving or copying files to (typically a new computer).

User configuration files

The files that are included in theWindows user profile folder.

VRS

Virtual Re-Scan straightens and cleans the scanned images using artificial intelligence software
processing after the pages are processed by the scanner.
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Windows user profile folder

The folder located in theC:\Documents and Settings\<user name>\Application Data\ImageNow
directory on an ImageNow Client computer.

Troubleshoot scanner configuration

Use this topic as a troubleshooting guide after you set up or modify scanner configuration settings, or when
errors appear while installing or testing a scanner in Perceptive Content.

A yellow question mark appears in the Windows Device Manager

Cause Resolution

The scanner is not completely installed. Typically,
the INF file associated with the scanner is missing.
This error may appear for the Canon DS2500 and
other older scanners.

To resolve this issue, download the ISIS/TWAIN
drivers and INF for Windows files from
http://www.usa.canon.com.

Common errors in Kofax device installation

When I try to install Kofax Adrenaline, a Sentinel installation failedmessage appears.

Cause Resolution

If this message appears, the Sentinel Driver might
already be installed or an older driver from the CD
was not installed.

You can disregard this message. However, if the
issue persists, follow the instructions for manually
installing the Sentinel drivers.

When I try to install Kofax Adrenaline, amessage indicating that I need administrative privileges to install the
drivers appears.

Cause Resolution

The SCSI card cannot be verified. Continue the installation, restart the computer, and
verify the SCSI card is listed in WindowsDevice
Manager. If it is not, install the drivers by inserting
the Kofax CD and running the setup application on
the Adrenaline drivers.

Kofax or one of its drivers could not be installed.
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Cause Resolution

You do not have aWindows account that is part of
the Local Administrators group.

To install Kofax, you must have aWindows account
that is part of the Local Administrators group. You
can manually install the three main drivers that are
installed with Kofax.

You need to download the Sentinel Hardware Key
Drivers.

You can download the drivers from SafeNets web
site using the following URL.
http://www.safenet-
inc.com/support/tech/sentinal.asp
The drivers are located under Sentinel Protection
Installer v7.4.0.

You need to download the ASPI layer drivers. This may be downloaded from the Adaptec web site.
http://www.adaptec.com/

Kofax Adrenaline 650 does not appear in theWindows DeviceManager.

Cause Resolution

During the installation, theWindows Account did not
have the necessary access rights for the correct
placement.

1. Check to see if SCSI card is listed under a
name that is not Adrenaline Kofax 650 (such as
Initio Ultra SCSI Host Adapter). If so, the
Adrenaline drivers did not get installed.

2. To correct this, install the drivers by inserting
the Kofax CD and running the setup application
on the Adrenaline drivers.

If you can not run the setup program, log off and use
the built-in Windows Administrator account for the
computer without network access. This step
prevents anyGroup Policies from overwriting your
permissions. If the error persists, contact Perceptive
Software Product Support for assistance contacting
Kofax Support.

An "Error Writing Data" message appears in the VCDemo (Error 20099)

Cause Resolution

You do not have access to the
Kofax folder or to the Kofax
registry keys.

To provide access, add the user to the list of Windows Power Users or
consult the Kofax knowledgebase web site using the following URL:
http://knowledgebase.kofax.com/faqsearch/results.aspx?QAID=1482
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A "There is no dongle connected" message appears in the VCDemo (Error 20452)

Cause Resolution

The Sentinel drivers are out of date Check the SCSI card, cables, and dongle if you are
using one. If the error message persists, update the
Sentinel Drivers from SafeNets web site using the
following URL.
http://www.safenet-
inc.com/support/tech/sentinal.asp

An error message indicating the product license does not include image processing appears in the
VCDemo (Error 20451)

Cause Resolution

If you are using a Kofax VRS Professional
Workgroup or Production license, you need to
activate the license.

ClickStart > All Programs > Kofax VRS >
Activate VRS.

If you are using a SCSI 650i card, some of the
Kofax driversmight not be installed.

Go toWindowsDevice Manager and look for the
SCSI card. If it is not listed, install the drivers by
inserting the Kofax CD and running the setup
application on the Adrenaline drivers.

An "Unknown ISIS Drivers" message appears in the VCDemo (Error 20393)

Cause Resolution

The ISIS driversmay be corrupted and you must
reinstall the drivers

Reinstall ISIS drivers

What are scanner tokens?

For a CaptureNow license, the token is the seat that allows all the users of that computer to use a scanner
with Perceptive Content.

Each scanner you connect to the ImageNow Client acquires a token provided by the CaptureNow license on
the ImageNow Server. CaptureNow licenses are hardware specific, so if you need tomove a scanner from
one computer to another, or if a scanner is no longer used with that computer, youmust release the token
before using it with another scanner. Typically, a token is removed automatically when you remove the
scanner from the ImageNow Client.
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Barcodes

Barcode triggers in CaptureNow

You can configure CaptureNow to use barcodes to separate documents, separate groups of documents, or to
automatically assign document property values to documents.

Supported triggers

You set barcode triggers, also called conditions, for CaptureNow to locate and parse a barcode. For example,
youmight configure CaptureNow to parse a barcode that contains the value 1650498029802011 into three
parts, and assign each part as a document property value. Youmight designate the first five digits as a
document property value, themiddle ten digits as a document property value, and the last digit as a document
property value.

The following list describes the barcode triggers that CaptureNow supports.

<barcode position number>|<range of digits>
Locate the specified barcode position on the page and use the specified range of digits from the
barcode. CaptureNow reads barcodes on a page from top to bottom and left to right.

Example

To locate the first (1) barcode on the page and use the first five (1-5) digits from the barcode, specify 1|1-
5 To locate the first (1) barcode on the page and use the sixth through the fifteenth (6-15) digits from the
barcode, specify 1|6-15 To locate the first (1) barcode on the page and use the sixteenth (16) digit from
the barcode, specify 1|16

>=value
Locate the barcode value that is greater than or equal to the specified value.

Example

>=123456

>value
Locate the barcode value that is greater than the specified value.

Example

>123455

<=value
Locate the barcode value that is less than or equal to the specified value.

Example

<=1234560
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<value
Locate the barcode value that is less than the specified value.

Example

<123459

between(first value,second value)
Locate the barcode value that resides between the specified values, where the first value is less than
the target value and the second value is more than the target value.

Example

between(123456,123460)

length=
Locate the barcode value that has the specified number of digits.

Example

length=6

pattern=
Locate the barcode value that includes the specified pattern or digit. CaptureNow supports using
asterisks ( * ) or question marks ( ? ) as wildcard characters.

Example

pattern=10*pattern=t*ppattern=A?C Corporationpattern=AcmeCorporation

range(first value,second value)
Locate the barcode value that resides in a range of values, where the first value is less than or equal
to the target value and the second value is greater than or equal to the target value.

Example

range(123456,123460)

&
Locate the barcode value that meets the specified conditions.

Example

To locate the first barcode on a page that has a length of 6 digits, specify 1&length=6
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Configure barcode options for batch scanning overview

To configure barcode options for batch scanning, complete the following steps.

Prerequisite Youmust perform this procedure on an ImageNow Client computer with a scanner is already
installed and configured.

1. Enable barcode detection for scanning profiles.
2. In a capture profile, configure how to use barcodes to process a batch.

l Enable barcodes for document properties in Batchmode.
l Enable barcodes for batch separation.
l Enable barcodes for batch grouping.

Enable barcode detection for scanning profiles

To enable Kofax or Pixel barcode detection in a scanning profile, complete the following steps.

Prerequisite Your scanner hardware and softwaremust support image processing to use barcode
detection. If the scanning profile does not already exist, youmust create it before you begin this procedure.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, perform the following substeps:

1. In the left pane, click Capture.
2. On theGeneral tab, underScanning Profiles, click Manage Profile List.

3. In theScanning Profile Manager dialog box, select the scanning profile for which you want to enable
barcode detection and click Modify.

4. In theScanning Profile dialog box, on theProperties tab in theDPI box, select 300 for optimal
barcode recognition.

5. Configure the barcode detection using one of the following options, depending on the situation:

Situation Steps

Enable barcode detection in CaptureNow
Adrenaline (Kofax)

1. On the Properties tab, in the Sides list,
select either Simplex orDuplex.

2. On theAdvanced tab, and under Image
Processing Filters, select theBarcode
Detection check box.

3. Double-clickBarcode Detection.
4. In theBar Code Properties dialog box,

underRecognition, verify that the Enable
check box is selected.

5. Select the Learn check box.
6. Under Search Direction, select the 0, 90,
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Situation Steps

180, and 270 check boxes.
7. UnderBar Code Algorithm, verify that

Enhanced Bar Codes is selected.
8. Under Type, select and add the barcode

types.

Configure barcodes for a Simplex scanning
profile in CaptureNow ISIS (Pixel)

1. On the Properties tab, in the Sides list,
select Simplex.

2. On the Image Processing tab, next to
Front, clickModify.

3. In the Image Processing Configuration
dialog box, underAvailable Filters, click
Barcode Detection > Add.

4. Under Selected Filters, clickBarcode
Detection > Configure.

5. In theBarcode Detection - Properties
dialog box, underCheck the following
symbologies, select the barcode types.

6. UnderOrientation, select the barcode
orientations you want, and then verify that
theDecode Symbol check box is selected
and then clickOK until you return to the
Scanning Profile dialog box.

Configure barcodes for a Duplex scanning profile
in CaptureNow ISIS (Pixel)

1. On the Properties tab, in the Sides list,
select Duplex.

2. On the Image Processing tab, next to
Front, clickModify.

3. In the Image Processing Configuration
dialog box, underAvailable Filters, click
Barcode Detection > Add.

4. Under Selected Filters, clickBarcode
Detection > Configure.

5. In theBarcode Detection - Properties
dialog box, under Symbologies To Check,
select the barcode types.

6. UnderOrientation, select the barcode
orientations you want, and then verify that
theDecode Symbol check box is selected
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Situation Steps

and then clickOK until you return to the
Scanning Profile dialog box.

7. Configure any additional barcode detection
filters you need.

Note: The available options vary by scanner type. For detailed help, press the F1 key while in theBar
Code Properties dialog box.

6. Click OK until you return to thePerceptive Content toolbar.

Enable barcodes for batch grouping

CaptureNow provides batch grouping during the scanning process. CaptureNow starts a new batch when it
detects a barcode, scans the specified increment of pages for a unique ID, or reaches the specified page limit
for a batch. To enable batch grouping, complete the following steps.

Prerequisite Your scanner hardware and softwaremust support barcode processing. If the Batchmode
capture profile does not already exist, youmust create it before you begin this procedure.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the capture profile for which you want to enable barcode

grouping and click Modify.
3. In the capture profile, on theBatch tab, underBarcode Grouping, perform the following substeps:

1. Select theEnable barcode grouping check box.
2. Optional. In thePage Limit list, type or select themaximum number of pages to allow in a batch.
3. In the Trigger box, specify a filter to identify a barcode whenmore than one barcode is detected.

4. On theDocument Keys tab, perform the following substeps:
1. Double-click a document property for which you want CaptureNow to include a unique ID for

each batch.
2. In theKey Definition dialog box, in the Type list, click Unique ID.
3. In the Increment list, select when to start a new batch during the scanning process.

5. Click OK until you return to thePerceptive Content toolbar.

Enable barcodes for batch separation

To enable batch separation based on one or more barcodes detected during the scanning process, complete
the following steps.

Prerequisite Your scanner hardware and softwaremust support barcode processing. If the Batchmode
capture profile does not already exist, youmust create it before you begin this procedure.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
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2. In theCapture Profiles dialog box, select the capture profile for which you want to enable barcode
options and click Modify.

3. In the capture profile, on theBatch tab, underSeparator Sheets, perform the following substeps:
1. From the Type list, select Barcode.
2. In the Trigger box, type a filter that a barcodemust match beforePerceptive Content starts a

new batch.
3. To keep a separator sheet that contains a barcode as part of the batch, clear theRemove

separator sheet check box.
4. Click OK until you return to thePerceptive Content toolbar.

Enable barcodes for document properties in Batch mode

CaptureNow can detect one or more barcodes during the scanning process, and assign barcode data to
specified document property values. To enable CaptureNow to assign barcode data to document property
values during batch capture, complete the following steps.

Prerequisite If the capture profile does not already exist, youmust create it before you begin this procedure.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the capture profile for which you want to enable barcode

options and click Modify.
3. In the capture profile, on theDocument Keys tab, perform the following substeps:

1. Double-click a property for which you want to assign barcode data.
2. In theKey Definition dialog box, in the Type list, select Barcode.
3. In theValue box, specify a filter to identify a barcode and to optionally parse the barcode data.

Example If a page includes only one barcode and you do not want to parse barcode data, type 1.
For additional details, refer to "Barcode triggers in CaptureNow."

4. Click OK.
4. Repeat the previous substeps for each document property for which you want to assign barcode data.
5. Click OK until you return to thePerceptive Content toolbar.

Supported barcode types

The following list details the supported barcode types. Each of the listed Perceptive Software products
requires a separate license. For optimal barcode recognition, we recommend a 10 point, Courier font and 300
DPI (Dots Per Inch). An asterisk denotes that a barcode is two dimensional.

CaptureNow - Adrenaline

l Aztec*
l Codabar
l Code 128
l Code 39 (3 of 9)
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l Code 93
l DataMatrix*
l EAN-8
l EAN-13
l Interleaved 2 of 5
l Linear 2 of 5
l Maxicode*
l PDF 417*
l Postnet
l QR Code*
l UPC-A
l UPC-E

CaptureNow - File with IP

l Addon-2
l Addon-5
l Australian Post
l BCD Matrix
l Codabar
l Code 128
l Code 32
l Code 93
l Datalogic 2 of 5
l DataMatrix*
l EAN-8
l EAN-13
l Interleaved 2 of 5
l Intelligent Mail
l Invert 2 of 5
l Matrix 2 of 5
l PDF 417*
l Postnet
l QR Code*
l Royal Post
l UCC/EAN-128 (GS1-128)
l UPC-A
l UPC-E
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CaptureNow - ISIS

l Addon-2
l Addon-5
l Codabar
l Code 128
l Code 39 (3 of 9)
l Code 93
l EAN-8
l EAN-13
l Interleaved 2 of 5
l UPC-A
l UPC-E

CaptureNow - TWAIN

l Addon-2
l Addon-5
l Codabar
l Code 128
l Code 39 (3 of 9)
l Code 93
l EAN-8
l EAN-13
l Interleaved 2 of 5
l UPC-A
l UPC-E
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DataCapture

l Codabar
l Code 128
l Code 39 without a start and stop character
l Code 39 (3 of 9)
l Code 39 with check digit
l Code 93
l EAN-8
l EAN-13
l Industrial 2 of 5
l Interleaved 2 of 5
l Interleaved 2 of 5 with check digit
l PDF 417*
l UCC/EAN-128 (GS1-128)
l UPC-A
l UPC-E

Fax Agent

l Codabar
l Code 128
l Code 39 (3 of 9)
l Code 93
l EAN-8
l EAN-13
l EAN with 2-digit or 5-digit supplement
l UPC-A
l UPC-E
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Recognition Agent

l Airline 2 of 5
l Aztec*
l Codabar
l Codablock A*
l

l Code 11
l Code 128
l Code 39 Full ASCII
l Composite
l Code 39 (3 of 9)
l Code 39 with check digit
l Code 93
l DataMatrix*
l EAN-8
l EAN-13
l EAN with 2-digit or 5-digit supplement
l Hong Kong 2 of 5
l IATA 2 of 5
l Industrial 2 of 5
l Interleaved 2 of 5
l Interleaved 2 of 5 with check digit
l Maxicode*
l MicroPDF417*
l MSI Plessey
l NEC 2 of 5
l PDF 417*
l Pharmacode
l Postnet
l QR Code*
l Reduced Space
l Standard 2 of 5
l Telepen
l Trioptic Code 39
l UCC/EAN-128 (GS1-128)
l UPC/EAN/JAN
l UPC-A
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l UPC-E

Patchcodes

About using patchcodes with CaptureNow

A patchcode is used to create a new batch when it is detected by the scanner.

Patchcodes are similar to barcodes in that they are used to further simplify the task of scanning and
organizing documents. Each time a patchcode is detected, a new batch is created for the documents that are
scanned after it. All newly scanned documents are placed in the new batch until scanning finishes or another
patchcode is detected.

Adjust the patchcode offset

The option to adjust the patchcode offset applies only to Kofax scanning drivers. The Left Offset to Center of
Patch Code setting is ameasurement in inches from the left edge of the page that defines a point that falls
near the center of the patchcode. The offset value allows the patchcode detection feature to quickly locate the
patchcode on the page. This offset can be any value between 0 and themaximum page width, in inches. A
value of 0 specifies searching anywhere in the horizontal direction for a patchcode. To adjust the offset value
for a patchcode, complete the following steps.

Prerequisite If the scanning profile does not already exist, youmust create it before you begin this
procedure.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underScanning Profiles, click Manage Profile List.
4. In theScanning Profile Manager dialog box, select the scanning profile and click Modify.
5. In theScanning Profile dialog box, on theAdvanced tab, under Image Processing Filters, double-

click Patchcode Detection.
6. In thePatch Code Properties (Advanced) dialog box, select theEnable check box.
7. In the Left Offset to Center of Patch Code (in) box, type or select the number of inches the

patchcode is offset from the left edge of the page. If you are unsure of this setting, leave this set to zero.
8. Click OK until you close theScanning Profile Manager dialog box.

Enable patchcode detection for a scanning profile

To enable Pixel or Kofax patchcode detection in a scanning profile, complete the following steps. When you
use Kofax drivers, patchcodes are only detected on the front side of a page.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underScanning Profiles, click Manage Profile List.
4. In theScanning Profile Manager dialog box, select the scanning profile, click Modify.
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5. In theScanning Profile dialog box, on theProperties tab, for optimal patchcode recognition. In the
DPI box, type 240.

6. Do one of the following action depending on the situation:

Situation Steps

Configure patchcodes for a Kofax duplex
scanning profile

1. In the Sides list, select Duplex.
2. On theAdvanced tab, and under

Perceptive ContentProcessing Filters,
select theBorder Removal and
Patchcode Detection check boxes.

Configure patchcodes for a Kofax simplex
scanning profile

1. In the Sides list, select Simplex.
2. On theAdvanced tab, and under

Perceptive ContentProcessing Filters,
select the Patchcode Detection check box.

Configure patchcodes for a Pixel duplex scanning
profile

1. In the Sides list, select Duplex.
2. On the Image Processing tab, next to

Front, clickModify.
3. In the Image Processing

Configurationdialog box, underAvailable
Filters, hold down the CTRL key and select
Blank Page Detection, Border Removal,
Patchcode Detection.

4. ClickAdd.

Configure patchcodes for a Pixel simplex
scanning profile

1. In the Sides list, select Simplex.
2. On the Image Processing tab, next to

Front, clickModify.
3. In the Image Processing Configuration

dialog box, underAvailable Filters, click
Patchcode Detection > Add.

7. Click OK until you return to thePerceptive Content toolbar.

Obtain patchcodes for CaptureNow

To download thePatch Codes.pdf file, complete the following steps.

For more information, refer to "Patchcode types for CaptureNow" or download themore detailedPatch
Codes.pdf file from the Customer Portal.

1. In theCustomer Portal, on theDownloads tab filter the download options for ImageNow Client.
2. Search for Patch Codes.
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3. Save thePatch Codes.pdf file where you can easily access it.
Next Print thePatchcodes.pdf file and provide it to users that need to scanmultiple batches at the same time,
designating each new batch with a patchcode.

Patchcode types for CaptureNow

CaptureNow supports six patchcode type patterns. Devices configured to use Kofax drivers recognize all six
patterns. Pixel enabled devices recognize patterns II, III, and T.

l Perceptive Content Patch I Header
l Perceptive Content Patch II Header
l Perceptive Content Patch III Header
l Perceptive Content Patch IV Header
l Perceptive Content Patch T Header

Scan batches using patchcodes

Each time Perceptive Content detects a patchcode, it creates a new batch for the pages scanned after the
patchcode. This enables you to scanmultiple batches at the same time while Perceptive Content places
pages in the desired batch. To scan batches using patchcode separator sheets, complete the following steps.

Prerequisite This procedure requires a scanning workstation configured for Batchmode and Scanner
source, a capture profile and scanning profile with patchcode detection enabled, and a printed patchcode
separator sheet that provides a patchcode positioned horizontally on the front-side of the page, that it is at
least 0.20 inches from the leading edge of the page, and does not extend 3.75 inches from the leading edge of
the page.

1. At the scanning workstation, place a patchcode separator sheet on top of each group of pages that you
want to scan as a new batch.

2. Insert the pages into the scanner's feeder with each patchcode separator sheet on the leading edge of
the paper.
This could vary based on scanner type.

3. On thePerceptive Content toolbar, click the arrow next to theCapture button and select a capture
profile set to Scanner source and Batchmode.

4. If theSupply Group Information dialog box displays, Select or type values forPrep User, Prep
Date, andPages to show which user captured the batch and when, and to validate the page count.

5. If theBatch Report dialog box displays, click OK.
Next Quality assure the batch and assign property values.



Manage Documents User Guide

122

Imprinter

Configure CaptureNow Imprinter overview

The CaptureNow Imprinter feature enables the user to print a string of data onto the front or back of the original
scanned document. It also allows CaptureNow to populate the imprinter value in a document property
assigned to the image. To configure the CaptureNow Imprinter feature, complete the following sequence of
procedures on the ImageNow Client computer.

Prerequisite This procedure requires that the scanner and imprinter hardware is already installed and
configured.

1. Enable CaptureNow Imprinter to work with your scanning device andCaptureNow.
2. Optional. Configure any additional Imprinter settings.
3. Populate a document property with an imprinter value.

Imprinter settings

The following settings are available when configuring Imprinter with a Pixel or Kofax device.

Pixel settings

Bold

Indicates that the string will be printed in bold font.

Counter Step

Select themethod used tomodify the imprinter counter after each page scanned. There are several
options:

l Decrease by 2
l Decrease by 1
l Do not change
l Increase by 1
l Increase by 2
If you select "Do not change," the imprinter counter will only increment when a new scan event is
performed (every time you click the Capture icon). When using this method, the number can only
increment by one.

Direction

Indicates which direction the string will imprinted, going up or going down.

Enable Imprinter

Select this setting to enable imprinting.
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Imprinter String

Specifies the text to be output by the imprinter. This alphanumeric string can be amaximum of 43
characters when Use Extended Counter setting is selected, or 40 characters otherwise. The string can
consist of the following:

l <space>
l 0-9
l _/\#.][()=+<>
l A-Z
l A-z
The "%" is a special character that can be used to append an optional counter to the end of the imprinter
string. This character can only be used at the end of the string. If present, it will be expanded to a 5 or 8-
digit number.

Other device drivers may use a character other than "%" to indicate the use of a counter.

Initial Count

Specifies the counters starting number. Only used if the "%" specifier is included in the imprinter string.

Orientation

Indicates the orientation of the imprinted string. Options are "Portrait" and "Landscape." The orientation
indicates the direction that each individual character is printed.

Use Extended Counter

Determines if the counter string will be five or eight characters. If selected, the counter will have a length
of eight digits, and can have a value between 0 and 16,777,215. If not selected, the counter will have a
length of five digits, and can have a value between 0 and 99,999.

Y Offset

Indicates the number of pixels that the imprinted string will be offset from the edge of the original
document.

Kofax settings

Digit

Type or select the number of digits you want the incrementing string to contain (1-8).

Enable Automatic Annotation

This functionality is not supported within Perceptive Content.

Enable Automatic Endorser

Enables the imprinter. Youmust have this selected in order to use the imprinter.



Manage Documents User Guide

124

Inc Off

Select this setting to turn off the counter increment feature.

Inc On Page

Select this setting to set the number of pages that will be scanned before the string increments. In some
cases, youmay want to assign the same number to each page within a batch of documents, and have
the string increment only when a new scan event is performed (every time you click the Capture icon).
To do this, set Inc On Page higher than the number of pages that any single batch of documents would
ever contain.

Inc On Patch

Select this setting to set the string to increment only when a specific patch code is detected. In the Inc
On Patch list, select the specific patch code that will be used to trigger the increment.

Increment Value

Type or select the value by which you want the incrementing string to increase on each subsequent
page.

Left (pixel)

Type or select the number of pixels that you want the imprinted string to be offset from the left edge of
the page.

Depending on the type of imprinter device you are using, this settingmay appear dimmed and
unavailable.

Orientation

Select the orientation of the imprinted string that you want. The rotation indicates the direction that each
individual character will be printed.

Prefix

Type a static text string that you want to precede the numbered string printed by the imprinter. The
default text string "Kofax" can be deleted and replaced with your own text string.

Reset Off

Select this setting to turn off the counter reset feature.

Reset On Page

Select this setting to set the number of pages that will be scanned before the incrementing string resets
to the value you set for Reset Value.
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Reset On Patch

Select this setting to set the incrementing string to reset to the value you set for Reset Value only when
a specific patch code is detected. In the Reset On Patch list, select the specific patch code that will be
used to trigger the reset.

Reset Value

Type or select the number to which you want the incrementing string to reset. The Counter Reset
options will appear dimmed and unavailable if the Inc Off option is selected.

Skip First Patch Code

Select this setting if you want the first patch code encountered by the imprinter to be ignored. This
setting is only enabled if you select Inc On Patch.

Starting Number

Type or select the number you want the incrementing string to begin with. The Counter Start settings will
appear dimmed and unavailable if the Inc Off option is selected.

Top (pixel)

Type or select the number of pixels that you want the imprinted string to be offset from the top of the
page.

Type

Select the font size that you want for the imprinted string.

What is Imprinter?

The Imprinter feature allows you to use imprinter hardware connected to your scanner to print a string of data
onto the front or back of the original scanned document.

Depending on the device, printing occurs immediately before or immediately after you scan a document.
When creating or using a scanning profile, you can define the type of value you want imprinted. Your options
include printing a static string on every document, an incrementing number, or a combination of both. Using
the imprinter functionality allows you to capture and re-use the string that was imprinted on the original paper
document as an index key. By doing so, you would be able to look at a document and then locate the original
paper document using the information the imprinted string contains.

The Imprinter feature can be driven using either a Kofax or Pixel scanner driver, but will only work with
scanners that support imprinters.

Predefined Lists
Create a predefined list in a capture profile
To create a predefined list of values for a document property in a capture profile, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
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2. In theCapture Profiles dialog box, click Create.
3. In theNew Capture Profile dialog box, on theDocument Keys tab, double-click the document

property for which you want to create a predefined list.
4. In theKey Definition dialog box, in the Type list, select Predefined List - Server.
5. In theValue list, select Edit List.
6. In thePredefined Lists dialog box, click New, and type a name for the list.
7. To add the list description and list member values, complete the following substeps.

1. Select the list name and click Modify.
2. In theEdit Predefined List dialog box, on theGeneral tab, in theDescription box, type a

description of the list.
3. On the List Members tab, in theName box, type the first value to appear in the list.
4. Click Add.
5. Repeat the previous substeps until you add all list member values.

Note: Click on theName header to sort list member values in ascending or descending order.

8. Click OK.

Delete a predefined list in a capture profile
To delete a predefined list assigned to a document property in a capture profile, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the capture profile and click Modify.
3. In the capture profile, on theDocument Keys tab, double-click the document property that contains the

predefined list you want to delete.
4. In theKey Definition dialog box, in theValue list, select Edit List.
5. In thePredefined Lists dialog box, select the predefined list and click Delete.
6. In the confirmation dialog box, click Yes.

Modify or rename a predefined list
Tomodify a predefined list assigned to a document property in a capture profile, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the capture profile and click Modify.
3. In the capture profile dialog box, on theDocument Keys tab, double-click the document property that

contains the list you want to modify.
4. In theKey Definition dialog box, in the Type list, verify that Predefined List - Server is selected.
5. In theValue list, select Edit List.
6. In thePredefined Lists dialog box, select the list you want to modify, and click Modify.
7. Optional. On theGeneral tab, modify the name or the description of the predefined list.
8. Optional. To add or modify list member values, on the List Members tab, perform any of the following
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actions.
l To add a list member, in theName box, type a list member value, and then click Add.
l To change the location of a list member value, select the value, and then click Move Up orMove
Down.

l To remove a value from the list, select the value, and then click Remove.
l To sort list member values in ascending or descending order, click theName header.

9. Click OK.

Profiles
About distributing capture and scanning profiles
If you administer a client-based capture profile from a central location, you can use ImageNow Server to
distribute the profile to multiple ImageNow Client workstations using the distributionmethods of User, Group,
or Machine.

Youmight need to send periodic updates to capture profiles and will need tomake those settings available on
every scanning computer. While users can still add or modify capture profiles if they have the necessary
permissions, you can overwrite all the local settings with a new set of capture profiles. After you create your
master configuration files, you distribute them to one or more target computers, and as a result, every new
Windows User account that logs on to Perceptive Content on the target computer acquires the settings from
themaster configuration files. However, if a user later modifies the capture profiles, scanning profiles, or
configuration settings, those changes are not distributed to other users. Assigningmaster files removes any
previous settings in theWindows user configuration folders of the affected users.

Distributing capture and scanning profiles overwrites all previous capture and scanning profiles and
overwrites exiting capture and scanning profiles only when the ImageNow Server is greater than the version
of the ImageNow Client. Users of ImageNow Client canmodify capture and scanning profiles after the first
capture and scanning profile is downloaded on the local computer. Modified profiles are not updated on
ImageNow Server automatically.

Define scanning profile options
To define scanning profile options, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the capture profile and click Modify.
3. In the <Capture Profile Name> dialog box, on theScanner tab, in theScanning list, select Edit

Scanning Profiles.
4. In theScanning Profile Manager dialog box, select the profile you want, and click Modify.
5. Optional. On theProperties tab, choose the property options to include with your scanning profile.
6. Optional. On the Image Processing tab, to modify filters, click Modify. In the Image Processing

Configuration box, select a filter and add it to theSelected Filters pane. Once added, you can
configure the filter, move it up or down, or remove it.

7. Click OK to save the changes and exit each dialog box. In the <Capture Profile Name> dialog box,
click OK to return to theCapture Profiles dialog box.
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Distribute a client-based capture or scanning profile
Distributing a client-based capture or scanning profile to multiple ImageNow Client workstations eliminates
the need tomanually create or modify the profiles on each workstation. To use ImageNow Server, complete
the following steps.

Prerequisite Youmust configure a set of scanning workstations and create amaster capture or scanning
profile.

1. On the ImageNow Server computer, in the [drive:]\inserver\ directory, create a folder namedProfiles.
2. In the [drive:]\inserver\\Profiles directory, create a folder for each profile that you want to distribute or

update.
For example, ScanningProfiles, ReviewProfiles, andViewProfiles.

3. On the originating computer, in ImageNow Client, create the capture and scanning profiles.
4. Close ImageNow Client.
5. Navigate to your ImageNow workpath and perform the following substeps. Depending on your

configuration, your work pathmay be%appdata%\ImageNow, \Documents and Settings\<username>,
or a location you configured in the inowsystem.ini file.
1. In a text editor such as Notepad, open the inscan.xml and indevice.xml files.
2. In each file, specify the following parameters where the <name> valuematches a folder name

you created earlier:
<versionInfo>

<name>ScanningProfiles</name>

<number>1</number>

</versionInfo>

3. Save and close the inscan.xml and indevice.xml files, and copy them to the corresponding folder
you created.

6. Open the ImageNow Server computer, in the [drive:]\inserver\etc directory.
7. Create a file named scan.ini and add the following lines:

;-------------beginning of file----------

[General]

//0 - User

//1 - Group

//2 - Machine

LookupMode=1

[Machine]

SJones = ScanningHR

TSmith = ScanningAP

[Users]
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SJones = ScanningAP

TSmith = ScanningAP

[Groups]

AP Scanning = ScanningAP

HR Scanning = ScanningHR

;-------------end of file----------

Note:When you create the scan.ini file, youmust choose one of the following distributionmethods:
User, Group, or Machine. Only one distributionmethod can be used at a time. Additionally, you need to
order the list of groups based on the capture profile assignment priority. For more information about
distributing profiles to groups, see Example 1 and Example 2 below.

Example 1: User A is amember of the following ImageNow groups: Reviewing, Scanning, and
Viewing. You want to assign the "Scanning" group capture profiles to User A. To configure the groups in
the [Groups] list, as shown here:

[Groups]

ScanningProfiles

ReviewProfiles

ViewProfiles
ImageNow evaluates the [Groups] list based on the order. In Example1, because User A is amember
of the "Scanning" group, the "Scanning Profiles" profile is assigned to User A. Perceptive Content
groups in the list.

Example 2: User B is amember of the following groups: Reviewing and Viewing. Using the scan.ini file
in Example1, Perceptive Contentfirst checks to see if User B is amember of the "Scanning" group.
Since User B is not amember of this group, Perceptive Content continues through the list. Because
User B is amember of the "Reviewing" group, the second group in the [Groups] list, User B receives
the "Review Profiles." Although User A and User B are bothmembers of the "Viewing" group,
they do not receive the "View Profiles" because the "Scanning" and "Reviewing" group profiles are
listed first.

Note:When entering themachine name in scan.ini, do not include the domain name (such as
PC01.psinet.com). Domain names may prevent capture profiles from being properly distributed.

8. To distribute the indevice.xml and inscan.xml files, under [General], assign one of the following
distributionmethods:
l To distribute the files to the users specified in the [Users] section, for the LookupMode statement,

specify 0.
l To distribute the files to the groups of users specified in the [Groups] section, for the LookupMode
statement, specify 1.
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l To distribute the files to the computers listed in the [Machines] section, for the LookupMode
statement, specify 2.

9. Save and close the scan.ini file.
10. On the ImageNow Server computer, copy the files you added to the [drive:]\inserver\Profiles directory

and place them in the \Documents and Settings\<username> directory of each target computer.
11. Tomodify an existing distribution profile, increase the <number> value in the header areas of the

inscan.xml and indevice.xml files located in the in the [drive:]\inserver\Profiles directory.
Users receive the updates after their next login.

What is a capture profile?
A capture profile stores the settings you define to capture files into Perceptive Content, making capture a
simple task for your users.

A capture profile identifies information such as the capture source, the workflow queue to which you route
captured documents, and additional image processing that you want Perceptive Content to complete.

Server-based capture profiles exist for Import Agent, Fax Agent, SAP ArchiveLink, iScript, and scanners.

Client-based capture profiles exist for CaptureNow and offer capture of documents from the File, Scanner,
and ImageNow Printer sources. You can use Perceptive Content Server to distribute client-based capture
profiles.

Client-Based Capture Profiles

Copy a client-based capture profile

To quickly create a new capture profile, you can base it on an existing profile. To copy a client-based capture
profile for Single, Batch, or PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the profile you want to copy.
3. Click Copy.

Create a Batch mode capture profile from File source overview

A Batchmode capture profile set to File source instructs CaptureNow to import one or more electronic files
and store them in a batch. To create a capture profile set to Batchmode and File source, complete the
following sequence of procedures.

1. Create a client-based capture profile.
2. Define file location and image processing options.
3. Define batch processing options.
4. Define capture profile document property options.
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Create a Batch mode capture profile from ImageNow Printer source overview

A Batchmode capture profile set to ImageNow Printer source prints an electronic file from an application,
such as Microsoft Excel, into a batch. To create a capture profile set to Batchmode and ImageNow Printer
source, complete the following sequence of procedures.

1. Create a client-based capture profile.
2. Define batch processing options.
3. Define capture profile document property options.

Create a Batch mode capture profile from Scanner source overview

A Batchmode capture profile set to Scanner source instructs CaptureNow to scan one or more pages and
store them as a batch. To create a capture profile set to Single mode and Scanner source, complete the
following sequence of procedures.

1. Create a client-based capture profile.
2. Define scanning profile options.
3. Define batch processing options.
4. Define capture profile document property options.

Create a Package Mode capture profile from File source overview

A PackageMode capture profile set to File source instructs CaptureNow to import one or more electronic files
into a package. To create a capture profile set to PackageMode and File source, complete the following
sequence of procedures.

1. Create a client-based capture profile.
2. Define file location and image processing options.

Create a Package Mode capture profile from Scanner source overview

A PackageMode capture profile set to Scanner source instructs CaptureNow to scan one or more pages into
a package. In the profile, youmust select or create a scanning profile. To create a capture profile set to
PackageMode and Scanner source, complete the following sequence of procedures.

1. Create a client-based capture profile.
2. Define scanning profile options.

Create a Single mode capture profile from File source overview

A Singlemode capture profile set to File source instructs CaptureNow to import one or more electronic files
and store them as a single document. To create a capture profile set to Single mode and File source, complete
the following sequence of procedures.

1. Create a client-based capture profile.
2. Define file location and image processing options.
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3. Define an application plan for a capture profile.
4. Define capture profile document property options.

Create a Single mode capture profile from ImageNow Printer source overview

A Singlemode capture profile set to ImageNow Printer source prints an electronic file from an application,
such as Microsoft Excel, into a document. To create a capture profile set to Single mode and ImageNow
Printer source, complete the following sequence of procedures.

1. Create a client-based capture profile.
2. Define an application plan for a capture profile.
3. Define capture profile document property options.

Create a Single mode capture profile from Scanner source overview

A Singlemode capture profile set to Scanner source instructs CaptureNow to scan one or more pages and
store them as a single document. To create a capture profile set to Single mode and Scanner source,
complete the following sequence of procedures.

1. Create a scanning profile.
2. Create a client-based capture profile.
3. Define scanning profile options.
4. Define an application plan for a capture profile.
5. Define capture profile document property options.

Delete a client-based capture profile

To delete a client-based capture profile for Single, Batch, or PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the profile you want to delete.
3. Click Delete.
4. In the confirmation prompt, click Yes.

Import a client-based capture profile on a non-scanning computer

Importing a capture profile from one workstation to another workstation eliminates the need tomanually
configure the same settings onmultiple workstations. To import a client-based capture profile for Single,
Batch, or Packagemode, complete one of the following procedures.

Prerequisite Youmust have a scanner installed on the target workstation and create at least one scanning
profile on the target computer. If your solution includes Kofax Virtual ReScan (VRS) software, youmust
create the correct source in the Scanning Configuration Utility for VRS. Ensure that you upload enough
CaptureNow licenses on the ImageNow Server for your scanners.

1. On the originating computer, copy the inscan.xml file to a location from where you can access it from
the target computer.
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2. On the target computer, start Perceptive Content.
3. On thePerceptive Content toolbar, click the arrow next to theCapture button and selectManage

Capture Profiles.
4. In theCapture Profiles dialog box, click Import.
5. In the wizard, in theSource list, select Perceptive ContentCapture Profile (local).
6. For Location, browse to the inscan.xml file that you copied from the originating computer and open it.
7. Click Next.
8. Select the check box next to the capture profile you want to import.
9. Click Finish.

Import a client-based capture profile on a scanning computer

Importing a capture profile from one workstation to another workstation eliminates the need tomanually
configure the same settings onmultiple workstations. To import a client-based capture profile for Single,
Batch, or PackageMode, complete one of the following procedures.

Prerequisite Youmust have a scanner installed on the target workstation and create at least one scanning
profile on the target computer. If your solution includes Kofax Virtual ReScan (VRS) software, youmust
create the correct source in the Scanning Configuration Utility for VRS. Ensure that you upload enough
CaptureNow licenses on the ImageNow Server for your scanners.

1. On the originating computer, open the user configuration folder and copy the inscan.xml file to a location
from where you can access it from the target computer.

2. On the target computer, on thePerceptive Content toolbar, click Capture > Manage Capture
Profiles.

3. In theCapture Profiles dialog box, click Import.
To import a profile, the user logged in to the local computer must have theWrite permission for the
C:\Documents and Settings\All Users\Application Data\ImageNow\etc directory.

4. In the wizard, in theSource list, select Perceptive ContentCapture Profile.
5. For Location, browse to the inscan.xml file that you copied from the originating computer and open it.
6. Click Next. This displays the capture profiles available in the inscan.xml file you selected.
7. Select the check box next to the capture profile you want to import.
8. On the same row, click <None> and select the scanning profile to use with the capture profile you

selected.
9. Click Finish.

Modify a client-based capture profile

Tomodify a client-based capture profile for Single, Batch, or Packagemodes, complete the following steps.

1. On thePerceptive ContentPerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the profile you want to modify.
3. Click Modify.
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4. Make any needed changes.
5. Click OK.

Reorganize client-based capture profiles

The order in which you store your client-based capture profiles in the Capture Profiles dialog box determines
their order on the Capture sub-menu on the Perceptive Content toolbar. To change the order of your client-
based capture profiles for Single, Batch, and PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select a profile and click Move Up orMove Down.
3. Click Close.

Roll back a client-based capture profile to the server version

To roll back a client-based capture profile to the server version, complete the following steps.

1. Exit ImageNow Client.
2. In theC:\Documents and Settings directory, locate the user configuration folder associated with the

capture profile you wish to roll back.
3. In thePerceptive Content user configuration folder, open the inscan.xml and indevice.xml files.
4. Change the <number> value to a previous version, as shown in the following example:

Example
<versionInfo><name>ScanningAP</name><number>4</number></versionInfo>

5. Save and close the inscan.xml and indevice.xml files.
6. Start Perceptive Content and verify that the capture and scanning profiles have loaded from

theImageNow Server.

Server-Based Capture Profiles

Copy a server-based capture profile

To quickly create a new capture profile, you can base it on an existing profile. To copy a server-based capture
profile, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theCapture Profile tab, select the capture profile you want to copy.
4. Click Copy.
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Create a Fax Agent capture profile for a document

Fax Agent enables you to process incoming faxes directly into a document. To configure a capture profile for
Fax Agent, complete the following steps.

Prerequisite Before you begin this procedure, youmust install Fax Agent, configure the inserverFax.ini file
to support the use of a Fax Agentcapture profile, and create a Fax Agent application plan for a document.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. On theCapture Profile tab, click New > Fax Agent.
4. In theCapture Profile Definitionwizard, on theCapture Profile Content Type page, select

Documents.
5. On theCapture Profile Information page, complete the following substeps.

1. Type name and optional description for the capture profile.
2. Verify that theProfile is active check box is selected.
3. Click Next.

6. On theCapture Profile Options page, complete the following substeps.
1. In theApplication plan list, select the Fax Agent application plan that you want to associate

with this capture profile.
2. Optional. In theWorkflow process list, select the workflow process to which you want to route

the new documents.
3. If you selected a workflow process, in theWorkflow queue list, select the workflow queue to

where you want to route the new documents.
4. Optional. To submit documents toRecognition Agent for bar code scanning, select theSubmit

to Content Server check box.
5. Optional. To add documents to version control, select theSubmit to version control check box.

6. Click Next.
7. On theCapture Profile Verification page, review your capture profile configuration settings and

complete one of the following actions.
l Tomodify a configuration setting, click Back andmake any needed changes.
l To keep the configuration settings, click Finish.

Create an external interface capture profile for a document

You use an external interface capture profile with external interfaces such as iScript or Integration Server. To
create an external interface capture profile, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theCapture Profile tab, click New > External Interface.
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4. If theCapture Profile Content Type page appears, select Document, and then click Next.
5. On theCapture Profile Information page, perform the following substeps.

1. Type a name and optional description.
2. Verify that theProfile is active check box is selected.
3. Click Next.

6. In theCapture Profile Options page, complete the following substeps.
1. In theApplication plan list, select the External application plan that you want to associate with

this capture profile.
2. Optional. In theWorkflow process list, select the workflow process to which you want to route

the new items.
3. If you selected a workflow process, in theWorkflow queue list, select the workflow queue to

which you want to route the new items.
4. Optional. To submit items toRecognition Agent for bar code scanning, select theSubmit to

Content Server check box.
5. Optional. To add items to version control, select theSubmit to version control check box.
6. Click Next.

7. In theCapture Profile Verification page, review your capture profile configuration settings and
perform one of the following actions.
l Tomodify a configuration setting, click Back andmake any needed changes.
l To keep the configuration settings, click Finish.

Create an Import Agent capture profile for a document

An Import Agent capture profile stores the settings you define for Import Agent to import files into a document.
To create an Import Agent capture profile, complete the following steps.

An Import Agent capture profile is one component required to define an Import Agent Capture Profile mode.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theCapture Profile tab, click New > Import Agent.
4. In theCapture Profile Definitionwizard, on theCapture Profile Content Type page, select

Document.
5. On theCapture Profile Information page, complete the following substeps.

1. Type a name and optional description for the capture profile.
2. Verify that theProfile is active check box is selected.
3. Click Next.

6. On theCapture Profile Source page, select one of the following options.
l Create a new source profile.
l Select an existing source profile and then choose a source profile from the list.

7. On theCapture Profile Options page, complete the following substeps.
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1. In theApplication plan list, select the Import Agent application plan that you want to associate
with this capture profile.

2. Optional. In theWorkflow process list, select the workflow process to which you want to route
the new documents.

3. If you selected a workflow process, in theWorkflow queue list, select the workflow queue to
which you want to route the new documents.

4. Optional. To submit documents toRecognition Agent for bar code scanning, select theSubmit
to Content Server check box.

5. Optional. To add documents to version control, select theSubmit to version control check box.

6. Click Next.
8. On theCapture Profile Verification page, review your capture profile configuration settings and

complete one of the following actions.
l Tomodify a configuration setting, click Back andmake any needed changes.
l To keep the configuration settings, click Finish.

Create an SAP ArchiveLink capture profile for a document

Perceptive Content Connector for SAP ArchiveLink is an extension that provides the functionality to upload
metadata stored in Perceptive Content to SAP software. SAP uses this metadata to create financial
accounting (FI) documents in your SAP application. To configure a capture profile for SAP ArchiveLink,
complete the following steps.

Prerequisite Before you begin this procedure, youmust install Perceptive Content Connector for SAP
ArchiveLink and create an Interact application plan for a document.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theCapture Profile tab, click New > SAP ArchiveLink.
4. In theCapture Profile Definitionwizard, on theCapture Profile Content Type page, select

Documents.
5. On theCapture Profile Information page, complete the following substeps:

1. In theName box, type SAP ArchiveLink.

Note: For a SAP ArchiveLink capture profile, the namemust be SAP ArchiveLink.

2. In theDescription box, type a short profile description.
3. Verify that theProfile is active check box is selected.
4. Click Next.

6. On theCapture Profile Options page, complete the following substeps:
1. In theApplication plan list, select the Interact application plan that you want to associate with

this capture profile.
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2. Optional. In theWorkflow process list, select the workflow process to which you want to route
the new documents.

3. If you selected a workflow process, in theWorkflow queue list, select the workflow queue to
where you want to route the new documents.

4. Optional. To submit documents toRecognition Agentfor bar code scanning, select theSubmit
to Content Server check box.

5. Optional. To add documents to version control, select theSubmit to version control check box.
6. Click Next.

7. On theCapture Profile Verification page, review your capture profile configuration settings and
complete one of the following actions:
l Tomodify a configuration setting, click Back andmake any needed changes.
l To keep the configuration settings, click Finish.

Delete a server-based capture profile

To delete a server-based capture profile, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theCapture Profile tab, click the capture profile you want to delete.
4. Click Delete.
5. In the confirmation prompt, click Yes.

Modify or rename a server-based capture profile for a document

Tomodify or change the name of a server-based capture profile that is used to capture files into a document,
complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theCapture Profile tab, click the capture profile you want to modify and click

Modify.
4. Optional. In theConfigure Capture Profile dialog box, on theGeneral tab, complete any of the

following actions.
l Modify the name and description.
l To activate the profile, select theProfile is active check box.
l To deactivate the profile, clear theProfile is active check box.

5. Optional. On theProfile tab, complete any of the following actions.
l In theSource type list, select a new source.
l If you selected Import Agent as the source type in the previous step, in theSource profile list,
select a source profile.
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l In theApplication plan list, select a new application plan.
l In theWorkflow process list, select a new workflow process.
l In theWorkflow queue list, select a new workflow queue.
l Optional. Select or clear the check box for any of the listed options.

6. Verify the changes and click OK.

Source Profiles

Copy a source profile

To quickly create a new source profile, you can base it on an existing profile. To copy a source profile,
complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theSource Profile tab, select the source profile you want to copy.
4. Click Copy.
5. In theCopy dialog, enter a name and click OK.

Create an Import Agent source profile

An Import Agent source profile stores information about the file types you want Import Agent to capture, the
method to gather document property values, and whether to move or delete the source files after Import Agent
captures them. To create a source profile for Import Agent, complete the following steps.

Prerequisite Import Agent is provided in the same installer as ImageNow Server, and this procedure
assumes that Import Agent is already installed. An Import Agent source profile is one component required to
configure Import Agent to capture files using Capture Profile mode.

1. InManagement Console, in the left pane click Capture.
2. In the right pane, on theSource Profile tab, click New.
3. In theSource Profile Definitionwizard, on theSource Profile Information page, perform the

following substeps:
1. In theName box, type a unique profile name.
2. In theDescription box, type a short profile description.
3. In theSource list, select Import Agent.
4. Verify that theProfile is active check box is selected.
5. Click Next.

4. On the Import AgentMode page, in the Import mode list, select one of the followingmodes and click
Next:
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Situation Steps

Obtain document property values from a
separate index file that your business application
generates. Perceptive Content assigns the
property values to an imported file. Import Agent
monitors the directory you specify for the
import.directory setting in the inserverImp.inifile
for an index file and a file to import.

1. Select Index File.
2. On the Import AgentOptions page, in the

Index file extension box, enter the file
extension of the index file that your business
application generated. The default is .inx.

3. In the Field delimiter box, enter the
delimiter character used in the index file to
separate data. The default is ^.

4. To specify whether Import Agent deletes or
moves files from the import directory after it
stores the files in the OSM, underAfter
capture, select Delete files orMove files
to the import complete directory.

5. Optional. To separate pages in a TIFF file,
resulting in a thumbnail for each page in
viewer, select the Split TIFFs into
separate pages for thumbnails check
box. Otherwise, the viewer displays the TIFF
file as one document that you can scroll
through.

6. Optional. If you selected Split TIFFs into
separate pages for thumbnails, and you
want each page to exist as a separate
document, select Make each page a
separate document.

Obtain document property values from the name
of the file it imports from the directory specified
for the import.directory setting in the
inserverImp.ini file. Perceptive Content can
populate property values for the imported file
based on literal or dynamic values defined in the
[Mode FILENAME] group in the inserverImp.ini
file.

1. Select File name.
2. To specify which file types to import from the

import directory specified in the
inserverImp.ini file, on the Import
AgentOptions page, under Select what to
import, select All file extensions or Limit
file extensions to the following.

3. To specify whether Import Agent deletes or
moves files from the import directory after it
stores the files in the OSM, underAfter
capture, select Delete files orMove files
to the import complete directory.

4. Optional. To separate pages in a TIFF file,
resulting in a thumbnail for each page in
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Situation Steps

viewer, select the Split TIFFs into
separate pages for thumbnails check
box. Otherwise, the viewer displays the TIFF
file as one document that you can scroll
through.

5. Optional. If you selected Split TIFFs into
separate pages for thumbnails, and you
want each page to exist as a separate
document, select Make each page a
separate document.

5. Click Next.
6. On theSource Profile Verification page, review your source profile configuration settings and perform

one of the following actions:
l Tomodify a configuration setting, click Back andmake any needed changes.
l To keep the configuration settings, click Finish.

Create an External Scanner source profile

Use this source profile when capturing images from an application that is utilizing Integration Server to
connect with Perceptive Content. This source profile stores settings you configure for your scanner, and
those become the default settings for any scan application you use. To create an External Scanner source
profile, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Capture.
3. On theSource Profile tab, click New.
4. On theSource Profile Content Type page, select Document orRecord, and then click Next.
5. On theSource Profile Information page, complete the following substeps, and then click Next.

1. UnderName, type a name for the source profile.
2. UnderDescription, type a description for the source profile.
3. UnderSource, select External Scanner.

Note: This source profile is active and available for use with scanner capture profiles. To
deactivate this source profile, clear theProfile is active check box.

6. On theScanner Options page, select scanner settings according to the options available for your
scanner. To display additional settings for your scanner when you scan, select Display property
dialog at scan time. Click Next.

7. On theScanner Barcode Options page, enable barcode detection for each barcode type you want,
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and then click Next.

Note: AutoBarcode is enabled by default, and identifies all barcode types. To ensure that only
specific barcode types are identified, youmust disableAutoBarcode.

8. On theScanner Image Processing Options page, select image processing options for your scanner,
and then click Next.

9. On theSource Profile Verification page, verify that the source profile settings are accurate, and then
click Finish.

Delete a source profile

To delete a source profile from your system, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theSource Profile tab, select the source profile you want to delete.
4. Click Delete.
5. In the confirmation prompt, click Yes.

Modify a source profile

Tomodify a source profile, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. Click Capture.
3. In the right pane, on theSource Profile tab, select the source profile you want to modify.
4. Click Modify.
5. Make the changes you want.
6. Click OK.

What is a source profile?

A source profile contains information about a server-side capture source. You associate a source profile with
one or more capture profiles to make capture a simple task for your users.

The source profile stores information about the file types you want to capture, themethod for gathering
property values, and whether to move or delete the source files after capturing them into Perceptive Content.

Source profiles for documents and records are available for Import Agent, Interact for Microsoft Outlook, and
scanners.

To view records functionality, youmust install a Records Manager license.



Manage Documents User Guide

143

Scanning Profiles

CaptureNow Adrenaline (Kofax) image processing filters

Image processing allows for scanned images to bemanipulated either to improve quality of the incoming
image, or to gather data from the image itself. Kofax VirtualReScan (VRS) supports a number of image
processing filters, some of which are described here.

Barcode Detection

The Barcode Detection filter can be used to detect and decode barcodes on scanned images. The filter
can detect many different types of barcodes, and there is no limit to the number of barcodes it can detect
on a page.

Border Removal

The Border Removal filter can be used to remove black edges that sometimes appear around the image
during scanning or photo-copying. The Border Removal filter looks for black around the edge of an image
(borders) and changes it to white.

Borders must be all black. If the border contains white, the filter will not remove it. The Border Removal
filter has no configurable settings.

Deshade

Shaded areas on an image are rectangular areas made up of black speckles. You can remove shaded
areas using the deshade feature. The deshade process removes the speckles that make up the shaded
areas while preserving the text inside the shaded areas.

Deskew

The Deskew filter can be used to straighten images that show a slant from its correct orientation.
Skewing can occur if the original document was skewed when it was fed into the scanner, fax machine,
or photocopier. The Deskew filter examines the image and determines the skew angle. The skew angle
is measured between the actual edge of the image data and the horizontal or vertical axis. The image
data is then rotated to correct the skew angle. Deskewing an imagemakes the image contents more
legible and can improveOCR results.

Despeckle

Speckles on an image are groups of black pixels surrounded by white pixels (or white pixels surrounded
by black pixels). You can remove unwanted speckles with the despeckle feature.

Edge Enhancement

The process of cleaning up lines and characters on an image, making them easier to read.

Endorser - Imprinter

Used with imprinter hardware that connects to the scanner and is used to print a string of data onto the
original scanned document.
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Line Removal

The Line Removal filter can be used to remove lines from or to reconstruct lines on a form-based image.
Removing lines can reduce the image file size and improveOCR results.

Patchcode Detection

The Patchcode Detection filter can be used to detect and decode patchcodes on scanned images. The
Patchcode Detection filter has no configurable settings.

Streak Removal

Sometimes streaks are included on an image during the scan process. For example, they might occur
as a result of marks on the original page, dust in the scanner assembly, or faulty scanner. These streaks
can be removed with the streak removal feature.

CaptureNow Adrenaline (Kofax) scanning profile options

The following tables describe the options that CaptureNow displays in a scanning profile for a scanning
device that uses a Kofax driver.

Properties
The Properties tab lists the following options.

Manual Start

Allows for amanual start, which requires the user to click the Scan button if present on the device.

Prompt when feeder becomes empty

Specifies to prompt the user when the device's document feeder is empty. This option is useful when
the user needs to add pages to a batch scan.

Auto Length Detection

Detects the page length. This option is helpful when a page is shorter than the size specified for Size.

Color Mode

Specifies the color mode to scan images. The available color options vary by scanning device.

Continuous Sheet

For scanning pieces of paper larger than legal size.

Destination

Specifies where scanned pages output to. This option is only available if the scanning device has more
than one destination.
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DPI

Specifies the Dots Per Inch (DPI). A higher DPI enhances image quality but also uses more storage
space.

Orientation

Specifies the page orientation as landscape or portrait.

Scan Start

Specifies the number of seconds the user can load paper into the scanning device after a scan operation
begins. This option only applies when you the user manually feeds pages into the scanner. We
recommend 30 seconds. If you set Scan Start to 0, no timeout occurs.

Set Scan Start to a value that is equal to or less than the value for Timeout on the Advanced tab.

Sides

Specifies which sides of a page to scan. You can choose one of the following options:

Simplex. Scans one side of each page.

Duplex. Scans both sides of each page. The scanning devicemust support duplex scanning.

Size

Specifies which paper size to scan.

Source

Specifies from where the device feeds the paper. This option is only available if the device has more
than one source.

Flatbed
If the scanning device includes a flatbed, CaptureNow lists the following options.

Action

Specifies the action between flatbed scans. You can choose one of the following options:

Prompt Between Scans. Displays a prompt asking if the user wants to scan another page.

Delay Between Scans. Displays a dialog box based on the Delay and Default options described later in
this table.

Default

Specifies which action occurs when the Delay timer expires. This option only applies when you set
Action to Delay Between Scans. You can choose one of the following options:

Scan. Scan when the Delay timer expires.

Stop. Stop scanning when the Delay timer expires.
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Delay

Specifies how long the prompt remains open before CaptureNow performs the Default action. This
option only applies when you set Action to Delay Between Scans.

Prompt to turn on ADF

Specifies whether to prompt the user to turn on the Automatic Document Feeder (ADF). This option is
helpful when the user needs the ability to scan from either the flatbed or the document feeder within one
profile.

Scan from flatbed when feeder is empty

Specifies whether to initiate flatbed scanning when the document feeder becomes empty.

Advanced
The Advanced tab lists the following options.

Advanced button

Opens the Advanced Settings dialog box that provides additional options. These options vary by
scanning device.

Calculate Blank Page Deletion

Indicates that amore advanced comparison will be used to delete blank pages. Useful in the event that
Kofax fails to properly set deletion flag when file size is less than the threshold.

Image Processing Filters

Allows for scanned images to bemanipulated either to improve quality of the incoming image, or to
gather data from the image itself.

Prescan

Specifies the number of pages for the Kofax accelerator to cache.

Timeout

Specifies the number of seconds before the scanning process expires after the last page is scanned.

Units button

Opens the Units dialog box where you can specify units of measurement (inches, centimeters, or
pixels).

Options
The Options tab lists the following options.
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Back Picking Rectangle Enabled

Specifies picking angle for devices supporting duplex scanning. Required that the current profile have
Duplex selected in the Sides field on the Properties tab.

Blank Page Detection (threshold)

Indicates if blank page is detected. If the threshold is not met, the scanned image will be discarded. The
threshold is theminimum file size (in Kilobytes) that a file must be in order to be retained.

Front Picking Rectangle Enabled

Specifies that a picking rectangle will be used within the profile. Picking rectangles retain a portion of the
scanned document (as defined through the top, left, width, and height fields). The rest of the image is
discarded.

Height

Specifies the total height, starting with topmeasurement.

Left

Specifies the distance from the left edge of the original page to being cropping the image.

Rotation

Specifies if the scanned page will be rotated. Pages can be rotated in 90 degree increments.

Top

Specifies the distance from the top edge of the original page to begin cropping the image.

Unit

Indicates the unit of measure for the top, left, width, and height measurements.

Width

Specifies the total width of the cropped image, starting with left measurement.
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CaptureNow ISIS (Pixel) image processing filters

Image processing allows for manipulation of scanned images either to improve quality of the image as it is
imported or to gather data from the image itself. Pixel Supports a number of image processing filters for color
and binary (black and white) image.

Filters

Although you can use all filters for both color and binary images, adding the Threshold filter to convert an
image to black and white may improve the results if processed prior to another filter, such as Dilation. The
order in which the filters appear in the Selected filters pane determines at what point during the image
processing Perceptive Content performs the filter action. When you build your Scanning Profile as part of
building your Capture Profile, the following filter options are available in the Image Processing tab when you
choose Pixel as your device.

Barcode Detection

The Barcode Detection filter can be used to detect and decode barcodes on scanned image. the filter
can detect many different types of barcodes, and there is no limit to the number of barcodes it can detect
on a page.

Black Overscan Removal

The Black Overscan Removal filter can be used to remove the black area around an image when a page
is scanned using an overscan option. Unlike the Border Removal filter, which inverts the black pixels
andmakes them white, and the Crop filter which removes white space from around the edge of the
image, the Black Overscan removal filter removes the overscan area from your image. This filter
reduces the physical size of the scanned image and the image file size by eliminating the black border
generated by scanners with black backgrounds. For best results, deskew images with black fill before
applying this filter. The Black Overscan removal filter has no configurable settings.

Blank Page Detection

The Blank Page Detection filter can be used to detect blank pages. Use the Sensitivity property to
specify noise tolerance during detection.

Border Removal

The Border Removal filter can be used to remove black edges that sometimes appear around the image
during scanning or photo-copying. The Border Removal filter looks for black around the edge of an image
(borders) and changes it to white. Borders must be all black. If the border contains white, the filter will
not remove it. The Border Removal filter has no configurable settings.

Color Dropout

The Color Dropout filter takes a color image and transforms specified colors into other colors. The filter
maintains a list of color mappings that it shouldmake when the filter is run. The Color Dropout
Properties dialog allows the user to manage a list of colors that will be transformed.
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Crop

The Crop filter can be used to set imagemargins and to remove white space around the edge of the
image. You can set different values for the Top, Left, Bottom, and Right properties, or you can use the
Force Symmetry property to lock the top/bottom and left/right margins to the same values.

Deskew

The Deskew filter can be used to straighten images that show a slant from its correct orientation.
Skewing can occur if the original document was skewed when it was fed into the scanner, fax machine,
or photocopier. The Deskew filter examines the image and determines the skew angle. The skew angle
is measured between the actual edge of the image data and the horizontal or vertical axis. The image
data is then rotated to correct the skew angle. Deskewing an imagemakes the image contents more
legible and can improveOCR results.

Dilation

The Dilation filter can be used to expand the area of black objects in an image. Using this filter may
improve image quality and the legibility of text. Performing dilation can increase the file size.

Erosion

The Erosion filter can be used to trim the area of black objects. Using this filter will reduce the file size,
but you could lose a lot of detail from the image content.

Halftone Removal

The Halftone Removal filter can be used to remove a background from an image or a graphics object on
the image. The Halftone Removal filter has no configurable settings.

Hole Removal

The Hole Removal filter can be used to remove punch holes from the edges of the image. The algorithm
searches for objects which look like punch holes around the edges of the image. Punch hole-like
graphics objects in other areas of the image will not be removed. The Hole Removal filter has no
configurable settings.

Invert Image

The Invert filter can be used to invert the image to its negative equivalent. The filter actually modifies the
image data itself, changing white pixels to black and black pixels to white. The Invert filter has no
configurable settings.

Line Removal

The Line Removal filter can be used to remove lines from or to reconstruct lines on a form-based image.
Removing lines can reduce the image file size and improveOCR results.

Noise Removal

The Noise Removal filter returns or sets themaximum area percentage an object can take up within the
area defined by themaximum noise width and height in order for the object to be considered noise.
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Patchcode Detection

The Patchcode Detection filter can be used to detect and decode patchcodes on scanned images. The
Pathcode Detection filter has no configurable settings.

Rotation

The Rotation filter can be used to perform image rotation in 90 degrees increments. It can rotate the
image 90 degrees clockwise and counterclockwise. it can also rotate it 180 degrees as well as perform
mirroring, which flips the page across the vertical axis so that it appears to be themirror image of the
original.

Scaling

The Scaling filter can be used to resize an image while preserving the original aspect ratio. After you
specify the desired width and height after scaling, the image area is resized so that it fits within those
boundaries, while maintaining the aspect ratio. If either the desired height or width value is larger than
the scaled image area, then the image area is centered along that dimension and white margins added to
both sides.

Skeleton

The Skeleton filter can be used to reduce black objects in an image to one pixel thick skeletonized
versions. Using this filter can reduce file size, but it can seriously distort the image. It should be used
with caution and is usually only appropriate with certain types of OCR engines. The Skeleton filter has
no configurable settings.

Smoothing

The Smoothing filter can be used to remove bumps and spurs that appear on text characters or graphics
objects in the image. The filter looks for any pixel that is surrounded by five or six other connected pixels
of the opposite color, and then inverts that center pixel based on the filter configuration. Smoothing is a
good way to improve legibility or to reduce the file size without losing a lot of image detail.

Threshold

The Threshold filter can be used to convert a 24-bit color image to a binary image. All of the pixels in a
color image that are darker than the threshold specified with the Brightness and Contrast properties are
converted to black and all of the pixels that are lighter than the threshold are converted to white.

CaptureNow ISIS (Pixel) scanning profile options

The following lists describe the options that CaptureNow displays in a scanning profile for a scanning device
that uses a Pixel driver.

Properties
The Properties tab lists the following options.

Paper Size

Specifies which paper size to scan.
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DPI

Specifies the Dots Per Inch (DPI). A higher DPI enhances image quality but also uses more storage
space.

Color

Specifies the color mode to scan images. The available color options vary by scanning device.

ADF Timeout

Specifies the number of seconds before the scanning process times out after the device scans the last
page.

Scan Source

Specifies from where the device feeds the paper.

Orientation

Specifies the page orientation as landscape or portrait.

Sides

Specifies which sides of a page to scan. You can choose one of the following options:

Simplex. Scans one side of each page.

Duplex. Scans both sides of each page. The scanning devicemust support duplex scanning.

Prompt when feeder becomes empty

Specifies to prompt the user when the device's document feeder is empty. This option is useful when
the user needs to add pages to a batch scan.

Enable ScanAhead

Specifies for imprinter hardware that is connected to the scanner to print a string of data onto the original
scanned page.

Advanced button

Opens the Advanced Settings dialog box for the selected device. The options vary by scanning device.

Flatbed
If the scanning device includes a flatbed, CaptureNow lists the following options.

Scan from flatbed when feeder is empty

Specifies whether to initiate flatbed scanning when the document feeder becomes empty.
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Prompt to turn on ADF

Specifies whether to prompt the user to turn on the Automatic Document Feeder (ADF). This option is
helpful when the user needs the ability to scan from either the flatbed or the document feeder within one
profile.

Action

Specifies the action between flatbed scans. You can choose one of the following options:

Prompt Between Scans. Displays a prompt asking if the user wants to scan another page.

Delay Between Scans. Displays a dialog box based on the Delay and Default options described later in
this table.

Delay

Specifies how long the prompt remains open before CaptureNow performs the Default action. This
option only applies when you set Action to Delay Between Scans.

Default

Specifies which action occurs when the Delay timer expires. This option only applies when you set
Action to Delay Between Scans. You can choose one of the following options:

Scan. Scan when the Delay timer expires.

Stop. Stop scanning when the Delay timer expires.

Image Processing
The Image Processing tab lists the following options.

Front

Displays image processing filters available for Simplex scanning.

Back

Displays image processing filters available for Duplex scanning.

Modify button

Lets you add, remove, and configure the available filters.

Create a scanning profile

A scanning profile contains information about scanning hardware. You associate a scanning profile with a
capture profile. To create a profile for a scanning device, complete the following steps.

Prerequisite The user logged in to the local machinemust have theWrite permission for the
[drive]:\Documents and Settings\All Users\Application Data\Perceptive Content\etc directory. Before you
begin this procedure, ensure the scanning device is configured.

1. On thePerceptive Content toolbar, click Settings > Options.
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2. In the ImageNow Options dialog box, perform the following substeps.
1. In the left pane, click Capture.
2. On theGeneral tab, underScanning Profiles, click Manage Profile List.

3. In theScanning Profile Manager dialog box, click Create.
4. In theScanning Profile dialog box, on theGeneral tab, perform the following substeps.

1. In theName box, type a unique profile name.
2. In theDescription box, type a short profile description.
3. In theDevice box, select a scanning device.

Depending on the type of driver you selected for the scanning device, the Scanning Profile dialog
box will display different tabs. Kofax drivers useGeneral, Properties, Advanced, andOptions
tabs. Other drivers useGeneral, Properties, and Image Processing tabs.

5. On theProperties tab, underProperties, choose the options you want.
6. Optional. If you are working with a flatbed scanner, under Flatbed Settings, choose the options you

want. If your scanner does not support flatbed scanning, then the Flatbed Settings options are dimmed
and unavailable.

7. When using Kofax drivers, on theAdvanced tab, underOptions, choose one or more of the following
options.
l In thePrescan box, specify the number of pages to be cached by the Kofax Accelerator.
l In the Timeout box, specify the time in seconds before the scanning process will stop after the last

page is scanned.
l To delete blank pages from the scanning process by using amore advanced comparison, select
theCalculate Blank Page Deletion check box.

l Click Advanced, and then choose the options you want. These vary based on the device you have
installed.

l Click Units, and then specify what units of measurement you want for the current profile.
8. When using Kofax drivers, on theOptions tab, choose the options you want in order to scan part of a

document, not all of it. If your scanning device supports duplex scanning, then you can specify a
picking rectangle for both front and back pages.

9. On the Image Processing tab, select a filter and add it to theSelected Filters pane. Once added, you
can configure the filter, move it up or down, or remove it.
The order in which the filters appear in theSelected Filters pane determines at what point during the
image processing Perceptive Content performs the filter action. For example, if you added the
Threshold filter to convert an image to black and white and the Dilation filter to expanding the area of
black objects in an image, you would need to ensure that the Threshold filter appears above the Dilation
filter in the Selected Filters pane.

10. Click OK to return to thePerceptive Content toolbar.

Create an external interface capture profile for a document

You use an external interface capture profile with external interfaces such as iScript or Integration Server. To
create an external interface capture profile, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the



Manage Documents User Guide

154

list.
2. Click Capture.
3. In the right pane, on theCapture Profile tab, click New > External Interface.
4. If theCapture Profile Content Type page appears, select Document, and then click Next.
5. On theCapture Profile Information page, perform the following substeps.

1. Type a name and optional description.
2. Verify that theProfile is active check box is selected.
3. Click Next.

6. In theCapture Profile Options page, complete the following substeps.
1. In theApplication plan list, select the External application plan that you want to associate with

this capture profile.
2. Optional. In theWorkflow process list, select the workflow process to which you want to route

the new items.
3. If you selected a workflow process, in theWorkflow queue list, select the workflow queue to

which you want to route the new items.
4. Optional. To submit items toRecognition Agent for bar code scanning, select theSubmit to

Content Server check box.
5. Optional. To add items to version control, select theSubmit to version control check box.
6. Click Next.

7. In theCapture Profile Verification page, review your capture profile configuration settings and
perform one of the following actions.
l Tomodify a configuration setting, click Back andmake any needed changes.
l To keep the configuration settings, click Finish.

Create an External Scanner source profile

Use this source profile when capturing images from an application that is utilizing Integration Server to
connect with Perceptive Content. This source profile stores settings you configure for your scanner, and
those become the default settings for any scan application you use. To create an External Scanner source
profile, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Capture.
3. On theSource Profile tab, click New.
4. On theSource Profile Content Type page, select Document orRecord, and then click Next.
5. On theSource Profile Information page, complete the following substeps, and then click Next.

1. UnderName, type a name for the source profile.
2. UnderDescription, type a description for the source profile.
3. UnderSource, select External Scanner.

Note: This source profile is active and available for use with scanner capture profiles. To
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deactivate this source profile, clear theProfile is active check box.

6. On theScanner Options page, select scanner settings according to the options available for your
scanner. To display additional settings for your scanner when you scan, select Display property
dialog at scan time. Click Next.

7. On theScanner Barcode Options page, enable barcode detection for each barcode type you want,
and then click Next.

Note: AutoBarcode is enabled by default, and identifies all barcode types. To ensure that only
specific barcode types are identified, youmust disableAutoBarcode.

8. On theScanner Image Processing Options page, select image processing options for your scanner,
and then click Next.

9. On theSource Profile Verification page, verify that the source profile settings are accurate, and then
click Finish.

What is a scanning profile?

A scanning profile is a type of source profile that contains information about your scanning hardware.

You can configure, save, and apply multiple settings related to available scanning hardware, and associate
those settings with capture profiles. Scanning profiles store information about the type of scanner your users
are using, along with scanner-specific features such as paper size, color mode, and image processing filters.
Before you can create a scanning profile, youmust install and license the scanner and then configure it to
work with CaptureNow.

Package Mode
Change the default basket for a basket group
When a user selects a basket group instead of a basket to capture files in ImageNowViewer - Package,
Perceptive Content captures the files into the basket set as the group's default. To set a basket as the default
for a basket group in PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, select the basket group and click Modify.
5. In theBasket Group dialog box, on theBaskets tab, in theDefault list, select a basket.
6. Click OK.

Configure Packagemode to import files overview
To enable users to import files using Packagemode, complete the following sequence of procedures to
configure the necessary component.

1. Create amanual application plan or Create a LearnMode application plan.
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2. Create a PackageMode capture profile from Filesourceoverview
3. Createabasket group.
4. Create a basket for a basket group.
5. Specify an application plan for Packagemode.
6. Optional. Distribute a client-based capture or scanningprofile if the capture profiles you create for

Packagemode apply to multiple workstations.

Configure PackageModewith Scan Prompter overview
To enable users to scan pages using PackageMode while Scan Prompter guides them through the process,
complete the following sequence of procedures.

1. Create amanual application plan or Createa LearnMode application plan.
2. Create a scanning profile for each type of scanner used to scan pages intoPackage Mode.
3. Create a PackageMode capture profile from Scanner source overview.
4. Createa basket group.
5. Create a basket for a basket group.
6. Createa package scanning document rule and associate it with the basket group.
7. Specify an application plan for Packagemode or specify to allow a user to select an application plan at

the time of capture.
8. Optional. Distribute a client-based capture or scanning profile if the scanning and capture profiles you

create for Packagemode apply to multiple workstations.

Configure PackageModewithout Scan Prompter overview
To enable users to scan pages using PackageMode without a Scan Prompter, complete the following
sequence of procedures.

1. Create amanual application plan or Create a LearnMode application plan.
2. Create a scanning profile for each type of scanner used to scan pages intoPackage Mode.
3. Create a PackageMode capture profile from Scannersource overview.
4. Create a basket group.
5. Create a basket for a basket group.
6. Specify an application plan for Packagemode or specify to allow a user to select an application plan at

the time of capture.
7. Optional. Distribute a client-based capture or scanningprofile if the scanning and capture profiles you

create for Packagemode apply to multiple workstations.

Copy a basket
To quickly create a new basket, you can base the group on an existing basket. To copy a basket in Package
Mode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
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3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, select the basket group and click Modify.
5. In theBasket Group dialog box, on theBaskets tab, select the basket group and click Copy.
6. Click OK until you return to thePerceptive Content toolbar.

Copy a basket group
To quickly create a new basket group, you can base it on an existing basket group. To copy a basket group in
PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, click the basket group and click Copy.
5. Click OK.

Create a basket group
To create a basket group in PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, to prompt a user to select a basket group to process files directly

after logging in, select thePrompt at login check box and click Create.
5. In theNew Basket Group dialog box, on theGeneral tab, type a name and optional description.
6. In theStatus list, verify that Active is selected.
7. To assign a capture profile to the basket group, select theProfile check box and perform one of the

following actions:
l To assign a capture profile to this basket group, in theProfile list, select a capture profile.
l To allow a user to select a capture profile, in ImageNowViewerPackage, in theProfile list, select
Use selected Capture Profile.

8. To display only the drawers for which the user has the Create privilege, on theBaskets tab, verify that
theRestrict drawer selection check box is selected.

9. Click OK.
Next Add baskets to the basket group.

Create a package scanning document rule
To create a document rule that Scan Prompter evaluates to guide a user through the scanning process in
PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
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3. On theGeneral tab, underPackage Settings, click Document Rules.
4. In theDocument Rules Manager dialog box, click Create.
5. In theNew Document Rule dialog box, on theGeneral tab, type a name and optional description.
6. To define how Scan Prompter displays the rule, in thePriority list, select one of the following options:

l Required. Forces the user to take the indicated action in Scan Prompter by clicking either the
Scan orReview button.

l Optional. Displays Scan Prompter but allows the user to skip the action by clicking theDefer
button.

l Disabled. Disables the rule so that Perceptive Content does not apply it to any documents in the
basket group. A disabled rule does not display Scan Prompter.

7. To select a capture profile to use when the user clicks theScan button for this rule inScan Prompter,
in theProfile list, select the capture profile.

8. On theConditions tab, do the following actions:

1. Click theAdd button and define the conditions you want to use for the scan prompter.
2. To display theReview button inScan Prompter, select theOn Success, display for Review

(with comment) check box.
The Review button enables the user to inspect a previously scanned document.

3. To display amessage inScan Prompterwhen a document on file passes all the conditions for a
specific rule, in theComments box, type themessage. For example,

Example Scan optional. There is already a valid driver's license on file for this patient.

9. On theBasket Groups tab, select the basket group that you want the rule to evaluate.
10. Click OK twice.

Delete a basket from a basket group
To delete a basket from a basket group in PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, select the basket group and click Modify.
5. In theBasket Group dialog box, underBaskets, select the basket you want to delete and click

Remove.
6. Click OK.

Delete a basket group
To delete a basket group and the baskets it contains in PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
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4. In theBasket Manager dialog box, select the basket group and click Delete.
5. Click OK.

Document rule conditions for package scanning
The following document rule conditions exist in PackageMode. Scan Prompter evaluates a document rule to
guide a user through the scanning process.

Type

Simple

Field

Drawer

Name

Field1

Field2

Field3

Field4

Field5

Document Type

Property

Creation Time

Creation User

Days since Creation

Days since Last View

Days sinceModification

Mod Time

ModUser

Total Pages
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Operator

Equal to

Not Equal to

Greater Than

Greater Than or Equal to

Less Than

Less Than or Equal to

Value

Type your value

Comment

Type your comment to notify end-users about the status or requirements for a document in Perceptive
Content.

Make a basket group active or inactive
Users can only capture files into a basket that is in an active basket group. To change the status of a basket
group to active or inactive, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, click the basket group and click Modify.
5. In theBasket Group dialog box, on theGeneral tab, in theStatus list, select Active or Inactive.
6. Click OK.

Modify a basket
Tomodify a basket in PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, select a basket group and click Modify.
5. In theBasket Group dialog box, on theBaskets tab, select the basket and click Modify.
6. In theBasket Definition dialog box, make any changes you want.
7. Click OK.
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Modify a basket group
Tomodify a basket group in PackageMode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, select the basket group and click Modify.
5. In theBasket Group dialog box, make any changes you want.
6. Click OK.

Reorder basket groups
To change the order in which basket groups display in a viewer, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, select a basket group and click Up orDown. Repeat this step until

the basket groups appear in the order you want.
5. Click OK.

Reorder baskets in a basket group
To change the order in which baskets display within a basket group in ImageNowViewer - Package, complete
the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In thePerceptive Content Options dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, select the basket group and click Modify.
5. In theBasket Group dialog box, on theBaskets tab, select a basket and click Up orDown. Repeat

this step until the baskets appear in the order you want.
6. Click OK twice.

Showor hide a basket group
Perceptive Content automatically hides a basket group when you define it as inactive, but you can show or
hide any basket group. To show or hide a basket group, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. On theGeneral tab, underPackage Settings, click Manage Group List.
4. In theBasket Manager dialog box, perform one of the following actions:

l To show a basket group in ImageNowViewer -Package, select the check box to the left of the
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basket group name.
l To hide a basket group in ImageNowViewer -Package, clear the check box to the left of the
basket group name.

5. Click OK.

Specify an application plan for Packagemode
You can specify that a user must use a particular application plan with Packagemode, or you can specify that
a user must select an application plan at the time of capture. The option you specify applies to all basket
groups and baskets. To specify an application plan for Packagemode, complete the following steps.

1. On thePerceptive Content toolbar, click Settings > Options.
2. In the ImageNowOptions dialog box, in the left pane, click Capture.
3. In the right pane, underPackage Settings, in theApplication Plan list, perform one of the following

actions:
l To select an application plan for all basket groups and baskets, select the application plan you
want.

l To use the application plan selected for Applications on the Perceptive Content toolbar at the time
of capture, select Use Default Application Plan.

4. Click OK.

Troubleshoot PackageMode
The following information describes how you can resolve an issue experienced by a user who is capturing
files with PackageMode.

The basket set in the capture profile resides in an inactive basket group

Cause Resolution

You attempt to use a profile set to capture files into
a particular basket, but the basket resides in an
inactive basket group.

Modify the capture profile so that you select a basket
that resides in an active basket group or the status
of the basket group in which the basket resides to
Active.

A conflict exists because the application plan is defined to store the document in
a folder but the basket definition is not

Cause Resolution

You attempt to capture files into a basket that is
defined to store the files in a drawer using document

Modify the basket so that it stores the files in a
folder, modify the application plan so that the map
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Cause Resolution

keys, but the map in the application plan is defined
to store the files in a folder using a path.

does not store the files in a folder, or specify a
different application plan for Package Mode.

The capture profile setting for the basket group or basket definition is invalid

Cause Resolution

The capture profile set for the basket group or
basket is inactive.

Select the Profile check box in the basket group or
the basket definition.

The capture profile set for the basket group or
basket was deleted from the Perceptive Content
system.

Select a different capture profile for the basket
group or the basket in the Profile list.

Sequences
Create a sequence in a capture profile
You can define a sequence and use it as a document property. To create a sequence in a capture profile,
complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the appropriate capture profile, and then click Modify.
3. Click theDocument Keys tab.
4. Double-click the appropriate key.
5. In theKey Definition dialog box, complete the following substeps.

1. From the Type list, select Sequence Number.
2. From theValue list, select Edit Sequence.

6. In theSequence Number dialog box, click New.
7. In theNew Sequence dialog box, complete the following substeps.

1. In theName box, type a name for your sequence.
2. From theBase list, select the numeral system you want to use for your sequence.
3. In theWidth box, type the number of digits you want to use in your sequence.
4. In the Increment box, type the amount that you want added to your sequence.
5. In thePrefix box, type a static text string that you want to precede the sequence.
6. In theSuffix box, type a static text string that you want to follow the sequence.

8. Click OK.
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Delete a sequence in a capture profile
To delete a sequence in a capture profile, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the appropriate capture profile, and then click Modify.
3. Click theDocument Keys tab.
4. Double-click the appropriate key.
5. In the Key Definition dialog box, do the following actions:

1. From the Type list, select Sequence Number.
2. From theValue list, select Edit Sequence.

6. In theSequence Number dialog box, select the sequence you want to delete and click Delete.
7. In the confirmation dialog box, click Yes.

Modify or rename a sequence
Using sequences, you can define your own sequence number and use it as a document property. Tomodify or
rename a sequence, complete the following steps.

1. On thePerceptive Content toolbar, click Capture > Manage Capture Profiles.
2. In theCapture Profiles dialog box, select the capture profile you want, and then click Modify.
3. Click theDocument Keys tab.
4. Double-click the appropriate key.
5. In theKey Definition dialog box, do the following actions:

1. From the Type list, select Sequence Number.
2. From theValue list, select Edit Sequence.

6. In theSequence Number dialog box, click Modify.
7. In theNew Sequence dialog box, do the following actions:

1. In theName box, type a name for your sequence.
2. From theBase list, select the numeral system to use for your sequence.
3. In theWidth box, type the number of digits to use in your sequence.
4. In the Increment box, type the amount to add to your sequence.
5. In thePrefix box, type a static text string to precede the sequence.
6. In theSuffix box, type a static text string to follow the sequence.

8. Click OK.
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Manage item properties
What is a custom property?

A custom property is a property field that is populated with data relating to an item or container.

A custom property allows you to store unlimited data beyond the standard item properties or container
structure. Youmake custom properties available to items and containers by assigning them to item types or
container types.

You can define a custom property using one of the following data types: Composite, Date, Flag, List, Number,
String, and User. Formatting settings let you control the data entry and display appearance of the custom
property for viewing by your end users. If you choose the Composite data type, you can create a composite
property that is a single property that contains one or more custom properties. Some data types require default
values. For others, default values are optional.

Suppose, for example, that the HumanResources Department has a "New Hire" folder type that is used to
create a folder for each new employee. When HumanResources hires a new Marketing director, the user
creates a new folder using the New Hire folder type and enters the following custom property values in
Perceptive Content for the folder:

l A string custom property for "Job Title" with the value "Marketing Director".
l A date custom property for "Date of Hire" with the value "05/08/2012".
As another example, a document assigned with the "Medical Enrollment Form" document type is added to
each new employee's folder. When the new employee completes the form, the user enters the following
custom property values in Perceptive Content for the document:

l A list custom property for "Plan Year" with the value "2012".
l A date custom property for "Coverage Start Date" with the value "06/01/2012".

What is a composite property?
A composite property allows you to storemultiple values or sets of values that are based on one or more
existing custom properties, and group and refine themetadata that your users use to describe the documents
and folders in your system.

Composite properties also allow users to store differing numbers of values in a single property. In the custom
properties of a document or folder, the user can add values to, change existing values in, or remove values
from a composite property at any time.

You can perform a search to locate documents, folders, and workflow items based on composite property
values just as you would when searching on any document or folder property.

The following examples show how youmight use composite properties:
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l You define a composite property to store values using a single custom property. In this example,
suppose you are tracking test scores for a student. Whenever a student repeats a test, the user tracking
the test scores must add the new score to the Test Results property in that student's document. For one
student, the scoremight contain one value, and for another it may contain fifteen values.

l You define a composite property to store sets of values usingmultiple custom properties. Expanding on
the previous example, suppose the user tracking the test scores needs to enter a date along with each
test score and a flag value that indicates whether a retest is required. This expanded Test Results
property contains one property set for a student who has taken the test only once, but for a student who
has taken the test and then retested five times, it contains six property sets, each with its own score,
date, and retest values.

Create a custom property overview
To create a custom property you can assign to a document or folder type or use as part of a composite
property, complete any of the following procedures.

l Create a date custom property.
l Create a flag custom property
l Create a list custom property
l Create a number custom property.
l Create a string custom property.
l Create a user custom property.

Create a date custom property
To create a custom property that stores a date value, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Custom Properties.
3. In the right pane, click New > Date.
4. In theNew Date Property dialog box, in theName box, type the name of the custom property.
5. InDefault value list, do one of the following options:

l To use the current date as the default value, select theDefault to the current date check box.
l To select a date to use as the default value, clear theDefault to the current date check box and
select the desired default date in theDefault value list.

l To use no default value, leave the default value empty and clear the checkbox.
6. In theDisplay Format section, select theMonth, Day, Year, andWeekday check boxes to show the

respective portion of the date.
7. Click OK.
Next You can assign the custom property to a document type, folder type, record type, record folder type, or
composite property.
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Create a flag custom property
To create a custom property that stores a flag, or boolean value, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Custom Properties.
3. Click New > Flag.
4. In theNew Flag Property dialog box, in theName box, type a name for the custom property.
5. Optional. In theDefault value list, select True or False for the default value for this custom property.

Note: If you leave this setting empty, no default value appears in the custom property.

6. In thePositive Label box, type the value to display when the condition is true.
7. In theNegative Label box, type the value to display when the condition is false.

Note: The Flag property stores values of 0 or 1 based on the value that is selected by the user. The
Positive Label andNegative Label boxes allow you to adjust the labels that represent the stored
values.

8. Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.

Create a list custom property
To create a custom property that stores a value from a predefined list, complete the following steps.

Prerequisite This procedure requires theGlobal > Manage > Custom Properties privilege.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Custom Properties.
3. In the right pane, click New > List.
4. In theNew List Property dialog box, in theName box, type a name for the custom property.
5. To add items to the list, do the following substeps:

1. UnderDisplay Format, in theValues list, click Add.
2. Type the value for the list item and then press ENTER.
3. Repeat the previous substeps for each value you want to display in the list.
4. Optional. After you add all list items, use theMove Up andMove Down buttons to rearrange the

order of the list items.
6. Optional. In theDefault value list, select the default list item value for this custom property.
7. Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.
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Create a number custom property
To create a custom property that stores a numeric value, complete the following steps.

1. InManagement Console, in the left pane, click Custom Properties.
2. In the right pane, click New > Number.
3. In theNew Number Property dialog box, in theName box, type a name for this custom property.
4. Optional. In theDefault value box, type the number to use for the default value for this custom

property.
5. UnderDisplay Format, complete the following substeps.

1. In the Format list, select Currency orDecimal.

Note: Select Currency format for currency values andDecimal format for standard numeric
values.

2. If you are usingCurrency format, select the currency type from the list.
3. If you are usingDecimal format, select whether the decimals are Fixed orVarying.
4. If you are usingDecimal format, in theDecimal Places box, type or select the number of

decimal places.

Note: If you are using a varying decimal value for a numeric value, you cannot set the number of
decimal places.

5. Optional. To remove the thousands separator from numbers greater than 999, clear the
Punctuated at thousands check box.

6. Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.

Create a string custom property
To create a custom property that stores a string value, complete the following steps.

1. InManagement Console, in the left pane, click Custom Properties.
2. In the right pane, click New > String.
3. In theNew String Property dialog box, in theName box, type a name for the custom property.
4. Optional. In theDefault value box, type the default string value for this custom property.
5. Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.

Create a user custom property
To create a custom property that stores a username value, complete the following steps.

Prerequisite This procedure requires theGlobal > Manage > Custom Properties privilege.

1. InManagement Console, in the left pane, click Custom Properties.
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2. In the right pane, click New > User.
3. In theNew User Property dialog box, in theName box, type a name for the custom property, and then

do one of the following options:
l To select user values from a group, complete the following substeps.
1. In the Source list, select Group.
2. In theGroup list, select the group.
l To select user values from a predefined list, complete the following substeps.
1. In the Source list, select Predefined list.
2. Click Add.
3. In theSelect Users dialog box, search for and select the users you want to add to the list and

click OK.
4. Reorder the list members as necessary.

4. Optional. In theDefault Value list, select the default user.
5. UnderDisplay Format, in the Format list, select a display format.
6. Optional. If you selected a display format other thanUser name, to display the prefix or suffix in the

user s user profile when displaying this custom property, select theDisplay prefix andDisplay suffix
check boxes.

7. Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.

Assign a custom property to a document type
To assign a custom property to a document type, complete the following steps.

Prerequisite Because assigning a custom property to a document type that is already in use can take a long
time, cause a potentially unacceptable delay, and use significant resources, we recommend you perform this
procedure during non-peak hours.

1. InManagement Console, in the left pane, click Document Types.
2. On theDocument Types tab, select the document type for which you want to assign a custom

property and then click Modify.
3. Optional. In theDocument Type dialog box, on theCustom Properties tab, to filter the available

custom properties by data type, in theBy Type list, select the data type you want.
4. In theDocument Type dialog box, on theCustom Properties tab, in theAvailable list, select the

custom property you want to add, click Add, and then, on theAdd Custom Properties confirmation
dialog box, click Yes.

5. If the document type is already in use, in theAdd Custom Property dialog box, determine how to
populate existing custom property values for all documents that are assigned any document types that
use this custom property:
l Select Use the Default Value assigned to this property to automatically populate existing custom
properties with the default value you specified when you created the custom property.

l Select Leave blank to populate existing custom properties with no value.
l Select Use to type or select a value to populate existing custom properties.
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6. Click OK and, if you receive another confirmation dialog box indicating the update could take a long
time and use significant resources, click Yes only if you are sure this will not create an unacceptable
delay. Otherwise, click No orCancel and repeat the procedure during non-peak hours.

7. Optional. Tomake a custom property required, in theAdded list, click once in the column in front of the
custom property until is displayed. A required custom property must contain a value whenever the
associated item is linked or you change the document type of the associated document.

Assign a custom property to a folder type
To assign a custom property to a folder type, complete the following steps.

1. InManagement Console, in the left pane, click Folder Types.
2. On the Folder Types tab, in the Folder Type list, select the folder type for which you want to assign a

custom property and click Modify.
3. Optional. In the Folder Type dialog box, on theCustom Properties tab, to filter the available custom

properties by data type, in theBy Type list, select the data type you want.
4. In the Folder Type dialog box, on the Custom Properties tab, in theAvailable list, select the custom

property you want to add, click Add, and, on theAdd Custom Properties confirmation dialog box,
click Yes.

5. If the file type is already in use, in theAdd Custom Property dialog box, determine how to populate
existing custom property values for all folders that are of folder types that use this custom property:
l Select Use the Default Value assigned to this property to automatically populate existing custom
properties with the default value you specified when you created the custom property.

l Select Leave blank to populate existing custom properties with no value.
l Select Use to type or select a value to populate existing custom properties.

6. Click OK, and if you receive another confirmation dialog box indicating the update could take a long
time and use significant resources, click Yes only if you are sure this is not an issue. Otherwise, click
No orCancel and repeat the procedure during non-peak hours.

7. Optional. Tomake a custom property required, in theAdded list, click once in the column in front of the
custom property. TheRequired icon appears. A required custom property must contain a value
whenever the associated item is linked or you change the folder type of the associated document.

Modify a custom property
To change settings for an existing custom property, complete the following steps.

1. In Management Console, in the left pane, click Custom Properties.
2. In the right pane, select the custom property you want to modify, and then click Modify.
3. In theModify <Property Type> Property dialog box, make your changes and then click OK.
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Delete a custom property
To delete a custom property, complete the following steps.

Because deleting a custom property that is already in use can take a long time, cause a potentially
unacceptable delay, and use significant resources, we recommend you perform this procedure during non-
peak hours.

1. InManagement Console, in the left pane, click Custom Properties.
2. In the right pane, select the custom property you want, and click Delete.
3. On theDelete Property dialog box, click Yes.

Custom property data types
You can choose from the following data types when you create a custom property. All custom property types
can have a default value or contain an empty (or NULL) value.

Data Type Name Data Type Description Value Restrictions

Composite Inherits types from
custom properties

A composite property
allows the user to enter
multiple values for a
single property.

If you select a single
custom property, the
user can add multiple
values of the same data
type to the composite.
The values appear as
numbered rows in the
Custom Properties pane
of the Viewer.

If you select multiple
custom properties, the
user can add multiple
property sets of the
composite with separate
sets of values for each
set. Property sets
appear as separate
hierarchies in the
Custom Properties pane
of the Viewer.

Valuesmust conform to
the data types of the
associated custom
properties.

Date Date field A date stored as a Not applicable.
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Data Type Name Data Type Description Value Restrictions

string. The displayed
date format is based on
the settings chosen
when you create the
custom property.

Flag Boolean field This data type is always
stored as TRUE (1) or
FALSE (0). The values
that display are based
on the settings chosen
when creating the
custom property.

1 or 0 but the display
strings that represent
the 1 can be altered.

List Predefined List This data type creates a
group of values that a
user can select from a
list box for the custom
property.

Not applicable.

Number Decimal number field Decimal data type
display format: Number
fields that support both
positive and negative
numbers up to a limited
number of digits. Zeros
to the right of the
decimal are suppressed.

Currency data type
display format: Number
fields that display as
currency defined using
one of the ISO 4217
country codes. The
default currency setting
matches the local
settings of the
ImageNowClient
computer.

Up to 16 digits.
Precision of 15 decimal
places.

String Text field Text fields that support
all printable ASCII
characters within the

Value can contain up to
128 characters. This
limit varies depending



Manage Documents User Guide

173

Data Type Name Data Type Description Value Restrictions

Single Byte character
set.

on your database
platform.

User User name This data type allows
you to select an
Perceptive Content user
to populate the custom
property.

Only Perceptive Content
users that currently exist
in the implementation.

Create a composite property
To create a composite property, complete the following steps.

1. InManagement Console, in the left pane, click Custom Properties.
2. In the right pane, click New > Composite.
3. In theNew Composite Property dialog box, in theName box, type the name of the composite

property and do the following substeps:
1. Optional. In theBy Type list, select the data type of the custom property you want to add.
2. In theAvailable list, select a custom property you want to include in the composite custom

property and then click Add.
4. Repeat the previous substeps until you have added all the custom properties you need.
5. Optional. To reorder the hierarchy of custom properties within the composite, in theAdded list, select

the property you want to reorder and then click Move Up orMove Down.
6. Click OK.
Next You can assign the composite property to a document type, folder type, record type, or record folder
type.

Modify a composite property
To change the name of a composite property or modify the custom properties associated with it, complete the
following steps.

1. InManagement Console, in the left pane, click Custom Properties.
2. In the right pane, select the composite property you want to modify.
3. To change the name of the composite property, in theModify Composite Property dialog box, in the

Name box, edit the name of the composite property.
4. To view a single custom property type in theAvailable list, in theBy type list, select a property type.
5. In theAvailable list, select any additional custom properties you want to include in the composite

property and then click Add.
6. To rearrange the hierarchy of custom properties within the composite, in theAdded list, select the

property you want to move and then click Move Up orMove Down.
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7. To remove a custom property from the composite, in theAdded list, select the property and then click
Remove.

8. Click OK.

Manage processes
Tasks
About administering tasks
To administer tasks in Management Console, you create task templates for your users.

You can assign one or more users a task on a particular document or folder. You choose the task type that
best matches the work that needs to be done. The three available task types are described below.

l Document deficiency. The document deficiency task type is used to indicate when a document is
missing or is incomplete.

l Pointer. The pointer task type is used to draw attention to a specific document or folder location for
further action.

l Signature required on document. The signature required on document task type is used when a
user needs to digitally sign a document. To use this task type, a Document Management Suite license is
required.

Task template security allows you to determine the roles your users have when working with tasks. You can
alsomanage reasons and reason lists for the task templates.

Signatures required on document tasks created inManagement Console are available for processing in
Interact Desktop. In Interact Desktop, you can Complete, Return, or Skip a Signature required on a document
task.

Troubleshoot tasks
If you experience issues using tasks, you can try any of the following possible resolutions.

I don t see a document task in Folder Viewer

Cause Resolution

If you create a document task and then add that
document to a folder, the document task does not
appear in the Tasks grid in Folder Viewer.

Only document tasks you create in Folder Viewer
appear in the Tasks grid in Folder Viewer.
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Not all location options are available when I create a task

Cause Resolution

The task template you are using to create a task
does not have the Task location set in the
Components area of the task template.

Use a different task template or select an available
location option.

When you are in Folder Viewer and do not have a
document open in ImageNowViewer - Folder, the
only Location option available is Folder.

To create a document or page task in Folder Viewer,
the associated viewer, ImageNowViewer- Folder
must be open.

When in ImageNowViewer, Folder is unavailable
because you are not in a folder.

Folder is only available when you create a task in
Folder Viewer.

Task Templates

Create a document deficiency task template overview

Document deficiency task templates define the structure of document deficiency tasks, which indicate when
a document is missing or incomplete. To create and define a document deficiency task template, complete
the following sequence of procedures.

1. Create a document deficiency task template.
2. Define task template properties.
3. Define task template components.
4. Optional. Define task template actions.
5. Define task template assignments.
6. Define task template reasons.
7. Define task template due datemethod.
8. Define task template security.

Create a signature required task template

To create a new signature required task template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Tasks.
3. In the right pane, on the Templates tab, in theSelect a task type box, click Signature required on

document.
4. Click New.

TheSignature Required on Document Task dialog box appears.
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Next Youmust define the task template s general properties, components, actions, assignments, reason
lists, due date, and security.

Create a pointer task template overview

To create a pointer task template, complete the following sequence of procedures.

1. Create a pointer task template.
2. Define task template properties.
3. Define task template components.
4. Optional. Define task templace actions.
5. Define task template assignments.
6. Define task template reasons.
7. Define task template due datemethod.
8. Define task template security.
Result The Incomplete Template dialog box appears if you do not define assignments, reason lists, or if you
opted to send the folder to workflow when the task location is a document in a folder box, but did not select a
queue. You can save this template in any of these states, but the template is set to inactive.

Modify a task template overview

Tomake changes to a task template, complete the following steps.

1. Open a task template.
2. Define task template properties.
3. Define task template components.
4. Optional. Define task template actions.
5. Define task template assignments.
6. Define task template reasons.
7. Define task template due datemethod.
8. Define task template security.

Copy a task template

Task templates specify various options for task creation. To copy a task template, complete the following
steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Tasks.
3. In the right pane, on the Templates tab, in theSelect a task type box, click a task type.
4. In the Templates list, click a template and then click Copy.
5. In theName column, type a name and then press ENTER.
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Rename a task template

To assign a new name to a task template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Tasks.
3. In the right pane, on the Templates tab, in theSelect a task type box, click a task type.
4. In the Templates list, click a template and click Rename.
5. In theName column, type the text of the template name and then press ENTER.

Delete a task template

When you delete a task template, Perceptive Content removes the template fromManagement Console but
retains all associated tasks. To delete a task template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Tasks.
3. In the right pane, on the Templates tab, in theSelect a task type box, click a task type.
4. In the Templates list, click a template and then click Delete.
5. In the Task Template dialog box, click Yes.

Configure task email notifications

To configure the options required for task creation email notifications, complete the following steps.

1. To add email addresses so that users can receive task creation notifications, perform the following
substeps.
1. InManagement Console, in the left pane, underSelect Department, select a department from

the list.
2. In the left pane, select Users.
3. In the right pane, on theUser Profiles tab, select the user for whom you want to add an email

address and then click Modify.
4. In theModify User Profile dialog box, in the left pane, select Contact Information.
5. In the right pane, in theEmail box, type the user's email address.
6. Click OK.
7. Define email addresses for all necessary users.

2. To configurePerceptive ContentNotification Agent to send email notifications, perform the following
substeps.
1. On the ImageNow Server computer, navigate to the [drive:]\inserver\etc folder.
2. Open the inserverNotification.ini file in a text editor.
3. In the Email section, configure the smtp.server.url setting.
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Example smtp.server.url=<smtp or smtps>://<SMTP server name or IP
address>:<port number>

4. Configure the smtp.from address.

Example smtp.from=<From address for email notifications>

5. Save and close the inserverNotification.ini file.
Result All task templates use the same Perceptive Content settings.

Task Reasons

About managing task reason lists

Reasons provide users with pre-set descriptions that they can select to indicate why they are signing,
completing, or returning a task.

A reason list is a set of reasons that you, the administrator, bundle as a list from which the user can select.
There are two types of reasons and reason lists: Action and Return. While Return reasons are required for
each task template type, Action reasons are optional for document deficiency and pointer task template
types.

Manage reasons

You can create reasons and then group them together in reason lists. You can assign reasons and reason lists
to tasks, workflow item holds, or digital signatures. To create, modify, or delete a reason, complete one of the
following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, complete one of the following steps.
1. Tomanage reasons for tasks or workflow item holds, underSelect Department, select a

department from the list.
2. Tomanage reasons for digital signatures, underSelect Department, select Cross Department

Settings.
3. In the left pane, click Tasks,Workflow, orDigital Signatures.
4. In the right pane, on theReason Lists tab, select a reason list and click Modify.
5. In theReason List dialog box, on the List Members tab, complete one of the following actions.

Situation Steps

Create a reason 1. ClickNew.
2. In theReason text box, type a name.

Modify a reason 1. Select a reason and clickModify.
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Situation Steps

2. In theReason text box, type a new name.

Delete a reason 1. Select a reason and clickDelete.
2. In theDelete Reason confirmation box,

clickYes.

Result Changes youmake to the available reasons apply to all departments.

Modify a reason list

Reason lists are used when you define action and return reasons in document deficiency and pointer task
templates. Tomodify an reason list for a task template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Digital Signatures.
3. In the right pane, on theReason Lists tab, perform one of the following actions, depending on the

situation.
4. Select the reason list and click Modify.
5. In theReason List dialog box, on theGeneral tab, change the name or description.
6. To enable or disable the list, clear or select the Is active check box.
7. On the List Members tab, in theSelected list, add, remove, or rearrange reasons.
8. Click OK.

Manage a reason list for a task template

Reason lists are used when you define action and return reasons in document deficiency and pointer task
templates. To create, modify, or delete a reason list for a task template, complete one of the following
procedures.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Tasks.
3. In the right pane, on theReason Lists tab, do one of the following actions, depending on the situation:

Situation Steps

Create a reason list 1. ClickNew.
2. In theReason List dialog box, on the

General tab, type a name and optional
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Situation Steps

description.
3. Verify that the Is active check box is

selected to make the list available for
assignment.

4. On the List Members tab, add, remove, or
rearrange reasons.

5. ClickOK.

Modify a reason list 1. ClickModify.
2. In theReason List dialog box, on the

General tab, modify the name or optional
description.

3. To enable or disable the reason list, clear or
select the Is active check box.

4. On the List Members tab, add, remove, or
rearrange reasons.

5. ClickOK.

Delete a reason list 1. ClickDelete.
2. In theDelete Reason List confirmation

box, clickYes.

Manage action reason lists for a signature required task template

To create, modify, or delete an action reason list for a signature-required task template, complete the following
steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, underSelect Department, select Cross Department Settings from the list.
3. In the left pane, click Digital Signatures.
4. In the right pane, on theReason Lists tab, perform one of the following actions, depending on the

situation.

Situation Steps

Create a reason list 1. ClickNew.
2. In theReason List dialog box, on the

General tab, type a name and optional
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Situation Steps

description.
3. Verify that the Is active check box is

selected to make the list available for
assignment.

4. Optional. On the List Members tab, in the
Available list, create, modify, or delete
reasons.

5. On the List Members tab, in the Selected
list, add, remove, or rearrange reasons.

6. ClickOK.

Modify a reason list 1. ClickModify.
2. In theReason List dialog box, on the

General tab, change the name or
description.

3. To enable or disable the list, clear or select
the Is active check box.

4. Optional. On the List Members tab, in the
Available list, create, modify, or delete
reasons.

5. On the List Members tab, in the Selected
list, add, remove, or rearrange reasons.

6. ClickOK.

Delete a reason list 1. Select a reason list and clickDelete.
2. In theDelete Reason List confirmation

box, clickYes.

Workflow
About administering workflow processes
Perceptive Content Workflow lets you automate business processes and create review checkpoints.

After you have saved a document, the document can be routed through any number of queues, whichmight
represent different departments or different desks within a department.

You enterWorkflow Designer to create or modify workflow processes. Other workflow administration tasks
are done throughManagement Console, such as deleting workflow processes, assigning workflow privileges,
and handling reason lists.
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Create a workflow process
A workflow process contains a series of tasks and rules reflecting the review path a workflow itemmust take
in order to meet the sign off and approval requirements of your work group. To create a workflow process,
complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
3. In the right pane, on theWorkflow tab, click New.
4. In theAdd Process dialog box, type a name and an optional description.

The description appears in the ToolTip for the process.
5. Click OK.
Next Create queues, routes, and rules to define the components in your new workflow process inWorkflow
Designer.

Modify a workflow process
Tomodify a workflow process, complete the following steps.

Prerequisite All other users must close the process.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
3. In the right pane, on theWorkflow tab, select a process and then click Modify.
4. When you are finishedmodifying your workflow process, closeWorkflow Designer.

Rename aworkflow process
To change the name of a workflow process, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
3. In the right pane, on theWorkflow tab, select a process and then click Rename.
4. Enter a new name for your process.

Delete a workflow process
To delete a workflow process and remove all workflow items in its associated queues from workflow,
complete the following steps.

Prerequisite All users must close the process before it can be deleted.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.
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2. In the left pane, clickWorkflow.
3. On theWorkflow tab, select a process and then click Delete.
4. In theDelete Process confirmation box, to remove items from the queues in this process and then

delete the process, select theRemove all items from workflow and then delete this process
check box and then click Yes.

Reasons

What is a reason list?

Reason lists provide users the ability to indicate why they are putting a workflow item on hold.

When putting an item on hold in a workflow queue, users are prompted to select a reason from a reason list.
As manager of a workflow process, you control the contents of every OnHold reason list. You can define a
reason list as part of a workflow queue's properties.

Add a reason list for putting an item on hold

When putting an item on hold in a workflow queue, the user must select the reason for the change from a
reason list. To create and edit a reason list, complete the following steps.

1. Complete one of the following actions, depending on the situation.

Situation Steps

Create a hold reason list in Perceptive Content 1. In Management Console, in the left pane,
under Select Department, select a
department from the list.

2. In the left pane, clickWorkflow.
3. On theReason Lists tab, clickNew.

Create a hold reason list inWorkflow Designer 1. InWorkflow Designer, double-click the
queue.

2. In theQueue Properties dialog box, click
Reasons > New.

2. In theReason List dialog box, type a name and optional description for the reason list and then leave
the Is active check box selected.

3. On the List Members tab, add, remove, and rearrange reasons as necessary.
4. Click OK.
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Modify or rename a reason list for putting an item on hold

Reason lists are created to provide users with predefined reasons for putting workflow items on hold. To
modify a reason list for putting an item on hold, complete the following steps.

1. Complete one of the following actions, depending on the situation.

Situation Steps

Modify a hold reason list inManagement
Console

1. InManagement Console, in the left pane,
under Select Department, select a
department from the list.

2. In the left pane, clickWorkflow.
3. Click theReason Lists tab.
4. Click the list you want to change and then

clickModify.

Modify a hold reason list inWorkflow Designer 1. Double-click the queue.
2. In theQueue Properties dialog box, click

Reasons in the left pane.
3. In the Select a reason list to use when

placing items On Hold in this queue list,
click the list you want to change and then
clickModify.

2. In theReason List dialog box, on theGeneral tab, change the name and description if necessary.

Note: You cannot change the name of a system list (Apply Signature, Void/Expire Digital ID, or Void
Signature).

3. Tomake the reason list inactive, clear the Is active check box.

Note: You cannot disable a system list.

4. In the List Members tab, add, remove, or rearrange reasons.
5. Click OK.

Delete a reason list for putting an item on hold

To delete a reason list for putting an item on hold, complete the following steps.

You cannot remove a system list (Apply Signature, Void/Expire Digital ID, or Void Signature).

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
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3. Click theReason Lists tab.
4. Click the reason list you want to delete and then click Delete.

Output Profiles
What is an output profile?
An output profile allows you to save output packaging configuration settings for reuse.

After you create an output profile, the system automatically sets the settings each time you select an output
method and an associated profile. You can create, modify, and delete output profiles for all four output
methods: email, fax, file, and print.

Although output packaging can handle large and complex output jobs, it is a client-side process designed for
smaller, ad-hoc output jobs. Outputting a large jobmay take several minutes to complete. The system notifies
you when the process starts and ends. Until then, you can continue to work in Perceptive Content.

For large and complex output jobs, consider using Output Agent, a server-side process that allows you to
output items on a job-by-job basis or in a batch.

Create an email output profile overview
To create an output profile users can specify when emailing items, complete the following sequence of
procedures.

1. Create an output profile.
2. Add a user or group to an output profile.
3. If emailing attachments, complete one of the following procedures.

l Output items as a single PDF
l Output item as amulti-page TIFF

4. If emailing attachments: Define output content settings.
5. Activate an output profile.

Create a fax output profile overview
To create a fax output profile, complete the following sequence of procedures.

1. Create an output profile.
2. Add a user or group to an output profile.
3. Define fax settings for an output profile.
4. Define output content settings.
5. Define document type output order.

This procedure only applies to documents.
6. Activate an output profile.
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Create a file output profile overview
To create an output profile that allows users to export items to a file, complete the following sequence of
procedures.

1. Create an output profile.
2. Add a user or group to an output profile.
3. Define file settings for an output profile.
4. Perform one of the following content options.

l Output items as individual files.
l Output item as amultipage tiff
l Output items as a single PDF.

5. Optional. Create a folder hierarchy for output files.
6. Define output content settings.
7. Define document type output order.

This procedure applies only to documents.
8. Activate an output profile.

Create a print output profile overview
To create a print output profile users can select when printing items, complete the following sequence of
procedures.

1. Create an output profile.
2. Add a user or group to an output profile.
3. Define output content settings.
4. Define document type output order.

Note: This procedure applies only to documents.

5. Activate an output profile.

Define page rotation for printing
To define whether the system automatically rotates a page image when the page orientation does not match
the printer sheet orientation, complete the following steps.

1. In the imagenow.ini file under [Printer], for the printer.rotate.to.best.fit setting, type one of the
following options.
l TRUE to rotate page images tomatch printer sheet orientation.
l FALSE to maintain the page image during printing.
The default setting is FALSE.

2. Save and close the file.
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Copy an output profile
To copy an output profile, complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.
2. In the right pane, click the appropriate output method tab.
3. Select the output profile and then click Copy.
4. In theOutput Profile dialog box, in theName field, type a name for the new profile, and then click OK.

Delete an output profile
To delete an output profile, complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.
2. In the right, click the appropriate output method tab.
3. Select the output profile and then click Delete.
4. In the confirmation prompt, click Yes.

Modify an output profile
Tomodify settings of an output profile, complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.
2. In the right pane, click the appropriate output method tab.
3. Select the profile and then click Modify.
4. Modify the output profile settings.
5. Click OK.

Rename an output profile
To rename an output profile, complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.
2. In the right pane, click the appropriate output method tab.
3. Select the output profile and then click Rename.
4. Type the new name of your output profile and press ENTER.

Activate an output profile
To activate an output profile that can be selected when printing, emailing, exporting, or faxing an item,
complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.
2. In the right pane, click the output method tab, select the output profile, and click Modify.
3. On theGeneral tab, select Is active.
4. Click OK.
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Define email settings for an output profile
To define the settings to use when emailing an item, complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.
2. In the right pane, click theEmail tab, select the output profile, and click Modify.
3. On theOutput tab, forEmail, perform one of the following actions.

l Type the email address where you want to send the output file.
l Leave the box empty to select the email address from the address book of your email client.

4. In theMethod list, select amethod for sending the email.
5. If you select Attachment, underAnnotations, for Include, select one of the following options.

l Annotations to output the item with annotations.
l No annotations to output the item without annotations.
l Current view to output the current view of the item.

6. Click OK.

Define fax settings for an output profile
To define the fax number and cover page information to use when exporting an item to fax using an output
profile, complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.
2. In the right pane, on the Fax tab, select the output profile you want to modify, and click Modify.
3. In theOutput Profile dialog box, on theOutput tab, underGeneral, perform one of the following

options.
l If you have added fax numbers to your address book, select the number from the Fax Number list.
l If you are using a number that is not in your address book, enter the fax number to where you want
to send the item.

4. UnderCover Page, perform any of the following actions to add content to the fax cover page.
l In theAttention box, type the name of the recipient of the fax.
l In theComments box, type any additional information you want to include with the fax.

5. UnderAnnotations, for Include, select one of the following options.
l Annotations to output the item with annotations.
l Current view to output the current view of the item.
l No annotations to output the item without annotations.

6. Click OK.

Define file settings for an output profile
To define the file format and location when exporting items to a file using an output profile, complete the
following steps.

1. InManagement Console, in the left pane, click Output Profiles.
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2. In the right pane, on the File tab, select the output profile you want to modify, and click Modify.
3. In theOutput Profile dialog box, on theOutput tab, for Format, select an output format.
4. To set the output directory, next to Location, click Browse and choose a location to store the output

files.

Note:
Youmust set a location. If you do not set one, the system prompts you with an error each time you try
to use the profile.

5. UnderAnnotations, for Include, select one of the following options.
l Annotations to output the item with annotations.
l Current view to output the current view of the item.
l No annotations to output the item without annotations.

6. Click OK.

Output file name variables
The following topic lists the variable text you can use when generating a custom file name to email an item as
an attachment or export an item to a file.

Note:
You can only use these variables with themulti-page TIFF and Individual file export formats. The Single PDF
file export does not support using these variables.

Guidelines

When entering variables, separate text with underscores and enclose variables with square brackets. The
entire file path, which includes the file name and extension, cannot exceed the character limit of your
operating system.

Variables

Variable Description Example

[DOCID] The item ID Document_[DOCID]

[DRAWER] The item drawer value [DOCID]_Account_[DRAWER]

[FIELD1] The item Field1 value [DOCID]_Account_[FIELD1]

[FIELD2] The item Field2 value [DOCID]_Patient_[FIELD2]
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Variable Description Example

[FIELD3] The item Field3 value [DOCID]_Invoice_[FIELD3]

[FIELD4] The item Field4 value [DOCID]_Student_[FIELD4]

[FIELD5] The item Field5 value [DOCID]_Program_[FIELD5]

[DOCTYPE] The item type [DOCTYPE]_[DOCID]

Manage digital signatures
What is a digital signature?

A digital signature is an electronic certification that represents the act of signing the document using the
Perceptive Content interface.

Digital signatures play an important role in moving processing from paper to electronic systems. A digital
signature is usually a cryptographic signature. Although you use digital signatures to electronically replace a
handwritten signature, they are not images of handwritten signatures. According to the E-SIGN Act of 2000,
digital signatures are legally binding as long as they meet the provisions outlined in the laws governing their
use.

Digital signatures provide four benefits for documents:

l Authenticity, which provides proof of the identity of the individual who signs a document.
l Data integrity, which ensures that the document has not been altered by a third-party.
l Non-repudiation, which prevents the signer of a document from later denying association with that
document.

l Confidentiality, which ensures that data is only readable to the sender and the intended recipient,
providing protection from third party snooping.

Digital signature functionality is separately purchased and licensed as part of the Document Control Suite.
Digitally signing a document requires that it be checked in to version control. Once signed, the document is
made secure from alterations to the signed version. Signing a document entails entering a password,
selecting a reason for the signature, and optionally placing one or more visual representations of the signature
on the document. Perceptive Content automatically generates a Digital ID for the signing user if none exists.
Otherwise, it uses the existing Digital ID to encrypt the digital signature.

After a document has been digitally signed, any user who can access the document can verify the signature.
When a document is opened, the signature is automatically authenticated against the stored hash value of the
document that was generated at the time of signing. Verifying a digitally signed document recalculates the
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document hash value and compares it with the signature to get real-time status. If the recalculated hash value
matches the signature, the signature is validated; if the hash value does not match the signature (which could
indicate tampering with the document outside of Perceptive Content), the signature is marked invalid.

A document can havemultiple valid signatures by a signer, and you can place as many visual representations
of your signature on the document as you like. However, visual representations are only supported on images
on which annotations are supported (TIFF, JPEG, and BMP).

Digital signature status indicators
Any document that contains a digital signature, either in its current version or in a previous version, is
accompanied by a status indicator in the search results grid in the Digitally Signed column. If your view does
not show this column, you can temporarily display it by clicking the Columns button and selecting the
Signature Status check box, or you can add the column in a private filter.

Status indicators

Status
Indicator

Label Description

[No icon] none The document has not been signed.

Valid This signature has been validated.

Invalid This signature is no longer valid because the document has been corrupted or
compromised by changesmade outside of Perceptive Content. To determine
whether any signature is invalid, Perceptive Content verifies all signatures on a
document when the user opens it or verifies signaturesmanually or automatically.

Voided This signature has been voided either because the signer has voided the
signature or because a user with the Void Signature privilege has voided the
signature.

Previously
Signed

Previous versions of this document are signed.

Documents with multiple signatures
If a document contains multiple signatures, only one icon appears, according to the following precedence
rules:

l If any signature in the list is invalid, the invalid icon is shown.
l If the document contains a at least one valid signature and no invalid signatures, the valid icon is shown.
l If the document contains only voided signatures, the voided icon is shown.
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Additional signature locations
The indicators also appear in the following locations:

l At the right end of the Viewer status bar
l In the Properties pane of the Viewer
l In a representation on the document (if the file type of the document permits annotations)

Digital Signature Settings
Set password entry frequency
To set the time elapsed before a user is prompted to enter his digital signature password again, complete the
following steps.

1. InManagement Console, in the left pane, click Digital Signatures.
2. On theDigital Signatures tab, underSigning Password, in the list, select how often users must enter

a password when signing documents.

Set digital signature time out
The time-out feature requires a user who digitally signed a document, but who did not log out before the
specified time out value, to re-enter his or her digital signature password. The time out applies globally to all
digital signatures. To set digital signature time out, complete the following steps.

1. InManagement Console, in the left pane, click Digital Signatures.
2. On theDigital Signatures tab, underSigning Password, set thePrompt user to enter password

option toOnce per session.
3. In thePassword time out list, select the amount of time to elapse between the last digital signature

activity and timing out (which requires the user to re-enter his or her digital signature password).

Note: The timeout value can range from Never (the default) to specific time values up to 60minutes.

4. Repeat the previous step for the password time out list, which can have a different value.

Append signature reports to printed or exported documents
To include a digital signature report whenever signed documents are printed or exported, complete the
following steps.

These options apply globally to all digital signatures. These reports are printed only when a document is
printed in its entirety.

1. InManagement Console, in the left pane, click Digital Signatures.
2. On theDigital Signatures tab, underDigital Signature Report, select the Include a Digital

Signature report for all signed documents check box to causePerceptive Content to print a report
whenever a user prints or exports a signed version of a document.
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Note: You can also clear the check box to disable this option. When this check box is cleared, no
report is printed.

3. In the For each report display list, select a display option for the reports.

Automatically verify signatures
You can apply automatic verification of signatures to all documents that have a common drawer or document
type. To activate automatic verification of signatures, complete the following steps.

Applying this setting to a large number of documents can occasionally slow performance of ImageNow
Server.

1. Depending on which category of documents you want to affect, inManagement Console, in the left
pane, click Drawers orDocument Types.

2. In the right pane, click the drawer or document type for which signatures will be automatically verified,
and then click Modify.

3. Do one of the following actions:
l In theDrawer dialog box, on theDigital Signatures tab, select theAutomatically verify
signatures for this drawer check box.

l In theDocument Type dialog box, on theDigital Signatures tab, select theAutomatically
verify signatures for this document type check box.

4. To specify how often the signatures are verified, in theVerification interval boxes, select the number
and time unit and then click OK.

5. Optional. Repeat this procedure for any additional drawers or document types to which automatic
signature verificationmust be applied.

Associate a digital signature with a task
To associate a digital signature with a task, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Tasks.
3. On the Templates tab, in theSelect a task type list, select Signature required on document.

Note: You can associate a digital signature only with tasks that have a task type of Signature
required on document.

4. Select the task with which you want to associate a digital signature and then click Modify.
5. In theSignature Required on Document Task dialog box, in the left pane, click Reasons.
6. In the right pane, underAction Reasons, select the reason list to present to the user in the action

reasons of the task.
7. In the right pane, underReturn Reasons, select the reason list to present to the user in the return

reasons of the task.
8. Click OK.
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Void a digital signature
To void a digital signature applied to a document by yourself or another user, complete the following steps.

1. Open the document.
2. If theProperties pane is not visible, click View > Digital Signatures.
3. In theDigital Signatures pane, double-click the row that contains the digital signature you want to

void.
4. In theDigital Signature dialog box, click Void, select a reason for voiding the digital signature, and

then click Close.

Digital IDs
Set Digital ID expiration period
This procedure applies globally to all Digital IDs. To set the number of days before a Digital ID automatically
expires, complete the following steps.

1. InManagement Console, in the left pane, click Digital Signatures.
2. On theDigital Signatures tab, underDigital ID Expiration, in theExpire list, select the default

expiration period.
3. If you selectedCustom interval after creation date, in the Interval box, type or select the number of

days for the expiration period.

Expire a Digital ID
Expiring a Digital ID enables a user to create another Digital ID and re-enter password information. To expire a
Digital ID, complete the following steps.

1. InManagement Console, in the left pane, click Users.
2. In the right pane, on theUser Profiles tab, search for the user you want and click Modify.
3. In theModify User Profile dialog box, complete the following substeps:

1. On theDigital ID tab, select the Digital ID you want to expire.
2. Click Expire.

4. In theExpire Digital ID dialog box, complete the following substeps:
1. In theDate list, select the date on which tomake the expiration effective.
2. In theReason list, select the reason for expiring the Digital ID.
3. Click OK.

5. In theModify User Profile dialog box, click OK.
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Void a Digital ID
Voiding a Digital ID voids all signatures associated with that ID. If you only want to allow a user to create
another Digital ID and re-enter password information, expire the Digital ID instead. To void a digital ID,
complete the following steps.

Depending on the number of signatures previously created with the Digital ID that you void, and the size of the
document images, ImageNow Server might require a long period of time to process the request.

1. InManagement Console, in the left pane, click Users.
2. In the right pane, on theUser Profiles tab, search for the user you want and click Modify.
3. In theModify User Profile dialog box, complete the following substeps.

1. On theDigital ID tab, select the Digital ID you want to void.
2. Click Void.

4. In theVoid Digital ID dialog box, complete the following substeps.
1. In theReason list, select the reason for voiding the Digital ID.
2. Click OK.

5. In theModify User Profile dialog box, click OK.

Reason Lists
Add a reason list for digital signatures
When completing a signature-required task, users must select the reason for using the signature from a
reason list. To create and edit a digital signature's reason list, complete the following steps.

Changes youmake to reason lists used for applying a signature, voiding a signature, or voiding or expiring a
Digital ID must be performed within the existing system reason lists.

1. InManagement Console, in the left pane, click Digital Signatures.
2. In theReason Lists tab, click New.
3. In theReason List dialog box, type the name and optional description for the reason list, and then

ensure that the Is active check box selected.
4. In theList Members tab, add one or more reasons to the new list and rearrange their order as

necessary:
l To add a reason to the list, click it in the upper list and then click Add.
l To remove a reason from the list, click in the lower list and then click Remove.
l To change the position of a reason in the list, click it in the lower list and then click Move Up or
Move Down.

5. Click OK.
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Modify or rename a reason list for a digital signature
Tomodify reasons that are displayed when a user signs a document, voids a document, or voids a Digital ID,
complete the following steps.

You cannot modify, rename, or hide a system list.

1. InManagement Console, in the left pane, click Digital Signatures.
2. Click theReason Lists tab.
3. Click the list you want to change and then click Modify.
4. In theReason List dialog box, in theGeneral tab, change the name and description if necessary.
5. To hide the reason list from the user, clear the Is active check box.

Note: You cannot hide a system list.

6. In the List Members tab, do one or more of the following:
l To add a reason to the list, click it in the upper list and then click Add.
l To remove a reason from the list, click in the lower list and then click Remove.
l To change the position of a reason in the list, click it in the lower list and then click Move Up or
Move Down.

7. Click OK.

Delete a reason list for digital signatures
To delete a reason list for digital signatures, complete the following steps.

You cannot remove a system list (Apply Signature, Void/Expire Digital ID, or Void Signature).

1. InManagement Console, in the left pane, click Digital Signatures.
2. Click theReason Lists tab.
3. Click the reason list you want to delete and then click Delete.

Manage annotations
What is an annotation template?

***Annotation templates allow users to add standardized annotations to an item.

Users can annotate an item without affecting the original image. Each annotation requires an annotation
template.

You specify the security options based on the template. In the annotation template, you can grant users or
groups the privilege to create, delete, hide, modify and view specific annotation templates.
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For example, you can create a Stamp template with the following text: Received by Accounts Payable. You
can set the template security so that only users in the Accounts Payable group can use, modify, or delete
annotations created using that Stamp template. If you do not grant users in the HumanResources access to
view stamps created using that stamp template, those users cannot view, modify, or delete this annotation.

You can remove an annotation template from theManagement Console list displayed to users without
deleting the template completely. You can also remove (without deleting) an annotation type such as check,
stamp, or line from the Annotation toolbar.

File formats for annotations and redactions
The following table shows the file formats you can annotate and redact using Perceptive Content.

Format Annotate Redact

BMP (24 bit, or lower) Yes Yes

GIF No No

JPG Yes Yes

Microsoft Office documents No No

PNG No No

TIFF Yes Yes

LZW No No

You can also annotate any file type outside of Perceptive Content. To do this, make sure the file is in version
control and then open the file, right-click the thumbnail, and select Launch Associated Application.

You can also annotate TIFF images using an external application. TIFF format is not standardized, however,
so different applications might modify the baseline tags and prevent the externally-annotated TIFF file from
being viewed in the ImageNowViewer or as thumbnails.

Stamp annotation codes
You can insert the following predetermined codes in a stamp or text annotation to represent current time,
dates, and user attributes. For example, the default code "% m/%d/%y" displays the current date
(month/day/year).

The following codes are available:
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Code Description Example

%% Percent sign %

%a Abbreviated weekday name FRI

%A Full weekday name FRIDAY

%b Abbreviated month name OCT

%B Full month name OCTOBER

%c Date and time representation
appropriate for locale

10/18/01 10:15:45

%d Day of month as decimal number
(01-31)

18

%H Hour in 24-hour format (00-23) 22

%I Hour in 12-hour format (01-12) 10

%j Day of year as decimal number
(001-366)

245

%M Minute as decimal number (00-
59)

02

%m Month as decimal number (00-12) 05

%m/%d/%y Mm/ dd/ yy 10/18/01

%m/%d/%Y Mm/ dd/ yyyy 10/18/2001

%p Current locales AM/PM indicator
for 12-hour clock

AM

%S Second as decimal number (00-
59)

45

%U Week of year as decimal number,
with Sunday as first date of week
(00-51)

19
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Code Description Example

%W Week of year as decimal number,
with Monday as first date of week
(00-51)

20

%w Weekday as decimal number (0-
6; Sunday is 0)

5

%x Date representation for current
locale

10/18/01

d

%X

Time representation for current
locale

10:15:45

%Y Year with century, as decimal
number

2001

%y Year without century, as decimal
number (00-99)

01

%z or %Z Time-zone name; no characters if
time zone is unknown

CENTRAL STANDARD TIME

<user.d> User description plan assessment coord

<user.e> User e-mail Bwhite@conacm.xyz

<user.eid> An identifier that logs the user in
to a separate system, such as a
business application

bwhite77

<user.f> User fax number 999-000-0000

<user.fn> User first name bob

<user.l> User location san rafael

<user.ln> User last name white

<user.m> User mobile number 999-000-0000

<user.o> User organization consolidated acme
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Code Description Example

<user.ou> User organizational unit budgeting & Planning

<user.p> User prefix Dr.

<user.pa> User pager number 999-000-0000

<user.ph> User phone number 999-000-0000

<user.s> User suffix esq.

<user.t> User title vice president Planning

<user> User name BobWhite

Create annotation templates
Create an arrow annotation template
To create an arrow annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation type box, select Arrow and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. In theArrow Annotation dialog box, to define the arrow template properties, perform the following
steps.
1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the arrow template, in theArrow Annotation dialog box, perform the
following steps.
1. In the left pane, select Appearance.
2. In Line Weight, select the width of the arrow line.
3. In Line Color, select a line color.

Note:When you select Automatic Colorwhenmodifying an annotation instance or creating an
annotation template, the system applies black to the color property beingmodified.
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6. To add security to the arrow template, in theArrow Annotation dialog box, in the left pane, select
Security.

7. UnderUsers and Groups, click Add.
8. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

9. In theArrow Annotation dialog box, underUsers and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

10. Click OK.

Create a check annotation template
To create a check annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation type list, select Check and then click New.
2. In the selected row underName, type a name for the template then press Enter.
3. Select the template and then click Modify.

4. To define the check template properties, in theCheck Annotation dialog box, perform the following
steps.
1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the check template, in theCheck Annotation dialog box, perform the
following steps.
1. In the left pane, select Appearance.
2. In Line Color, select a line color.

Note:When you select Automatic Colorwhenmodifying an annotation instance or creating an
annotation template, the system applies black to the color property beingmodified.

6. To add security to the check template, in theCheck Annotation dialog box, in the left pane, select
Security.

7. Under Users and Groups, click Add.
8. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
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3. Add as many users or groups as necessary.
4. Click OK.

9. In theCheck Annotation dialog box, under Users and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

10. Click OK.

Create a highlight annotation template
To create a highlight annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps:

1. In theSelect an Annotation type box, select Highlight and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the highlight template properties, in theHighlight Annotation dialog box, perform the
following steps.
1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the highlight template, in theHighlight Annotation dialog box, perform
the following steps.
1. In the left pane, select Appearance.
2. In Fill Color, select the highlight color.

6. To add security to the highlight template, in the Highlight Annotation dialog box, in the left pane,
select Security.

7. UnderUsers and Groups, click Add.
8. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

9. In the Highlight Annotation dialog box, underUsers and Groups, select the user or group you want
to assign privileges to and grant or deny the necessary privileges.

10. Click OK.

Create a line annotation template
To create a line annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
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list.
2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation type box, select Line and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the line template properties, in the Line Annotation dialog box, perform the following steps.
1. In the left pane, select Properties.
2. Optional. Supply aDescription for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the line template, in the Line Annotation dialog box, perform the
following steps.
1. In the left pane, select Appearance.
2. In Line Weight, select the width of the line.
3. In Line Color, select a line color.

Note:When you select Automatic Colorwhenmodifying an annotation instance or creating an
annotation template, the system applies black to the color property beingmodified.

6. To add security to the line template, in the Line Annotation dialog box, in the left pane, select
Security.

7. UnderUsers and Groups, click Add.
8. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

9. In the Line Annotation dialog box, underUsers/Groups, select the user or group you want to assign
privileges to and grant or deny the necessary privileges.

10. Click OK.

Create anOLE annotation template
To create anOLE annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation type box, select OLE and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
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3. Select the template and then click Modify.
4. To define the OLE template properties, in theOLE Annotation dialog box, perform the following steps.

1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To add security to the OLE template, in theOLE Annotation dialog box, in the left pane, select
Security.

6. UnderUsers and Groups, click Add.
7. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

8. In theOLE Annotation dialog box, underUsers and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

9. Click OK.

Create an oval annotation template
To create an oval annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation Type box, select Oval and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the oval template properties, in theOval Annotation dialog box, perform the following steps.
1. In the left pane, select Properties.
2. Optional. Supply a description for the oval template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the oval template, in theOval Annotation dialog box, perform the
following steps.
1. In the left pane, select Appearance.
2. In Line Weight, select the width of the oval s border.
3. In Line Color, select a line color for the oval s border.

Note:When you select Automatic Colorwhenmodifying an annotation instance or creating an
annotation template, the system applies black to the color property beingmodified.
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4. To fill the oval with color, remove the selection from No Fill and, in Fill Color, select a color.
5. To remove the fill color, select No Fill.

6. To add security to the template, in theOval Annotation dialog box, in the left pane, select Security.
7. UnderUsers and Groups, click Add.
8. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

9. In theOval Annotation dialog box, underUsers and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

10. Click OK.

Create a pen annotation template
To create a pen annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation Type box, select Pen and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the pen template properties, in thePen Annotation dialog box, perform the following steps:
1. In the left pane, select Properties.
2. Optional. Supply aDescription for the annotation template
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the pen template, in thePen Annotation dialog box, perform the following
steps:
1. In the left pane, select Appearance.
2. In Line Weight, select the width of the line.
3. In Line Color, select a line color.

Note:When you select Automatic Colorwhenmodifying an annotation instance or creating an
annotation template, the system applies black to the color property beingmodified.

6. To add security to the pen template, in thePen Annotation dialog box, in the left pane, select
Security.

7. UnderUsers and Groups, click Add.
8. In theSelect User and Groups dialog box, perform the following steps.
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1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

9. In thePen Annotation dialog box, underUsers and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

10. Click OK.

Create a rectangle annotation template
To create a rectangle annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation Type box, select Rectangle and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the rectangle template properties, in theRectangle Annotation dialog box, perform the
following steps.
1. In the left pane, select Properties.
2. Optional. Supply aDescription for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the rectangle template, in theRectangle Annotation dialog box, perform
the following steps.
1. In the left pane, select Appearance.
2. In Line Weight, select the width of the rectangle's border.
3. In Line Color, select a line color for the border of the rectangle.

Note:When you select Automatic Colorwhenmodifying an annotation instance or creating an
annotation template, the system applies black to the color property beingmodified.

4. To fill the rectangle with color, remove the selection from No Fill and, in Fill Color, select a
color.

5. Optional. To remove the fill color, select No Fill.
6. To add security to the rectangle template, in theRectangle Annotation dialog box, in the left pane,

select Security.
7. Under Users and Groups, click Add.
8. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
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3. Add as many users or groups as necessary.
4. Click OK.

9. In theRectangle Annotation dialog box, underUsers and Groups, select the user or group you want
to assign privileges to and grant or deny the necessary privileges.

10. Click OK.

Create a redaction annotation template
To create a redaction annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation type box, select Redaction and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the redaction annotation template properties, in theRedaction Annotation dialog box,
perform the following steps.
1. In the left pane, select Properties.
2. Optional. Supply aDescription for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To change the appearance of the redaction template, in theRedaction Annotation dialog box, perform
the following steps.
1. In the left pane, select Appearance.
2. In Fill Color, select a color for the redaction area.

6. To add security to the redaction template, in theRedaction Annotation dialog box, in the left pane,
select Security.

7. Under Users and Groups, click Add.
8. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

9. In theRedaction Annotation dialog box, underUsers and Groups, select the user or group you want
to assign privileges to and grant or deny the necessary privileges.

10. Click OK.

Create a stamp annotation template
To create a stamp annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the



Manage Documents User Guide

208

list.
2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation Type box, select Stamp and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the stamp annotation template properties, in theStamp Annotation dialog box, perform the
following steps.
1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To add text to the stamp template, in theStamp Annotation dialog box, perform the following steps.
1. In the left pane, select Content.
2. Click Text, and then type the text you want in the field.
3. To insert a time or user code in the text, click the insertion point in the field and then click Insert.
4. In the Insert Date/Time/User Code dialog box, select a code to add and then click Insert.
5. Optional. To display the current date and time for this stamp type instead of when the stampwas

created, select Enable dynamic code values.
6. To add a picture to the stamp template, in theStamp Annotation dialog box, perform the following

steps.
1. In the left pane, select Content.
2. Click Picture, and then click Browse.
3. In theStamp Annotation Picture dialog box, navigate to the picture and then click Open.

7. To change the shape of the stamp template, in theStamp Annotation dialog box, perform the following
steps.
1. If you selected text content, in the left pane, select Appearance.
2. In Frame, select the type of frame you want.
3. If you select Rounded Rectangle, inRoundness, click a number that represents the shape of

the corners, the lower the number produces squarer corners and the higher the number produces
more curved corners.

4. InMargins, select a number representing themargin surrounding the text.
5. For the border, in Line Weight, select the width of the border line, and in Line Color, select a

color.
6. To fill the stampwith color, remove the selection from No Fill and, in Fill Color, select a color.
7. To remove the fill color, select No Fill.

8. To change the font, in theStamp Annotation dialog box, perform the following steps.
1. If you selected text content, in the left pane, select Appearance.
2. In Face, select a typeface.
3. InStyle, select B for bold, I for italic, U for underline, orS for strikeout text.
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4. InSize, choose the font size.
5. InAlignment, select the type of alignment you need for the text.
6. InColor, select the text color.

9. To add security to the stamp template, in theStamp Annotation dialog box, in the left pane, select
Security.

10. UnderUsers and Groups, click Add.
11. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

12. In theStamp Annotation dialog box, underUsers and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

13. Click OK.

Create a sticky note annotation template
To create a sticky note annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation Type box, select Sticky Note and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the sticky note template properties, in theSticky Note Annotation dialog box, perform the
following steps.
1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To add security to the check template, in theCheck Annotation dialog box, in the left pane, select
Security.

6. UnderUsers and Groups, click Add.
7. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.

8. In theSticky Note Annotation dialog box, underUsers and Groups, select the user or group you
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want to assign privileges to and grant or deny the necessary privileges.
9. Click OK.

Create a text annotation template
To create a text annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation type box, select Text and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. To define the text template properties, in theText Annotation dialog box, perform the following steps:
1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To add content to the text template, in the Text Annotation dialog box, perform the following steps.
1. In the left pane, select Content.
2. Optional. InEnter text, type the text you want in the field.
3. To insert a time or user code in the text, click the insertion point in the field and click Insert.
4. In the Insert Date/Time/User Code dialog box, select a code to add and then click Insert.

6. To change the appearance of the text template, in the Text Annotation dialog box, perform the
following steps.
1. If you selected text content, in the left pane, select Appearance.
2. In Face, select a typeface.
3. InStyle, select B for bold, I for italic, U for underline, orS for strikeout text.
4. InSize, choose the font size.
5. InAlignment, select the type of alignment you need for the text.
6. InColor, select the text color.

Note:When you select Automatic Colorwhenmodifying an annotation instance or creating an
annotation template, the system applies black to the color property beingmodified.

7. To add security to the text template, in the left pane, select Security.
8. UnderUsers and Groups, click Add.
9. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
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3. Add as many users or groups as necessary.
4. Click OK.

10. In the Text Annotation dialog box, underUsers and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

11. Click OK.

Create a URL annotation template
To create a URL annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation type box, select URL and then click New.
2. In the selected row underName, type a name for the template and then press ENTER.
3. Select the template and then click Modify.

4. In theURL Annotation dialog box, to define the URL template properties, perform the following steps.
1. In the left pane, select Properties.
2. Optional. Supply a description for the annotation template.
3. UnderOptions, verify that Is Active is selected so that it appears on theAnnotations toolbar.

5. To add content to the URL template, in theURL Annotation dialog box, perform the following steps.
1. In the left pane, select Content.
2. Optional. InAddress, type the web address of the URL to open when a user selects the URL.
3. Optional. In Text to Display, type the text you want to appear on the item to identify the URL.

If you leave any of these fields blank, Perceptive Content prompts for themissing information
when the user adds the annotation.

6. To change the appearance of the URL template, in theURL Annotation dialog box, perform the
following steps.
1. If you selected text content, in the left pane, select Appearance.
2. In Face, select a typeface.
3. InSize, choose the font size.
4. InColor, select the text color.

7. To add security to the text template, in the URL Annotation dialog box, in the left pane, select
Security.

8. UnderUsers and Groups, click Add.
9. In theSelect Users and Groups dialog box, perform the following steps.

1. To add a user, on theUsers tab, search for and select a user and click Add.
2. To add a group, on theGroups tab, search for and select a group and click Add.
3. Add as many users or groups as necessary.
4. Click OK.
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10. In theURL Annotation dialog box, underUsers and Groups, select the user or group you want to
assign privileges to and grant or deny the necessary privileges.

11. Click OK.

Modify annotation templates
Hide an annotation type
When youmake all annotation templates of a specific type such as check, stamp, or line inactive, that
annotation type no longer appears on the toolbar in the viewer. If you later create new templates of the type
that was hidden, the type is restored on the toolbar. To hide an annotation type, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, in theSelect an Annotation type box, select the annotation type you want to hide.
4. Under Templates, select the annotation template and then click Modify.
5. In the <Annotation Type> Annotation dialog box, in the left pane, select Properties.
6. In the right pane, underOptions, clear the Is Active check box and then click OK.
7. Repeat the previous steps for all the annotation templates of the type you want to hide.

Delete an annotation template
You can remove an annotation template only if an annotation of that type does not exist. If an annotation of
that type does exist, you cannot remove the annotation template but you canmark it as not active. To delete
an annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, in Select an Annotation type box, select the appropriate type for the annotation you

want to remove.
4. Under Templates, select an annotation template and then click Delete.
5. Click Yes.

Disable an annotation template
When youmake an annotation template inactive, it no longer appears as a selection for that annotation type
such as check, stamp, or line in the viewer. To inactivate an annotation template, complete the following
steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, in theSelect an Annotation type box, select the appropriate type for the annotation

template you want to make inactive.



Manage Documents User Guide

213

4. Under Templates, select the annotation you want to make inactive and then click Modify.
5. In the <Annotation Type> Annotation dialog box, in the left pane, select Properties.
6. In the right pane, underOptions, clear the Is Active check box.
7. Click OK.

Modify an annotation template
Tomodify an annotation template, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, perform the following steps.

1. In theSelect an Annotation Type box, select the annotation type you want to modify.
2. Under Templates, select the template and then click Modify.

4. Tomodify the template properties, in the <Annotation Type> Annotation dialog box, in the right pane,
underGeneral, perform the following steps.
1. In the left pane, select Properties andmodify the annotation template properties.
2. Modify the name and description as needed.

5. Tomodify the template appearance, in the <Annotation Type> Annotation dialog box, in the right
pane, under General, perform the following steps.
1. In the left pane, select Appearance andmodify the annotation template appearance properties.

Note:When you select Automatic Colorwhenmodifying an annotation template, the system
applies black to the color property beingmodified.

6. In the right pane, underOptions, perform one of the following actions:
l Tomake the template available through theAnnotations toolbar, select the Is Active check box.
l Tomake the template inactive and remove it from theAnnotations toolbar, clear the Is Active
check box.

7. If Content appears in the left pane, select Content andmodify the content as needed.
8. Click OK.

Show inactive annotation templates
***To show inactive annotation templates, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, click Annotations.
3. In the right pane, select theShow Inactive Templates check box.

All inactive templates appear.
4. Modify the inactive templates as needed.
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Manage views
About administering views

As a department manager, you create views that display only the content with which your users need to work.

By tailoring your user's view to only the items they need to see, you simplify their user experience. While the
systemmay contain hundreds or thousands of items and other types of content, your users see only the
subset of items that you enable in their view. Views enable you to add another layer of protection to content.
In addition to the access privileges set for drawers, file plans, and item types, your users can see the item
within a particular drawer, file plan, or type that satisfies the view definition.

You can also use a view to create a report if you have Business Insight installed in your environment.

To view records functionality, youmust install a Records Manager license.

About administering related views
A user can display one or more related views from a viewer in Perceptive Content. When the user selects a
related view to apply to the active document or folder, the Related Documents or Related Folders pane
displays other items that match the items with respect to the conditions you define for the related view.

Users with document or folder view management privileges can create, rename, and delete related views in
Perceptive Content. When youmodify a related view, you automatically enter Perceptive Content View
Designer, where you can create or modify relationship conditions, activate the view, and assign security
settings to it.

Suppose, for example, you view a student information document with a Field2 value that contains the
student's ID number. You want to see all the other documents with the same Field2 value. You can create the
condition for this relationship, and the Related Documents pane displays any other documents that have a
Field2 value that match the student ID number in the active document. 

As another example, suppose you view an inventory document with a custom property that contains a check
number. Another set of business documents contains a check number in Field3 rather than in a custom
property. You want to see all documents with a Field3 value that matches the Check Number custom property
in the active document. You can create the conditions for this relationship, and the Related Documents pane
displays any other documents that have a Field3 value that matches the Check Number custom property in
the active document.

For folders, related views are like related views for documents except that the relationship matches on folder
properties. For example, suppose you work at a hospital and your Perceptive Content environment is set up
so that each time a patient visits the hospital, a new folder is created. The new folder contains all documents
related to that visit. If a patient makes a return visit, that patient will have two folders created, one for each
visit. You view a recent patient's visit and realize you need to see all other folders from past visits. You can
create the conditions for this relationship, view all folders that correspond to the patient's identification code,
and open any folders that you need to view.
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Types of views
The following list summarizes views available in Perceptive Content, including views created by you, your
view manager, and views created automatically by the Perceptive Content system.

Application Plan
An application plan view returns a set of documents captured using a specific application plan. Application
plans that do not have a defined view action do not display results.

Modifiable components

View conditions

Column layout

View statistics

Sorting and grouping

Security considerations

Users with application planmanagement privileges canmodify application plan views, including view
actions and components, in Application Plan Designer.

Users with the View privilege for the application plan can run the view. For the active business
application plan screen, the view returns the associated results.

Batches
A batch view returns the batches in your Perceptive Content system. By default, batch users can see all
batches, batches that are ready for QA, and batches that are ready for linking.

Modifiable components

Column layout

Sorting and grouping

Document
A document view returns a set of documents. Document views appear in the Views pane under Documents.

Modifiable conditions

View name

View privileges

View conditions

Public filters

Private filters
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Column layout

View statistics

Sorting and grouping

Security considerations

Users with view access can run a document view.

File Plans
A file plan view returns a set of records within a particular record category or record folder. File plan views
appear in the Views pane under File Plans, and are organized according to the hierarchy of file plans, record
categories, and record folders in the system. When you select one of these items, Perceptive Content
retrieves the set of records within that item.

ImageNowExplorer uses the system-defined view and it cannot bemodified. You canmodify a view during a
viewing session, but you can t create and save filters or views for file plan view.

File plan view does not useQuick Search, only Advanced Search.

Modifiable components

View conditions

Column layout

Sorting and grouping

Security considerations

In the views tree, users see only the file plans for which they have been granted Search privileges, and
the record categories and record folders for which they have been granted Use privileges.

Folder
A folder view returns a set of folders. Folder views appear in the Views pane under Folders.

Modifiable conditions

View name

View privileges

View conditions

Public filters

Private filters

Column layout

View statistics
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Sorting and grouping

Security considerations

Users with view access can run a folder view.

Folder content
When the user opens a folder, Folder Viewer displays a secondary grid that lists the folder's contents. This
secondary grid is called a folder content view. Because document and folder shortcuts can belong to any
number of folders, the same document or folder might appear as a representation in Folder Viewer with
different grid layouts, depending on the type of folder the user opens.

Changes youmake apply to all folders associated with themodified folder type. Because you can represent a
document or folder using shortcuts in any number of folders, the same itemmight appear in a folder content
view with different grid layouts, depending on the folder's type.

Modifiable conditions

Column layout

View statistics

Sorting and grouping

Security considerations

Users with folder typemanagement privileges canmodify components of the folder content view in
Management Console.

Recently received documents
Recently received documents appear in a temporary view that appears when one Perceptive Content user
transfers documents to another user with the Send to User feature. This transfer must occur while both users
are connected to the same ImageNow Server. The view sorts the received documents according to the name
of the sending user and the time they were sent.

Record
To view records functionality, youmust install a Records Manager license.

A record view returns a set of records. Record views appear in ImageNowExplorer, in the Views pane under
Records.

Modifiable conditions

View name

View privileges

View conditions
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Public filters

Private filters

Column layout

View statistics

Sorting and grouping

Security considerations

Users with view access can run a record view.

Record Folder
A record folder view returns a set of record folders and record categories. Record Folders views appear in
ImageNowExplorer, in the Views pane under Record Folders.

Modifiable conditions

View name

View privileges

View conditions

Public filters

Private filters

Column layout

View statistics

Sorting and grouping

Security considerations

Users with view access can run a record folder view.

Record Folder Content
When the user opens a record folder, Record Folder Viewer displays a secondary grid that lists the folder s
contents. This secondary grid is called a record folder content view. Because record folder shortcuts can
belong to any number of record folders, the same record folder might appear as a representation in Record
Folder Viewer with different grid layouts, depending on the type of record folder the user opens. Changes you
make apply to all record folders associated with themodified record folder type.

Modifiable conditions

Column layout

View statistics
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Sorting and grouping

Security considerations

Users with record folder management privileges canmodify components of the record folder content
view inManagement Console.

Recycled documents and document folders
When the user deletes a document or folder, Perceptive Content moves the item to a system view calledMy
Recycled Documents or My Recycled Folders.

Items remain in the recycled view for the number of days that you specify in the inserverFS.ini file.

Modifiable conditions

Private filters

Security considerations

If the user is a Department Manager, two additional views appear. These views, All Recycled
Documents and All Recycled Folders, display all items deleted by all users. As long as the user can see
a recycled document or folder, the user can restore it to its previous state, at which time the document or
folder keeps the attributes it had before deletion, if possible.

Related
Related views appear in the Related Documents pane of the document viewer and in the Related Folders
pane of the folder viewer. A related view applies the relationship selected in the list to the current document or
folder. The view displays a list of all documents or folders that satisfy the conditions of the relationship.

Modifiable conditions

Relationship name

View privileges

View conditions

Public filters

Private filters

Column layout

View statistics

Sorting and grouping

Security considerations



Manage Documents User Guide

220

Users with document view management privileges can create andmodify document relationships in
Management Console. Users with folder view management privileges can create andmodify folder
relationships in Management Console.

Task
A task view returns a list of tasks assigned to the user according to the type of task, such as My Assigned or
To Review. Task views appear in the Views pane under Tasks.

Modifiable conditions

Public filters

Private filters

View statistics

Column layout

Sorting and grouping

Workflow process
A workflow process view returns a list of items (representing documents or folders) when the user accesses a
workflow process, which appears in the Views pane underWorkflow.

Modifiable conditions

Private filters

Security considerations

Workflow process views appear automatically depending on the workflow queues for which a user has
the necessary privileges. Users with workflow process management privileges canmodify workflow
queue view components inWorkflow Designer.

Security considerations

Users with view access can run a folder view.

Workflow queue
A workflow queue view returns a list of items (representing documents or folders) when the user accesses a
workflow queue, which appears in the Views pane underWorkflow.

Modifiable conditions

Column layout

View statistics

Private filters

Grouping and sorting
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Security considerations

Workflow queue views appear automatically depending on the workflow queues for which a user has the
necessary privileges. Users with workflow process management privileges canmodify workflow queue
view components inWorkflow Designer.

Supported file formats for Perceptive Content
The following tables list the file formats that ImageNowViewer support.

Archive file formats

Format Version Extension

7-Zip 4.57 7Z

BinHex N/A HQX

GZIP 2 GZ

Java Archive N/A JAR

Microsoft Cabinet Format 1.3 CAB

Microsoft Compressed Folder N/A LZH, LHA

PKZIP Through 9.0 ZIP

RARArchive 2.0 through 3.5 RAR

Tape Archive N/A TAR

Unix Compress N/A Z

UUEncoding All versions UUE

WinZip Through 10 ZIP

Binary file formats

Format Version Extension

Executable N/A EXE
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Format Version Extension

Link Library N/A DLL

Database file formats

Format Version Extension

Microsoft Access 95, 97, 2000, 2002, 2003 MDB

Display file formats

Format Version Extension

Adobe PDF Through 9 PDF

Graphic file formats

Format Version Extension

Computer GraphicsMetafile N/A CGM

CorelDRAW Through 9.0 CDR

DCX Fax System N/A DCX

Digital Imaging and
Communications in Medicine

N/A DCM

Encapsulated PostScript (raster) TIFF header EPS

Enhanced Metafile N/A EMF

GIF 87, 89 GIF

JPEG N/A JPEG, JPG

Lotus AMIDrawGraphics N/A SDW
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Format Version Extension

Lotus Pic N/A PIC

Macintosh Raster 2 PIC, PCT

MacPaint N/A PNTG

Microsoft Office Drawing N/A MSO

PCPaintBrush 3 PCX

Portable Network Graphics N/A PNG

Sun Raster Image N/A RS

Tagged Image File Through 6.0.3 TIFF

Truevision Targa 2 TGA

Windows Animated Cursor N/A ANI

Windows Bitmap N/A BMP

Windows Icon Cursor N/A ICO

WindowsMetafile 3 WMF

WordPerfect Graphics 1 1 WPG

WordPerfect Graphics 2 2, 7 WPG

Mail file formats

Format Version Extension

Lotus Notes database 4, 5, 6.0, 6.5 NSF

Microsoft Outlook 97, 2000, 2002, 2003 MSG

Microsoft Outlook Personal
Folder

97, 2000, 2002, 2003 PST
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Multimedia file formats
Any audio or movie format supported by Apple QuickTime orWindows Media Player. For specific formats
supported by these players, refer to the respective Apple or Microsoft websites. Depending on your hardware
and network, largemovie files (over 100MB)may slow performance.

Presentation file formats

Format Version Extension

Applix Presents 4.0, 4.2, 4.3, 4.4 AG

Corel Presentations 6, 7, 8, 9, 10, 11, 12, X3 SHW

Lotus Freelance Graphics 2 2 PRE

Lotus Freelance Graphics 96, 97, 98, R9, 9.8 PRZ

Microsoft PowerPoint Macintosh 98, 2001, 2004 PPT, PPS, POT

Microsoft PowerPoint PC 4 PPT, PPS, POT, PPTX, PPTM,
POTX, POTM, PPSX, PPSM

Microsoft PowerPoint Windows 95, 97, 2000, 2002, 2003, 2007 PPT, PPTM, PPTX

Spreadsheet file formats

Format Version Extension

Applix Spreadsheets 4.2, 4.3, 4.4 AS

Comma Separated Values N/A CSV

Corel Quattro Pro 5, 6, 7, 8 WB2, WB3

Lotus 1-2-3 96, 97, R9, 9.8 123

Lotus 1-2-3 2, 3, 4, 5 WK4

Lotus 1-2-3 Charts 2, 3, 4, 5 123

Microsoft Excel Charts 2, 3, 4, 5, 6, 7 XLS
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Format Version Extension

Microsoft Excel Windows 2.2 through 2007 XLS, XLSM, XLSX, XLW, XLT,
XLA, XLTX, XLTM, XLAM

Microsoft Excel Macintosh 98, 2001, v.X, 2004 XLS

Microsoft Works Spreadsheet 1, 2, 3, 4 S30, S40

OASIS Open Document Format 1, 2 ODS, SXC, STC

OpenOffice Calc 1, 1.1 SXC, ODS, OTS

StarOffice Calc 6, 7 SXC, ODS

Text andMarkup file formats

Format Version Extension

ANSI N/A TXT

ASCII N/A TXT

HTML 3, 4 HTM

Microsoft Excel Windows XML 2003 XML

Microsoft WordWindows XML 2003 XML

Rich Text Format 1 through 1.7 RTF

Unicode Text

Note: Specific support is only
applicable to the Unicode
version.

3, 4 TXT

UTF-8 N/A TXT

UTF-8 - No Byte Order Mark
(BOM)

N/A TXT
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Format Version Extension

UTF-16 Little Endian (UTF-16LE)

Note: A BOM is required for the
UTF-16LE format to be read
correctly.

N/A TXT

XHTML 1 HTM, XHTML

XML 1.0 XML

Word processing file formats

Format Version Extension

Adobe FrameMaker Interchange
Format

5, 5.5, 6, 7 MIF

ApplixWords 3.11, 4, 4.1, 4.2, 4.3, 4.4 AW

Corel WordPerfect Linux 6.0, 8.1 WPS

Corel WordPerfect Macintosh 1.02, 2, 2.1, 2.2, 3, 3.1 WPS

Corel WordPerfect Windows 5, 5.1 WO, WPS

Corel WordPerfect Windows 6, 7, 8, 9, 10, 11, 12, X3 WPD

DisplayWrite 4 IP

Folio Flat File 3.1 FFF

Fujitsu Oasys 7 OA2

IBM DCA/RFT (Revisable Form
Text)

SC23-0758 -1 DC

JustSystems Ichitaro 8 through 2005 JTD

Lotus AMI Pro 2, 3 SAM
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Format Version Extension

Lotus AMI Professional Write
Plus

2.1 AMI

LotusWord Pro 96, 97, R9 LWP

Lotus SmartMaster 96, 97 MWP

Microsoft Word PC 4, 5, 5.5, 6 DOC

Microsoft WordWindows 1.0, 2.0, 6, 7, 8, 95, 97, 2000,
2002, 2003, 2007

DOC, DOCX, DOCM, DOT,
DOTX, DOTM

Microsoft Word Macintosh 4, 5, 6, 98, 2001, v.X, 2004 DOC, DOT

Microsoft Works 1, 2, 3, 4, 6, 2000 WPS

Microsoft WindowsWrite 1, 2, 3 WRI

OASIS Open Document Format 1, 2 ODT, SXW, STW

Wordpad Through 2003 RTF

XyWrite 4.12 XY4

Work with Views
Create a view
To create a new view, complete the following steps.

1. InManagement Console, in the left pane, click Views.
2. In the right pane, click the appropriate tab, and then click New.
3. In theNew View dialog box, define a name and description for this view and click OK.
Next Modify the view in View DesignerManagement Console to define conditions, column layout, filters, and
view security.

Create a related view
To create a relationship view for an item, perform the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. In the right pane, on theRelated tab, click New.
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3. In theNew Relationship dialog box, type a name and an optional description of the view that appears
in the Tool Tip for the view, and then click OK.

Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Copy a view
You can copy a view to create a new view with the same conditions, filters, column layout, and security
settings. To copy a view, perform the following steps.

You cannot copy a task view.

1. InManagement Console, in the left pane, click Views.
2. On the appropriate tab, select the view definition and click Copy.

To view records functionality, youmust install a Records Manager license.
3. In theCopy View dialog box, type a name and optional description for the new view.
4. Optional. To copy public filters associated with the original view definition, select theAll public

filters check box.
5. Optional. To copy users and the view privileges associated with the original view definition, select the

All users and their privileges check box.
6. Optional. If you included users and you also want to copy any private filters created by those users,

select thePrivate filter for users check box.
7. Click OK.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Copy a related view
To copy a relationship view for an item, complete the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. In the right pane, click theRelated tab.
3. Select the relationship and click Copy.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Delete a view
To delete a view, perform the following steps.

1. InManagement Console, in the left pane, click Views.
2. On theDocument, Folder, Record, orRecord Folder tab, select the view and click Delete.

To view records functionality, youmust install a Records Manager license.
3. In the confirmation dialog, click Yes.
Result Users will not see the view removed until they log out and log in again.
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Delete a related view
To delete a relationship view for a document, complete the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. In the right pane, click theRelated tab.
3. Select the relationship and click Delete.
4. In the confirmation dialog box, click Yes.

Rename a view
To rename a view, complete the following steps.

You can also rename a view by editing its properties in View Designer. You cannot rename a task view.

1. InManagement Console, in the left pane, click Views.
2. In the right pane, on the appropriate tab, select the view you want to rename and click Rename.
3. In theRename View dialog box, type the new view name and an optional description.
4. Click OK.

Rename a related view
To rename a relationship view for documents or folders, complete the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. In the right pane, click theRelated Documents orRelated Folders tab.
3. Select the relationship and click Rename.
4. In theRename Relationship dialog box, type the new name of the relationship in theName box.

Modify a view
Tomodify components of a view, complete the following steps.

Prerequisite It is recommended that you perform view modifications when no users are signed in to
Perceptive Content.

1. InManagement Console, in the left pane, click Views.
2. In the right pane, on the appropriate tab, select the view you want to change and click Modify.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Modify a related view
Tomodify a relationship view for an item, complete the following steps.

Prerequisite It is recommended that you perform view modifications when no users are signed in to
Perceptive Content.

1. InManagement Console, in the left pane, click Relationships.
2. In the right pane, click theRelated tab.
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3. Select the relationship and click Modify.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Version control status indicators
Any document added to version control, either in its current version or in a previous version, is accompanied
by a status indicator in the document search results grid, in the Version Controlled column. If your view does
not show this column, you can temporarily display it or you can add the column in a private filter.

None

The document is not version controlled.

Checked In

The document is version controlled but not currently checked out to any users.

Checked Out

This document is version controlled and currently checked out by another user.

Checked Out by You

This document is version controlled and currently checked out by you.

If a document is checked in, but marked private by another user, the Is Private icon appears in the Is
Private column in the document search results grid.

Configure recycle bin views
You can determine the amount of time an item appears in the recycle bin views in ImageNowExplorer before
permanently deleting it. To configure recycle bin views, complete the following steps.

The following recycle bin views are available to configure: My Recycled Documents, My Recycled Folders,
All Recycled Documents, and All Recycled Folders.

1. Open the [drive:]\inserver\etc\inserverFS.ini file with a text editor.
2. To determine the number of days you want items to remain in the recycled views before they are

permanently removed from ImageNow Server, under [General], perform one of the following actions
for the destruction.wait.time setting.
l To immediately delete items from the recycle bin, enter 0.
l To delete items from the recycle bin after a specific number of days, enter the number of days.
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Note: You cannot enter a negative integer. Themaximum number of days you can retain items in a
recycle bin view is 2,147,483,647.

3. Save and close the inserverFS.ini file.
4. Restart the File System Agent service.

Set the system default view
You can set the system-wide default view to use a link that does not specify which view to use, and the user
does not have a default view configured. To set the system default view, complete the following steps. You
must be a department manager to set the default system view.

You can also set the default view on a per-user basis in Management Console.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, select Views.
3. In the right pane, select theSystem Defaults tab.
4. In theDocument view list, select a default document view.
5. In the confirmation prompt, click Yes.

Note: Select None from the list to remove the default document view.

6. In the Folder view list, select a default folder view.
7. In the confirmation prompt, click Yes.

Note: Select None from the list to remove the default folder view.

Folder content search conditions
When you display the Search pane on the Content tab of Folder Viewer, several conditions are available. The
Add Condition dialog box allows you to build a search using a combination of constraints, fields, operators,
and values described in the following table.

If you are performing a variable search, you can select one of the following values to use as a variable for the
current user: user name, first name, last name, title, organization, organization unit, locality, or user ID. You
can also use the current date and time as a variable.

Composite property

The Composite property constraint allows the following operators: is equal to, is not equal to, is less
than, is greater than, is less than or equal to, is greater than or equal to, starts with, does not start with,
ends with, does not end with, contains, does not contain, is blank, is not blank is one of, is not one of, is
between, and is not between.

The composite properties, which can contain all possible values, are defined by your administrator.
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You can select a composite property is the Composite list, or you can select a custom property in the
Field list.

Custom property

The Custom property constraint allows the following operators: is equal to, is not equal to, is less than,
is greater than or equal to, starts with, does not start with, ends with, does not end with, contains, does
not contain, is blank, is not blank, is one of, is not one of, is between, is not between, is equal to, is not
equal to

Constraint Operators Field Field
Description

Possible Values

Composite
property

is equal to, is not
equal to, is less
than, is greater
than, is less than
or equal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

In the Composite
list, select a
composite
property. In the
Field list, select a
custom property.

Composite
properties are
defined by your
administrator.

All defined
composite
properties

Content property is equal to, is not
equal to, is less
than, is greater
than, is less than
or equal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not

Content type The type of
content in the
folder.

l Document
l Document
Shortcut
Folder

l Folder
Shortcut
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Constraint Operators Field Field
Description

Possible Values

between

Added to folder
within (days)

The number of
days within which
the document,
folder, or shortcut
was added or
moved to the
folder.

Type any positive
integer.

Created within
(days)

The number of
days within which
the document,
folder, shortcut
was created.

Type any positive
integer.

Name The name value of
the document,
folder, or shortcut.

Type any
alphanumeric
value.

Drawer The drawer value
associated with
the document,
folder, or item
referenced by a
shortcut.

Type any
alphanumeric
value.

Document ID The unique ID of
the document.

Type any
alphanumeric
value.

Field1 The Field1 value
associated with
the document or
document
referenced by a
shortcut.

Type any
alphanumeric
value.

Field2 The Field2 value
associated with
the document or
document
referenced by a

Type any
alphanumeric
value.
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Constraint Operators Field Field
Description

Possible Values

shortcut.

Field3 The Field3 value
associated with
the document or
document
referenced by a
shortcut.

Type any
alphanumeric
value.

Field4 The Field4
associated with
the document or
document
referenced by a
shortcut.

Type any
alphanumeric
value.

Field5 The Field5
associated with
the document or
document
referenced by a
shortcut.

Type any
alphanumeric
value.

Document type The document
type associated
with the document
or document
referenced by a
shortcut.

Type any
alphanumeric
value.

Folder ID The unique ID of
the folder.

Type any
alphanumeric
value.

Folder type The folder type
associated with
the folder or folder
referenced by a
shortcut.

Type any
alphanumeric
value.

Custom property is equal to, is not
equal to, is less

Select a custom
property.

Custom properties
are defined by
your administrator.

All defined custom
properties
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Constraint Operators Field Field
Description

Possible Values

than, is greater
than, is less than
or equal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

Date is equal to, is not
equal to, is less
than, is greater
than, is less than
or equal to, is
greater than or
equal to, is one of,
is not one of, is
between, is not
between

Added to folder The date the
content was added
or moved to the
folder.

Type or select a
date value.

Checked out The date the
document or
document
referenced by a
shortcut was
checked out in
version control.

Type or select a
date value.

Created The date the
document, folder,
or shortcut was
created.

Type or select a
date value.

Last viewed The date the
content was last
viewed by a user.

Type or select a
date value.
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Constraint Operators Field Field
Description

Possible Values

Modified The date the
document, folder,
or shortcut was
last modified.

Type or select a
date value.

Status changed The date the
folder's active or
inactive status
changed.

Type or select a
date value.

Document Status is equal to, is not
equal to

Digital signature
status

The status of the
version controlled
digital signature of
the document.

Valid, Invalid,
Void, Not Signed

Has hold applied Whether the
document has a
direct or inherited
retention hold
applied.

Yes, No

Has physical
reference

Whether the
document had a
physical file
reference.

Yes, No

Is private Whether the
document is
marked private in
version control.

Yes, No

Is version
controlled

Whether the
document is
added to version
control.

Yes, No

Folder Status is equal to, is not
equal to

Folder status The active or
inactive status of
the folder.

Active, Inactive

Has required
documents

Whether the folder
has required
document types.

Yes, No
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Constraint Operators Field Field
Description

Possible Values

Physical property is equal to
is not equal to, is
less than, is
greater than, is
less than or equal
to, is greater than
or equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

In the Template
list, select a
physical file
template. In the
Field list, select a
physical property.

Physical file
templates and
physical properties
are defined by
your administrator.

Template: All
physical file
templates the user
can access, Field:
All physical
properties
associated with
the template

User is equal to, is not
equal to, starts
with, does not
start with, ends
with, is blank, is
not blank, is one
of, is not one of

Checked out by The user who has
the document
checked out in
version control.

Type an
alphanumeric
value. Any valid
user name.

Created by The user who
created the
document, folder,
or shortcut.

Last viewed by The user who last
viewed the
document, folder,
or item referenced
by a shortcut.

Modified by The user who last
modified the
document, folder,
or shortcut.

Private by The user who
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Constraint Operators Field Field
Description

Possible Values

marked the
document private
in version control.

Status changed by The user who last
changed the folder
status.

Workflow item
property

is equal to, is not
equal to, is less
than, is greater
than, is less than
or equal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

Is in workflow Whether the
document or folder
is added to
workflow.

Yes, No

Workflow queue The workflow
queue associated
with the
document, folder,
or item referenced
by a shortcut.

Type an
alphanumeric
value.

Workflow item
user

The user who
added the
document, folder,
or item referenced
by a shortcut to
workflow.

Type an
alphanumeric
value. Any valid
user name.

Workflow item
status

The status of the
document, folder,
or item referenced
by a shortcut in
workflow.

Idle, Working, On
hold, Pending,
Waiting for
routing, Waiting
for inbound action
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Sort view or search results
You can sort the rows in the results grid for a view or public filter. To sort view results, complete the following
steps.

1. In the view preview or search results grid, to sort by a single column, right-click the column heading and
then do one of the following:
l To sort the results in ascending order, select Sort Ascending.
l To sort the results in descending order, select Sort Descending.

2. To sort by additional columns, hold the SHIFT key and click the column heading once to sort the results
in ascending order or twice to sort the results in descending order.

Note: To sort onmultiple columns, youmust group the results.

3. Optional. To remove all sorting, right-click a column heading and select Reset sort order.
4. Save the view or filter to preserve the sort order.

Select columns to display
To show or hide columns in a view or public filter, complete the following steps.

1. InView Designer, in thePreview pane, click theColumns button.
2. In theColumns dialog box, do the following substeps:

1. For the column or columns you want to hide, clear the check box. To hide all columns, right-click
anywhere in the dialog box and then click Clear All.

2. For the column or columns you want to show, select the check box. To show all columns, right-
click anywhere inside the dialog box and then click Select All.

3. Click OK.
3. In theDesigner toolbar, click theSave button.

Group view or search results
You can group the results of a view, filter, or search by one or more columns into groups you can expand and
collapse. To group view results, complete the following steps.

1. In the search results grid or view preview grid, right-click a column heading, and then click Group by
this Column.
Groups are initially collapsed when the view or filter runs.

2. Optional. To create a subgroup under the grouped column, right-click a column heading, and then click
Group by this Column.

3. Optional. To expand the grouped results, right-click a column headings, and then click Expand All
Groups.

4. Save the view or filter to preserve the column grouping.
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About viewing batches by batch user
A user can view batches captured by batch users, and can be limited to viewing batches captured only by
specific batch users.

Users can capture batches with theGlobal > Capture > Batch Mode privilege and then view those batches.

If you want a user to view batches captured by any other batch users, youmust give the user theDrawer >
Batch (Proposed Key) > Process privilege for each drawer.

If you want to limit a user to viewing batches captured only by specific batch users, youmust also enable
filtering by batch user. When you enable filtering by batch user, you create a list of only those batch users
whose batches you want the user to view.

Add a custom property column
To add columns to display custom property values for content, complete the following steps.

1. Access the view using one of the followingmethods:

Situation Steps

Add a custom property column for a workflow
queue view

1. Open the workflow process inWorkflow
Designer.

2. InWorkflow Designer, open the desired
queue.

3. In theQueue Properties dialog box, click
Appearance.

4. In the right pane, clickPreview.

Add a custom property column for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Add a custom property column for a folder
content view

1. InManagement Console, in the left pane,
click Folder Types.

2. In the right pane, on the Folder Types tab,
select the folder type and clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, clickPreview.

2. In theView Previewwindow, click theColumns button.
3. In theColumns dialog box, click Add.
4. In theCustom Property dialog box, select the Filter by list and do one of the following actions:

l To display a custom property based on item type, select Document Types.
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l To display a custom property based on folder type, select Folder Types.
l To display all custom properties, select All Custom Properties.

5. In the Type list, select a custom property.
The Type list options change based on the Filter by option selected.

6. Select a custom property and click Add.
7. Click OK.

Enable filtering by batch user for a group
A group can view batches captured by batch users if granted the appropriate drawer privileges for the drawers
for which the batches are targeted. To further limit groups to viewing only batches captured by specific batch
users, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select Cross Department
Settings from the list.

2. In the left pane, click Groups.
3. In the right pane, select the group you want and click Modify.
4. In theModify Group Profile dialog box, in the left pane, click Batch Users.
5. Select Enable filtering by batch user.
6. To add batch users to the list, complete the following substeps.

1. Click Add.
2. In theSelect Users dialog box, underAvailable Users, select a user and click Add.
3. Click OK when you finish adding batch users.

7. Optional. To remove batch users from the list, complete the following substeps.
1. Click the batch user.
2. Click Remove.

Enable filtering by batch user for a user
A user can view batches captured by batch users if granted the appropriate drawer privileges for the drawers
for which the batches are targeted. To further limit users to viewing only batches captured by specific batch
users, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select Cross Department
Settings from the list.

2. In the left pane, click Users.
3. In the right pane, select the user you want and click Modify.
4. In theModify User Profile dialog box, in the left pane, click Batch Users.
5. Select Enable filtering by batch user.
6. To add batch users to the list, complete the following substeps.

1. Click Add.
2. In theSelect Users dialog box, underSearch, select a user and click Add.
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3. Click OK when you finish adding batch users.
7. Optional. To remove batch users from the list, complete the following substeps.

1. Click the batch user.
2. Click Remove.

Add a custom property column for records
To add a custom property column for a record content view, complete the following steps.

1. InManagement Console, in the left pane, click Records and select Record Folder Types orRecord
Category Types.

2. In the right pane, on theRecord Folder Types orRecord Category Types tab, select the folder type
and click Modify.

3. In the dialog box, on theAppearance tab, click Preview.
4. In theView Previewwindow, click theColumns button.
5. In theColumns dialog box, click Add.
6. In theCustom Property dialog box, select the Filter by list and do one of the following actions:

l To display a custom property based on record type, select Record Types.
l To display a custom property based on record folder type, select Record Folder Types.
l To display all custom properties, select All Custom Properties.

7. In the Type list, select a record or record folder type.
The Type list options change based on the Filter by option selected.

8. Select a custom property and click Add.
9. Click OK.

Statistics
What are statistics?
Statistics are calculations such as themaximum, minimum, and average of all the values in a specific column
that appear in the search results for the view.

You can define statistics for any document view, folder view, task view, record view, or record folder view for
which you havemanagement privileges. You cannot define statistics for a public filter or a related view.

For any folder type for which you havemanagement privileges, you can create a view that determines the
appearance of the folder content results in Folder Viewer. You can also create a statistic for a workflow view,
which defines the appearance when viewing the contents of a workflow queue. When you define a set of
statistics for a folder content or workflow view, the statistics appear in a pane below the search results grid. In
the statistics pane, you can view the statistics, highlight the search results in the grid that apply to the
statistic, and, if only one document or folder matches the statistic value, open the document or folder.

The following examples demonstrate someways you can use view statistics.
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Accounts Payable: Theresa is an Accounts Payable administrator who wants to quickly view the total
of all the invoices in her "OpenInvoices" view. This view contains a custom property columnwhich
stores the invoice amount for each document. Because it is a numeric custom property, Theresa adds
a Sum statistic on this custom property column named "Total open amount". Every time she runs a
search using this view, she sees the total invoice amount of all the documents returned by the search
in the statistics pane.

Admissions: Sam is an Admissions director who wants to view the average ACT score of the students
who applied to his university in the current academic year. His student folder view contains a custom
property columnwhich stores the ACT score for each student and a date range that spans the current
academic year. Because the view uses a numeric custom property, Sam adds an Average statistic on
this custom property column named "Average ACT."

Healthcare: Dr. Lovelace wants to quickly view the next task he is responsible for in his folder view
that lists all his patients with document deficiencies. His view administrator adds a Next statistic to
the task due date column in the view. When Dr. Lovelace logs in, he can quickly see the date the next
task is due, highlight the document associated with the task, and open it in ImageNowViewer.

To view records functionality, youmust install a Records Manager license.

Data types for statistical functions
The statistical functions you can define depend on the data type of the column values. To add a statistic for a
custom property column, youmust first add the custom property column to the view. The following statistics
are available for the specified data types.

Statistical functions

Average
This function calculates the average of the column values.

Column value data type

Numeric

Sample columns

Summary Task Count

<Number custom property>

Count
This function counts the number of values in the search results grid that match the selected variable
(you must select a variable for this statistical function).

Column value data type

String, list, flag
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Sample columns

Folder Name

InWorkflow

<List custom property>

<String custom property>

<Flag custom property>

Count Future
This function counts the number of the column's date values that occur in the future.

Column value data type

Date

Sample columns

Next Task Due

DueDate

<Date custom property>

Count Past
This function counts the number of the column's date values that occur in the past.

Column value data type

Date

Sample columns

Created

Last Viewed

<Date custom property>

First
This function distinguishes the earliest date in the column's search results.

Column value data type

Date
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Sample columns

Modified

CheckedOut

<Date custom property>

Last
This function distinguishes the latest date in the column's search results.

Column value data type

Date

Sample columns

Checked In

Assigned

<Date custom property>

Maximum
This function distinguishes the largest numeric value in the column's search results.

Column value data type

Numeric

Sample columns

Pages

<Number custom property>

Median
The function distinguishes the middle value in the column's search results.

Column value data type

Sample columns

Current Version

<Number custom property>

Minimum
This function distinguishes the smallest numeric value in the column's search results.
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Column value data type

Numeric

Sample columns

Days Until Due

<Number custom property>

Mode
This function distinguishes the most frequently occurring numeric value in the column's search
results.

Column value data type

Numeric

Sample columns

Summary Task Count

<Number custom property>

Next
This function distinguishes the next sequential date value in the column's search results.

Column value data type

Date

Sample columns

Status Changed

<Date custom property>

Previous
This function distinguishes the previous sequential date value in the column's search results.

Column value data type

Date

Sample columns

Completed

<Date custom property>

Sum
This function calculates the total of the values in the column's search results.
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Column value data type

Numeric

Sample columns

Pages

<Number custom property>

Add view statistics overview
The configuration of a view statistic differs based on the data value type you select. You can create statistics
for document, folder, folder content, record, task, and workflow views. To create a statistic for a view,
complete any of the following procedures.

l Add a statistic for a date value.
l Add a statistic for a flag value.
l Add a statistic for a list value.
l Add a statistic for a numeric value.
l Add a statistic for a string value.

Add a statistic for a date value

You can display the newest, oldest, or next date value in a list of search results, or display the total number of
dates in the past or dates in the future. To add a statistic for a date value, complete the following steps.

Prerequisite Before you can add a statistic for a date custom property value, youmust first add the custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.
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Situation Steps

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to view the next task due date, type Next task due.

5. UnderColumn, select the view columnwith the date values.
6. Under Function, select one of the following options depending on the display variable you want to

show:

Situation Steps

Total number of dates in the future l Select Count Future.

Total number of dates in the past l Select Count past.

Oldest date value l Select First.

Newest date value l Select Last.

The next future date l Select Next.

The most recent date l Select Previous.

7. Optional. UnderCaption, select the value to display when the statistic only applies to one search
result.
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Example If aPrevious statistic shows the last viewed item, and you want to quickly display the user
name of the user who viewed the item, you can use theCaption column to select the Last Viewed By
user.

8. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

9. Click OK.
The statistic appears below the grid in thePreview pane.

10. In thePreview pane, click theRun button to test the statistic's performance.

Add a statistic for a flag value

You can add a statistic that distinguishes the number of search results that have a true or false (boolean)
value. To add a statistic for a flag value, complete the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, youmust add the flag custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.
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2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to count the number of documents or records assigned to a retention
policy, type Documents in Retention or Records in Retention.

5. UnderColumn, select the view columnwith the flag values.
6. Under Function, select Count.
7. UnderVariable, select whether you want to count the results that meet the TRUE condition or the

FALSE condition.
8. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If there is one version-controlled item in your search results, and you want to quickly display
the user whomarked the item private, you can use theCaption column to select thePrivate By user.

9. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

10. Click OK.
The statistic appears below the grid in thePreview pane.

11. In thePreview pane, click theRun button to test the statistic's performance.

Add a statistic for a list value

You can add a Count statistic that distinguishes a unique value of a list custom property. To add a statistic for
a list value, complete the following steps.

Prerequisite Before you can add a statistic for a list value, youmust first add the list custom property
column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.
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Situation Steps

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If you have a list custom property to select the fiscal quarter associated with an invoice and
you want to add a statistic to show fourth quarter invoices, type Invoices in Q4.

5. UnderColumn, select the list custom property.
6. Under Function, select Count.

Note: Count is the only statistical function for list values.

7. In theVariable list, select an item from the list to use for the statistic.
8. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If there is only one item added to workflow during themonth of January, and you want to
quickly display the user who added the item to workflow, you can use theCaption column to select the
workflow user.

9. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

10. Click OK.
The statistic appears below the grid in thePreview pane.

11. In thePreview pane, click theRun button to test the statistic's performance.
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Add a statistic for a numeric value

You can display the average, sum, median, or mode statistic that distinguishes numeric values, such as the
number of tasks or a custom property that stores an amount value. To add a statistic for a numeric value,
perform the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, youmust add the flag custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to view the average amount of invoices, type Average invoice
amount.

5. UnderColumn, select the view columnwith the flag values.



Manage Documents User Guide

253

6. Under Function, select the display variable you want to show.
7. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If aMaximum statistic displays the invoice with the highest amount, and you want to quickly
display the user name of the user who last viewed the invoice, you can use theCaption column to
select the Last Viewed By user.

8. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

9. Click OK.
The statistic appears below the grid in thePreview pane.

10. In thePreview pane, click theRun button to test the statistic's performance.

Add a statistic for a string value

You can add a non-case sensitive Count statistic that distinguishes string values, such as a task template or
drawer name. To add a statistic for a string value, which you can add at the view or filter level, perform the
following steps.

Prerequisite Before you can add a statistic for a flag custom property value, youmust add the flag custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.
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Situation Steps

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to count the number of items scanned by the department manager, type
Scanned by Manager.

5. UnderColumn, select the view columnwith the string values.
6. Under Function, select Count.

Note: Count is the only statistical function for string values.

7. UnderVariable, type the value for the statistic, such as the drawer name or task template name.
8. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If there is only one items for a specific vendor in your workflow process, and you want to
quickly determine if it is an invoice or a purchase order, you can use theCaption column to show the
Document Type.

9. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

10. Click OK. The statistic appears below the grid in thePreview pane.
11. In thePreview pane, click theRun button to test the statistic's performance.

Modify a statistic
Tomodify the components of a statistic defined for a view, complete the following steps.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.
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Situation Steps

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button and then, in theStatistics dialog box, click the row of
the statistic you want to change.

3. Do one of the following actions.
l To change the statistic definition, highlight the statistic row and thenmodify the components you
want to change.

l To reposition the statistic, click Move Up to move it ahead of the preceding statistic, or click Move
Down to move it after the following statistic.

4. Click OK.
5. In thePreview pane, click theRun button to test the statistic's performance.

Remove a statistic
To remove a statistic from a view, complete the following steps.

1. Access the view preview using one of the followingmethods.
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Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click the row of the statistic you want to remove and click Remove.
4. Click Yes in the confirmation prompt and then, in theStatistics dialog box, click OK.
Result Removing a statistic does not remove the column from the view.
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